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To Anna, who came to love the Macintosh
through this book. I hope that everyone will do the same.

I wrote this book with two purposes in mind: to provide a complete reference for
independent study of Macintosh system and application software, and to support
directed study in a college environment.
Beyond these uses, a third purpose is implicit and, finally, more important:
The book and its course Computers and Education are products of extensive
development over several years at Cornell . The original vision fo r the course,
uniquely viable in the Department of Education, sought to teach computers not
so that facility with the tool was the only end result; rather, that the student might
also cultivate a broader understanding of where tools and information fit and how
they work, in culture and in human endeavor.
Tom Hughes, who taught the course before me, contributed exceptional
competence and energy towards the precursor to this book. It has been my task
to preserve the quality he established, and extend where possible the conceptual
and philosophical emphasis that makes this curriculum uniquely valuable. Dan
Smellow and Anne Chetham-Strode, teaching assistants, provided copious and
consistently valuable insight into how best to explain and illustrate concepts that
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the beginner finds incomprehensible, and that the practiced user feels ought to be
obvious to everyone .
I owe many a great deal of appreciatio n . In the end, though , I feel as
Schonberg must have when he began his Theory of Harmony with "I have
learned this book from my students." They have helped me write this one too.

John Rethorst
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Yet another book on achieving basic competence on the Macintosh? No-this
one's quite a bit different.
The question of how to teach something never was easy and , when the subject is personal computers, it becomes difficult in manifold ways. It's a somewhat
technical environment, yes, but for what most people want it's far less complicated than most beginners could imagine.
The Macintosh environment is profoundly untechnical. It's almost playful at
times, and strongly spurs creativity . In a wonderful way, it invites the user to
explore.
All of this starts to happen, though , after a big hurdle has been breachedcomputer anxiety . People of every age, educational background, vocation and

purpose share this when they first sit down in front of a computer. You might feel
that you simply have no talent for the thing, that it's too complicated, that you're
just a few short steps from disaster.
If so, this book is for you.
!learned how to teach what's in this book when I came to Cornell for a Ph.D.
in Education, bringing with me twelve years of computer experience. I joined the
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teaching staff of the University's course whose task was to take 200 people a
semester who knew nothing about computers, and get them up and running on
the Macintosh in seven weeks.
The hardest part of it (aside from convincing them that they could do it) was
showing the why as well as the how-critical for any real understanding, and
being able to go further on your own. Teaching which buttons to push is decidedly easier. Which button to push is-we ll , there 's almost nothing to it .
Explaining the concepts behind the keystrokes is a tougher job, though, requiring
that the teacher have a critical appreciation of the computer and the ideas behind
it, seen through a beginner's eyes.
After the first year I was put in charge of the course, and immediately began
to develop this material. I was convinced that, given a positive educational environment, anyone could start off on the Macintosh and progress, step by step, so
that they couldn't help but learn it well, and have a lot of fun at the same time.
That's the key to the focus of this whole book-fun . Reviewers of what
you're about to read have called it "warm, inviting, and trustworthy. " But make
no mistake about its serious intent. You'll. do better at absolutely anything you
want to do if you have a Macintosh to help. And if you take this book a step at a
time, you'll enjoy it, and be much more advanced than most personal computer
users when you finish.
So get set for a good time.

CHAPTEr\
GETTING
STA~TED
In this chapter, you'll learn how to:
• use icons and windows
• work with menus and scroll bars
• get help from the Mac's Balloon Help feature
• work with a floppy disk
• copy a file from one disk to another
• make and use folders
• find any file in your Mac
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Welcome to what will be a wonderful learning experience for you as a computer
. user! These easy, step-by-step tutorials show you everything you'll need to know
about using the Macintosh.
We say 'using' rather than 'programming', because there's quite a difference.
The latter is technical and difficult. But using a Macintosh computer with programs that are already written is easy and convenient. Take your time and don't
skip any steps. After each chapter, a little more practice is all that you'll need to
be a competent user of that kind of program.
First, though, let's take a short look at the why as well as the how of what
we'll be doing here.

STARTING SOMETHING

NEW

We live in what's often been termed the "Age of Information," a phrase with special meaning in almost any environment-corporate, educational, or civic.
How are we going to approach and prepare for this age? Let's begin with an
overview of the ideas of information and learning, and how these contribute to
the whole person and to growth. What do we mean, when we say we want information about something? What counts? Futurists discuss information theory,
game theory, and such esoteric concepts, but we mostly find ourselves looking for
greater quantities of information, as though that alone will help us.
Yet it is not the amount, but the quality and relevance of what we know, that
solves problems. The task of this book is, in large part, to address both that and
the process, not the product: how to get and work with information, make it
work for us, and pass it along to others.
It was not so long ago that most of the world survived by bartering thingsproducts and services-and what anyone knew played a supporting role. A revolution, in which the computer played a vital part, has taken place within the last
decade, and decisions now are based not so much on whether you can obtain
resources but on how to manage them: decisions that require a quality of information beyond what we used to expect and what we thought possible.
Managing information is critical and primary, and the computer has become
one of the most important tools we have in commerce and government-and in
how we educate.

CHAPTER
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GETTING STARTED

Think for a moment of the aphorism, "The power of the printed word. " It
certainly has a great deal of power, but how much power was required to achieve
it? The incunabula of the Middle Ages had enormous beauty , but each book
required a good part of a year to produce, and could be read only by limited numbers of people. Transporting a volume of information took a horse and cart, and
at least two people to support the effort and guard such a precious article.
More recently, the typewriter and printing press, and universal literacy, have
changed how information is transmitted. However, the path they describe is still
in only one direction: print a book or article and distribute it. You could copy part
of my work or react to it, but the interaction between those who develop information, and the target audience, is largely a monologue.
It's quite a step up from the fourteenth century, but a much larger change has
occurred in the last few years. I can send text to you via electronic mail, and you
won't need to retype anything I wrote, but can make corrections to the original
text and send it to me or others for their response. The printed word has taken
on the quality of conversation to a degree it did not have before, and the change
benefits us both enormously. Ideas move faster today.
The same is true with numbers or other organizations of data. The telephone
book is like any other printed work: even with a great quantity of information
available, it is fixed. We can retrieve information from it, but may have to shuffle
lots of pages, take a fair amount of time, and be willing to correct numbers of
mistakes.
What if you could manipulate the data in the phone book in a matter of seconds-for example, to find the telephone numbers of everyone who lived on your
street, to call them to organize a neighborhood meeting? You could do that in
about ten seconds, with a computer program we'll learn in this book.
The meaning of what you know comes from two places: first, input of imagination and theory; second, the factual side. They're equal in importance, and we
need both to make information make sense.
Managing and using information, as opposed to just having it , is a tool of
empowerment. You can ask a computer to make decisions by formulating 'what-if'
questions: where to invest if interest rates go up or down by a specified amount,
for instance. By having the computer do the repetitive and quantitative work, we
can free ourselves for choices that require intelligence and understanding.
That last paragraph contains one of the most important words in any
description of what a computer does for us: 'free.' If you find yourself retyping a
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whole page of a college paper or business report because you left out a line, or
getting artistic with the white-out to make the third correction on a page look presentable, you are hardly free. You're spending time with mechanics instead of letting the machine do the mechanics, while you spend time with ideas.
Getting used to the value of your time and efforts is an important part of an
introduction to using information. As we go along, your learning experience will
be greatly enhanced if you let machines do what they can do for you-both in the
concrete terms of careers and in the process of life-long learning enhanced by the
freedom to deal with ideas.
The American philosopher and educator John Dewey thought that education
was simply growth that, properly conceived, should never stop. The power of
information can be instrumental to that goal. And we'll be looking here not only
at the specifics. Those are important but, even more, we'll want to take a step
back from the details now and then to see what we' re doing as we do it, and
thereby grasp a much greater tool: learning how to learn.
As the educational researcher David Kolb points out, each of us has a learning style that works best for us. Learning styles are combinations of experimentation and observation, concrete experience and abstract reasoning, and each of us
has a different best combination.
It's a mistake to think that we have to learn about computers in only this or
that way or style. For some, going right through each step in each chapter is the
best means to do it. For others, stopping to understand the concept behind each
step works better. Don't feel you're not learning as well because you're not moving as fast as someone else.
In accordance with this, the different chapters of this manual explore different ways of learning how programs and ideas fit together, keeping in mind that
the purpose of this machine is really to help you think better.

THE MACINTOSH ENVIRONMENT
A tool is an extension of its user. A wrench allows you to do things with your
hand you couldn't otherwise do. A computer is the same thing, but is an extension of your mind rather than hand.
When we use a wrench on a lawnmower, we can say that we have an interface with the tool and the object. We understand how we're using the tool to

CHAPTER

1 GrniNG STARTED

manipuiate the object. On the Macintosh, our first tool is the scree n, which shows
us pictures representing ideas. We call these icons-pictures with meanings. One
icon may represent a program-a set of instructions to the Macintosh to make a
drawing, or write a letter, for example. Another icon might represent a file or a
document-the drawing or letter itself.

.

..

,

Icons such as these form a
large part of the Mac's user
Interface-the conversation
between computer and
user. This visual operating
system-also called a
graphical user Interface, Is
far easter to use than some
other systems that require
you to type codes that were
difficult to understand and

/ 1 ...

,;-- ~-

/

'

lllustr a tor
Composer

~

~

WordPerfect

remember.
This inte rface is, simply enough, how we talk with the computer. We give it
certain informa tion, and it gives us information in return. We talk to it with the
keyboard and mouse: Letters and numbe rs go in by the keyboard, as with a typewriter, and th e mouse is something we use to point to an object on the screen. As
you move your mouse, an arrow moves in like fashion on the screen.

.,

,

· iW... The arrow moves on the

screen as you move your
mouse. You use the
arrow to tell the com puter what you want it
to do.

~) )
0

When we want to choose, or select something we see, we press the button
on top o f the mouse, or click on what we see on the screen.

d
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Poi n t and click are not simplistic synonyms for technical ter ms; they 're
words that Macintosh programmers use to describe the process of pointing to
something on the screen and selecting it.
'JI: To select the Composer

• ·

icon, move your mouse,
and see how the arrow
follows your mouement.
When the tip of the arrow
is over the icon, press the
button on top of the
mouse or, in other words,
click on the icon.

~-

Composer "" ...

--~~

What you're doing is called input. The other half of the conversation is output-what the computer tells you. It does this with the screen and printer and
those are, more or less, the same thing. It prints what you see on the screen.
The next part of the Macintosh interface is windows . Just like an icon for a program, such as Composer, a window is a graphic representation of a part of the environment you're working in. Just as you can look in a window of a house to see what's
inside, you can look in a window on the Macintosh screen to see what's on a disk.
A typical Macintosh window looks something like Figure 1.4. "Something
like" because your computer might be set up a little differently; for now, those differences aren't important.

Lw

.

~~•1

A window with one program within.

Close box

/

Winlwtitle
Disk Window

1 item

74 .8 M8 in disk

~

Zoombo\

1.9MB availabl e

~
""-Scroll arrow

Compos~r

__.scroll bar

""'
vesizebox

¢1

0

1¢ l2i

C HAPTER

1
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This is just a way of looking at what's on a disk you might have inserted into
your computer. There seem like a lot of parts at first, but note two important
points:
• Operation is highly intuitive. You'll know how to work a window five minutes
from now.
• Nearly every Macintosh program uses the same kind of window. Learn one
program, and you've learned an important part of all of them .
Let's look at a typical window:
The zoom box and resize box control the size of the window. You may want
a window to be as big as your screen, to work with everything available. Or, you
may want to make it much smaller, so you can open another window and look at
both at once.
The scroll bars and scroll arrows let you move around the window, if it's too
small to see all the icons.
A window at full size, with all Icons visible. The scroll bars are inac-

tive-whlte or gray.
!10

E!J~

MocDoodle
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The same window,
reduced in size. The
scroll bars are now actiue,
and appear in darker
gray.

~

Archal'Optery x

~

Bogart

~

N

o

~
B~ar

D

B utt~r fiy

1 .EPSF

~

Figures 1.5 and 1.6 are two views of one window. You can click in the
zoom box, at the top right of the window, to change from one size to the
other. The scroll bars of the smaller window are dark, or active; this means
T E that we can use them to move, or scroll , around to look at all the icons.

S peaking of icons: so far , we've looked at icons fo r programs. Othe r icons
rep resent files-say letters o r drawings-or they can represent folde rs . A folder
o n your screen does just what a manila folder does: it's a way to o rganize things.
You can put programs and documents into folders .

•'

rw• Different icons. A program icon, such as Illustrator, may take any
shape. A file icon. such as Resume, generally takes the shape of a
standard sized letter. A folder icon, like Virus. info, looks like a
manilla folder.

/l

....r·f·-.
/

'
'

Illustrator

If
LLI
Resume

LJ

Virus .info

You can move windows around, as well as resize them. You can put folders
inside other folders- all in the interest of setting up your computer enviro nment
for the way you want to work.
Now let's look at the rest of what you see on a Macintosh screen.
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The first thing you'll notice is the menu bar, across the top of your screen.
T he menu bar has listings of commands that you work with: to open a program
or a file, make a copy of a file , or print.
As well, there are icons outside of the window. These usually represent disks
that you've inserted into the computer, or are built in to the computer.
All of the icons, taken together, and the menu bar, are called the desktop . As
with all of the terms we' re using, the computer term is a representation of things
we already know. A desktop is simply the place where you work. On it, you can
see icons for disks and programs, and other tools we'll look at. Here's an example of a desktop:
:

A Macintosh desktop. The disk '·Blue Note," is open, so a window

with the same name appears on the screen.
Menu bar

j

Window
Edit

Ulew

La bel

//

'1"" ~- . ~
Illustrator

~

[MJ?1ll
More

2ni

e~

Thtori st

Balloon help

Speci a l

1$ ~

Compost,.

WordPerft>ot

File-Maker

'tfb

~

HyptrC• rd

~
Exctl

MaoFtow

Tarskl 's World Supt rP.aint
~

••
Go

~

k.

LJ

P hilosophy

Folders

Trash icon

You access the menu bar with the mouse: by clicking and holding the mouse
button down on any menu; you'll see a list of commands.
For example, if you clicked your mouse on the File menu, you'd see this:

II
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The File menu.

•:111n. Edit

UiPUJ

New Folder 8€ N
Open
8€ 0
Print
:•:P
[!OS(~

"un~

·upen anything you've selected
Print anything you've selected

Window

Get Info
Sharing ...

8€ 1

Ouplit:<l1 (~

:•:n

Make Alias
Put Away
. . . ..

8€ M
8€ Y
...

Find .. .
Find Again

8€F
8€G

Page Setup .. .
Print Desktop ...

a new folder in the window

Close the window

. - - - - -These commands are more
advanced but, as with all others,
just let you work with the icons
in the window.

. - - - - -Youc an find any icon
(program, file or folder)
on any disk.
. - - - - -These let you change
printing options.

I

Outside of the window, there are separate icons for disks, and one for the trashlogically enough, when we want to throw something away.
The "Blue Note" window shows the contents of the disk of the same name,
visible at the top right of the desktop. The window contains several icons. Note
the difference between program and folder icons.
We're learning a lot of terms here-desktop, folder, window. But note that
each term, and the picture it represents, is designed to be something you're
already familiar with.
This is becoming generally true for personal computers: they' re made to
work the way you think, instead of the other way around.
An especially nice feature as we go is Balloon Help : if you want some help
on any menu or tool, go to the Balloon menu, towards the right of the menu bar,
and choose Show Balloons . Then move your mouse over any part of the
screen, and wait for a second. You'll see a short explanation, in the form of a cartoon-like dialog box, for any feature you point to with your mouse.
Let's work with the things we've seen.

Getting Started with

MyLabelDesigner
Powerfully Simple Software
MyLabelDesigner is easy to learn and use. Please start by:
studying the package to get an overview of MyLabelDesigner
completing the following Quick Start Tutorial
reviewing the MyLabe!Designer Manual
reading the Read Me First file on the Master Diskette

Installing the Software:
Requirements
A System version 4.1 or greater (including System 7)
. 512K Memory available
. 800K or 1.4M Floppy Drive
The Master Diskette

T•~•t

~

""'h¢~,~--------------~1¢~~

""'

Hard Disk Users
MyLabelDesigner is not copy protected, so you can copy the Master
Diskette to a new folder on your Hard Disk by dragging the Master
Diskette icon onto your Hard Disk icon.

Floppy Disk Users
Create two disks that contain the following:
Disk 1. A System Disk containing the System and Finder.
Disk 2. A copy of the MyLabe!Designer Master Diskette.
Always run from a copy of the MyLabelDesigner Master
Diskette and store the Master Diskette in a safe place.
2217-GS-1

MyLabelDesigner

Quick Start Tutorial
5 minutes to learn the essentials

Double click on the MyLabelDesigner
icon.

~

My La belDesigner

Enter your name and address and click
OK. The following screen will appear:

the Tools Bar are defined as follows:

[IJ

Arrow Tool - used for selecting
and moving objects (text, lines,
pictures, rectangles, etc.)

lAbel

Text Tool - used for creating text
fields in the label

~

Line Tool- used for drawing
horizontal or vertical lines and
for setting the width of lines,
borders and outlined rectangles

[Q
[8]

Border Tool - used for adding
a border to the label
Outlined Rectangle Tool - used
for drawing squared or
rounded rectangles

=

Filled Rectangle Tool -used for
drawing squared or rounded
rectangles which are filled in

~
~
[±]

In the middle of this screen is the Design
Label. This is where you design your label
as it will be printed.
The at the top of the label are the Quick
Access Buttons for printing and defining
label specifications and the Statistics Box
to show you pertinent statistics (e.g. font
size, line length, and label size).
The Tools Bar below the Design Label
contains the tools available for
designing your labels. The tools on

Picture Tool - used for adding
pictures to the label

Size Nudge Tool- used for
making small changes to the
size of an object
Position Nudge Tool - used for
making small changes to the
position of an object

To use each tool, simply click on
them with the mouse pointer. To
teach you the use of these tools, the
following Tutorial will take you
through the steps of creating an
address label like:
~ftware ComG,""Y
1259 Camino Real utte 167
Menlo Park CA 94025-4298

CW1W.H~•

3600 Co\U\tyvi•" Ori••
Mill V&lloy CA 94941

The first step in creating a label is to
determine what size label you are
going to print out on. To do this:
1. Select a shipping label size from the
Labels Menu by:
a. pulling down the Labels Menu.
b. moving the mouse to
Mailing/Shipping.
c. without releasing the mouse
button, move the mouse to the
right until it is over one of the
label sizes. For example:

(The sizes may vary depending on
what type of printer you are using.)
d. release the mouse button. The
label on screen will now appear in
the label size selected.
2. Now that you have selected a label
size, you can start adding objects to the
label. To quickly add your return
address, select Add Return Address
from the Layout Menu.

The name and address you typed in for
your User ID when you first started up
the program will be placed in your
label.

until the address is in the upper left
comer of the label. (This is called
click, drag & release)
MySofttRare Company
t2S9 Bl t:amino Real Suite 167

Menlo~':~-:~-~.~~.~~~~~·--····-····--·--··-~

................-........,

1··-......................

~

I

I

lI. . . . . . . ._. . . . . .-.. . . . . . . . . _. . . . . . . . . . . . . . . 1

Notice the dotted lines that are drawn
while the text is being moved. These
lines are guides and can be used to
align the text with other items in the
label.
4. Release the mouse button. Your
address will be moved to the specified
location.
5. Click on the thickest line on the
Line Tool in the Tools Bar.

~~
The mouse pointer will change to a
cross bar.

+
6. Position the pointer below and to
the left of your address. Hold down
the mouse button and, without
releasing the button, move the mouse
horizontally to the right until the line
is as shown below:
MySoftware Company
!
1259 El Camino Real Suite 167l
Menlo Park CA 94025-4298
l
I

3. To position you address in the label,
point to the address, hold down the
mouse button and, without releasing
the button, move the mouse

Once the line is the desired length,
release the mouse button.

7. If this line is not in the desired
location, ~lick on the Arrow Tool.

~
Now, simply click, drag & release it, as
you learned in Step 3 above.
8. Click on the Text Tool in the Tools
Bar.

lAbel
The pointer will change to be an
"I-Bar."

I
3. Click in the lower middle portion
of the label. A two line edit box will be
displayed. Type a friend's name and
address into this box.
Curt W. Harri!

.3600 Coui

!

Press Return after each line typed and
a new entry line will be created.
5. Once you finish typing, click outside
the edit box. The edit box will be
removed, and your friend's name and
address will now appear in the label.
11. Click on the Border Tool in the
Tools Bar.

A border will be added to the name tag
in the thickness currently selected in
the Line Tool.

33. To print the labels, click on the
Print Button.

Print
A dialog will ask you how many
copies of this label to print.
34. Enter the number of copies you
wish to print. Click OK in this dialog.
35. The standard Macintosh Print
Dialog will then appear. Click OK and
your labels will be printed in the label
size that you selected.
36. To save this file, just select Sav:e
from the File Menu. A dialog will
appear asking you to name the file.
Enter a file name and click on Save.

That's it for the basi~$
of creating & printi~g
a label.
To create a set of similar labels, s~
Chapter 8 to learn how to use the
Next in List feature.
If you have a color monitor, you. may

change the color settings of your
screen. To do this, simply choose
Color Selections from the Display
Menu and enter the desired colo,rs.
See Chapter 10 of the Manual for
more information.
We recommend that you now read
the package cover and review the
manual to get an idea of
MyLabelDesigner's other featureS.
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The Balloon Help icon
and menu.

Rbout
Show
Finder Shortcuts

A help balloon. We produced this by turning Show Balloons on,
and dragging our mouse ouer a scroll bar.

Scroll bar
To scroll a little at a time, press
one of the scro11 arrows. To
scroll by the windowful, click in
the gray bar. To scroll to another
part of the window, drag the
scroll box.
Folder

Folder 2

HANDS-ON

[I] Mouse and Cursor.

Move your mouse around and see how the arrow cursor moves correspondingly on the screen.

~ Selecting. Point to a folder (put the tip of the arrow on any folder icon) and
click the button on top of the mouse-press it once lightly, and release it.
The folder you chose should change its appearance: it used to be dark on
light, and is now light on dark. We say it's selected and, in the Mac world,
what we usually do is select something and then perform an action on it.

lfi WELCOME TO ... THE MACINTOSH: FP-OM MYSTERY TO MASTERY
Selected versus unselected icons.
Busine-ss

@J Dragging. Click on an icon , hold the mouse button down, and move the
mouse in any direction. Whatever you selected moves with the cursor.

0

Moving Windows. Click and hold in the title bar , and move the whole window around. Click in the zoom box to change the size of the window.

WJIUfHf' A title bar.

Blue Note

Click in it again to restore the previous size. Press the mouse button and
hold it down in the resize box at the bottom right of the window. Move your
cursor down and to the right to increase the size , up and to the left to
decrease it.

[II

Closing Windows. Click in the close box, at the top left of the window.
Oops. The window closed, and where it was, we see a closed folder of the
same name. No worry-we can get that window back.

QJ!!If111The close box.
Just click on the folder to select it, and choose Open from the File menu.

[I] The menu bar. Remember that this is at the top of your screen, above any
windows. There's a small picture at the top left of an apple with a bite taken
out of it, and then the words File , Edit , View , Label , and Special.

CIJ Menus. Move your mouse so the cursor is over the File menu, and then click
and hold the mouse button. See how the menu 'drops' to show the various
commands available.
Move the cursor down the menu and see how most items in turn change
from dark on light to the reverse, to show each is selected.
Release the menu, go back to your window, and:
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folder, to select it.

~ Click on the File menu, and select the Open command. Your folder should
open.

[!QJ Scrolling. If the window is too small , not all of the icons may be visible.
Note in Figure 1.15 that you can see only part of some icons at the bottom
of the window. If you don't want to change the size of a window, you can
scroll around the window.
This is hard to visualize at first, but think of the screen within the window as a
piece of paper and, through the window, you can see part of it. Scrolling is
moving the paper behind the window.
You can scroll both vertically and horizontally-as long as there's part of the
window that isn't visible. The window in Figure 1.15 is sized so that we can't
see all of the contents of the folder-part of some icons are cut off at the bottom. We need to scroll the window to see all of those icons.

[ii] How to scroll. We do that with scroll bars, found at the right side and at the
bottom of the window. At either end of a scroll bar is an arrow.

If there's anywhere to scroll, the bar itself will be dark gray, and there'll be a
scroll box somewhere in the bar. Click on the bottom arrow in the vertical
scroll bar until those mysterious icons are fully in view.
Using scroll bars.

Archaeoptery x

~

Banana

~

~

Bogart

~

~

~
Bear

D
B uu
Bugs

Butterfly 1.EPSF

With your mouse, point to the
down arrow at the bottom of the
vertical scroll bar, and click. See
how the window moves up,
since you've scrolled down.
Click again, and the window will
scroll farther.

WELCOME TO ... THE MACINTOSH: FROM MYSTERY TO MASTERY

DISK BASICS
Now that we have the idea of windows and menus, let's look at a disk, specifically
floppy disks. These small disks are called floppies because the actual material
inside the protective jacket is pliable. Most floppies measure 3.5 inches on a side.
That size was chosen so that they would fit into a shirt pocket or a business
envelope. The actual disk is a sheet of plastic with a coating on both sides like that
on cassette tape. Other disks are larger devices called hard disks, often built into
the computer, which can hold many times more data (that is, programs and files) .
A floppy disk.

Label recess
Shutter

The computer accesses a floppy disk through the shutter, the metal part of
the disk. Let the computer open the shutter-we don't need to , and doing so
risks letting dirt, or a fingerprint, get onto the disk surface. Aside from coffee, the
greatest natural enemy of a floppy disk is your fingerprint.
A prime rule of computing: be good to your disks, and they might be good to you.
When you're starting out with computers, losing work seems like a
main concern. It's actually not an easy thing to do, if you keep a few
simple rules in mind. Among them is to take good care of floppies.
WA RNING The blank disk costs a dollar or so, and can hold weeks of work. The
value you add to a blank floppy argues strongly for taking care of it, as well as
making backup copies. What you're really caring for is your data.

W ORKING WITH A D ISK

C!J Labeling a disk. First, write your name on the adhesive label that came
with your disk. It's best to do this before putting the label on the disk because
otherwise, the pressure of your pen on the protective cover might cause it to
touch the disk surface, rendering that part of it less reliable.
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How to Take Care of Floppy Disks.

• Keep them in a protective case. If they're loose in a desk or briefcase, they're
easily damaged.
• Don't expose them to temperature extremes, such as you might find in a car
trunk or dashboard.
• Magnetic fields , such as near telephones or on the left side of a compact
Macintosh, can erase data.
• Walk floppies around airport X-ray machines. The X-rays don't do the damage; the magnetic field around the motor moving the belt does.

[f) Put the label on the disk,

in the recessed area on the top-that is, the side
without the turntable showing. (Depending on the size of the label, part of it
may fit over the top of the disk onto the back, but the whole label should fit
entirely within the recessed area).

If you put the label on the wrong side, over the turntable the computer uses
to tum the disk, it will be even less reliable.

@J Inserting

a disk. We always put the disk in the Mac with the shutter forward and label side up. Insert the disk and push it in the drive slot-the computer catches it and pulls it in when you have it in most of the way.

8J Formatting. You will see a box with a question (called a d ia log box) like
Figure 1.17. It tells us that since this new disk has never been used, the computer doesn' t recognize it, and so it needs to format it to hold data-like
putting grooves in a record (remember records?) to hold music.
The formatting dialog box.

+

~

This is not a Macintosh disk:
Do you want to initialize it?

[

Eject

J (One- Sided)

(Two-Sided)

iii
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We're going to format this disk as two-sided , which most are these days.
Older disks were one-sided.

~ Click your mouse on the Two-Sided button.
The Macintosh cautions you that this will erase anything already on
this disk. This is valuable information if you 're erasing a disk that
already has data on it. But this is a new disk, so you're OK.

• · 1•1:• The second dialog box in the formatting process.

it
(
~

•

•

This process will erase all
information on this disk.

Cancel

~

)

Erase

~

Click on Erase. The Mac then asks you to name your disk.

.

....

,.~

The Macintosh asks vou to name your blank disk.

•

~

Please name this disk:

IUntitled

~

I
OK

~

GJ Type your name, and click on OK. If you mistype, just backspace past the
error and retype . You can change the disk name at any time-you'll see how
a little later.
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The computer takes a minute to format the disk. After the noise in the disk
drive stops, look on the desktop on the screen, toward the top right. There
should be a new icon representing a disk, with your name below the icon.
This disk icon should be selected. If it isn't:

[II Click on it to select it.
[!] Choose Open from the File menu.

J-.
L:::::::l

Or, as a shortcut, you can double-click on the disk icon: click on it
twice, quickly.

SHORTCUT

You'll see a window for your disk. In Figure 1 .20, we formatted a floppy and
named it "My Floppy. " We then opened its window.
Its window is largely on top of the hard disk window, and is next to the window for MacDoodle, a folder on this computer's hard disk.
Looking at these three windows, note that MacDoodle looks different from
the others. It's the only one to have thin horizontal lines along the top, on either
side of the title. It's also the only one to have visible scroll bars, although the
other windows have rectangles set aside for them.
MacDoodle is the active window on the screen. At any time, there can only
be one active window, and that window is always in front of any others.
To make another window active, just click on it.
Manipulating Windows on the Desktop.

• To make a window active and bring it to the front, click in any visible part
of it.
• To move the active window on the screen, click and hold its title bar. You
may then drag and position it where you want it.
• Any icons that appear gray on the desktop have open windows.
• Windows will reopen in the same position they were in when they were last
closed.
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The MacDoodle window, showing the contents of the MacDoodle
folder on the hard disk, Is the actfoe window. It would appear In
front of the My Floppy window, If the two ooerlapped.

With different disks and folders , all with windows, in your computer, you can
do necessary things like compare what's on one disk with what's on another, by
checking out their windows.
As well, you can copy a file from one disk to another, by dragging its icon
from a window of one disk, or a folder on that disk, to the window of another disk.

COPYING FILES
Copying a file, as shown in Figure 1.21, is as easy as dragging an icon from one
window to another.

IIJ Choose a window on your computer that has files in it that you can copy to
your floppy disk.
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Before copying any file, whether a document or a program, make
sure you have permission to do it. Most programs are copyrighted ,
and you cannot legally make a copy unless you have bought a license
to use the program.

ITJ Move windows around, by dragging their title bars, so that both the file you
want to copy, and the disk window you want to copy it to, are visible.

~ Click a nd ho ld o n the file icon , and drag it into the receiving window, as
shown in Figure 1.21.
Your Mac tells you it's copying and, after a moment, you' ll see an icon for
the file appear in the receiving window.
We want to copy the file "Boats" from the MacDoodle folder on the
Hard Disk onto My Floppy. Click anywhere In MacDoodle to make It
the active window. Then click and hold on the Boats icon. and drag It
over into the My Floppy window before releasing.

C•stle

C•t

ORGANIZING YOUR DESKTOP
A primary use of folders is to keep things organized. If you copy several files , perhaps of different types, onto My Floppy, you may want to make some folders on
that disk, and put files in them.
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DJ Click in your floppy disk window to make it active.

I2J Choose New from the File menu.
You now have another icon in your floppy's window, named Untitled Folder.
We've just created
a new folder on

My Floppy
SKin disk

777K avoilabl•

My Floppy.

Boats

To name it, type anything you want. Try "New Files, " for example. Shorter
names are advantageous.

@J

'

Click on your file icon, and drag it over on top of your folder icon. When
both icons are selected, release the mouse button.
· IW-#l:J To moue Boats into

New Files, just click
on the file Icon, and
drag it ouer the
folder icon, so that
both become
selected.

§[]

--·-----

2 it•ms

-

My Floppy
SKin disk

I

0~
777K availablt

Q

IDml
'

0
¢1

1¢ Q]

The Boats icon disappears. Not to worry- you haven't lost it. It's in the New
Files folder.

0

Double-dick on the New Files folder, to open its window, and confirm that
your file is actually there .
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When we dragged Boats from the hard disk onto My Roppy, the original stayed put and a copy was written onto the receiving disk. But
when we moved Boats into a folder on the same disk we moved, rather
than
copied, the file.
N 0 T E

This design suits normal usage: we most often want to copy files from one
disk to another, but move a single copy around on one disk.

FINDING FILES
With the ability to move files into folders (and even folders into other folders), it
may seem easy to misplace something. But the Mac has a feature to obviate this.
The Find command on the File menu lets you find any file on any disk in
your computer.
The Find Command.

Find
Find: IBoats
More Choices

Cancel )

n

Find

l

It shows you where the file you want is located, and you can then click on
that icon and drag it out of-one folder into another, or open it.

CHECKLIST
Make sure that you understand what icons and windows mean. These form the
basics of the Macintosh filing system-how we manage the data on our disks. In
practicing with these tools, you've learned how to
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• open and close windows, and scroll within them,
• use balloon help,
• format and name disks,
• copy files from one disk to another, and
• move files among folders on a disk.
By mastering these concepts, you 'll have done more than you think. This is
because most Mac programs use the same graphic interface. As we go along, in
graphics, word processing, and managing data, your sense of this graphical,
visual system will be most valuable.

HELPFUL HINTS
Congratulations! You've done about 90 percent of what Mac users do every day
to move around their computers. To practice what you've learned, try making
new folders, and moving files or programs into them. You can put folders inside
other folders too. Go ahead and play.
The most important thing to understand at this point is not any mass of details
about that mysterious computer. Rather, you should realize that the interface, or
what you've been working with, is designed to work with you, not against you.
The details aren't so important and, in any case, become automatic in just a
little while. What you have at your command now is knowledge that the computer in front of you displays what you need to know in a graphic, intuitive format. With a little practice, you can easily grasp and work with it.

Q&A
Q: I seem to have lost an icon. At least, I can't find which folder I've

put it in. I also remember only part of its name. How do I find it?
A: The Find command on the File menu is meant just for this. You only need to
type part of the name, and the command shows you everything it finds with a
name including what you typed. If the first icon it finds isn 't what you want,
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choose Find Again from the File menu. Careful, though: the name or part
of it you type has to be exact. If your icon was named "My.Document" and
you searched for "My. Doc," you wouldn't find it, since the find request has a
space after the period.
Q: My electronic desktop is even more cluttered than my paper

one. Is there a fix?
A: There are two. The first is the Clean Up Window command in the Special
menu, which snaps every icon to an invisible grid. Holding down the option
key while you choose this changes it to Clean Up by Name (alphabetically).
Selecting one or more icons and then holding down the shift key while
choosing Clean Up then moves only the selected icons.
The second way to impose order on chaos is to choose another view from
the Views menu. The list views, especially the By Name (alphabetically) and
By Date (most recent at the top), make things easier to find. Personal preference is your best guide.
Q: My mouse doesn't move very smoothly around the screen.

A: There are three possibilities here. The first is that the cable connecting it to the
keyboard or computer is loose. Be sure that the mouse or keyboard isn't placed
far enough away so as to stretch the cable and encourage it to become loose.
The second possibility is that your desk's surface isn't of a kind your mouse
likes. The ball on the bottom of the mouse needs a little traction to be turned,
and turns erratically if moved on a smooth , polished surface. The solution,
and a good idea for the reason below too, is to get a mousepad.
The third possible reason is that the mouse's ball and surrounding cavity has
become dirty, and this is a common problem . But it's easy to follow the
instructions in your owner's manual and take the ball out, and clean it and the
cavity it lives in. This is good preventative maintenance anyway, once a week
or so. Using a mousepad keeps your mouse cleaner.
Q: I want to drag an icon into a folder, but I succeed only in dragging it on top of the folder.

A: You need to drag the selected icon completely over the folder, so that both
show as selected.
Q: I tend to lose smaller windows behind larger ones.

A: "Window management" is something of an art. Sizing and positioning open
windows so that the ones behind the active window stick out on one side
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becomes a habit after a while. Or, small utility programs can add a Window
menu to programs that lack it, including the Finder. See the note on shareware at the end of this book for a recommendation.
Q : Should I buy single-sided, double-sided or high-density floppies?
A: Numbers first: the single-sided disk holds 400K, the double-sided BOOK, and
the high-density 1400K. For a large file you may need a high-density disk.
Otherwise, since floppies tend to get lost or sat on with disturbing frequency,
why not have your data distributed over a larger number of lower density
disks? The single-sided disks won't hold very much as they're meant to be
used, so many people format them as double-sided and use them that way.
The reason not to is that although the single-sided and double-sided disks are
manufactured the same way, only the double-sided disks have passed the manufacturer's testing on both sides. So it's a little safer to buy double-sided disks.

(HAPTE~
COMPUTER
GRAPHICS
In this chapter, you'll learn how to:
• create graphic images on a Macintosh
• use a variety of painting tools
• save your graphic onto a disk
• work with advanced painting techniques
• copy all or part of a graphic, and paste it into a new file
• use on-line help
• print a file
• work in different graphics modes
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For any of you with artistic leanings, Macintosh graphics may be a step into a
wonderfully versatile and highly capable medium . You can do so much, so easily
and so accurately, with computer graphics, that it's exceptional to find professional graphic art and design these days that wasn't done on a computer.
Other advantages abound as well. Art in electronic form can be sent across
the country by telephone line to benefit from a colleague's ideas. Of course, you
can fax conventional art as well, but that copy isn't as good as the original, while
the computer copy is identical to the original.
You can make any number of changes to your art, and then undo some or all
of them. There 's nothing like trying this or that, then changing it, to give you a
sense of what works well.
What if you don't aspire to aesthetic expression in drawing or painting?
There's still a great deal of value here, because a graphics program is the best
way to learn how to use a Macintosh application (a program that produces
something, e.g. a painting or a letter. The system programs that you learned in
the last chapter don't produce anything for you; they let you manage the computer and files).

LET's START
Most programs on the Mac are started by selecting the icon for that program,
and choosing Open from the File menu- or, as a shortcut, double-clicking on
the program icon.

OJ Starting up. Select SuperPaint and choose Open from the File menu, or
double-click on the icon. It takes the Mac a moment to read necessary parts
of the program into memory.

C3J The painting area and tools . After the Mac has read the parts of the
SuperPaint program it needs, you'll see a screen like Figure 2. 1. This is a lot
at once, so don 't worry. And notice that there's still a menu bar- although
there are more menus- and a window with a title bar and zoom, close, and
resize boxes, and there are still scroll bars.
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SuperPalnt's main window. A large combination of shapes, textures,
patterns and colors (with a color computer) is possible.
Paint (a paintbrush)
and draw (a compass)
modules. Paint is
selected here.

The pattern palette:
Line pattern
pattern

,..

........._

D
0 0
0

Ill(
!+--Geometric
shapes

G

)

dropper

/

-z,... ••- - ·Freehand

Grabber ~

{;I (\ • •- -Magnifying Glass

Eye- ~

hand

You've just opened this program for the first time, but you a lready
know your way around half of it. This consistency among programs is
partly why the Mac is so easy to learn.
N 0 T E

What's new are painting tools, along the left side of the screen, and a palette of
patterns along the top.
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@J Select the Paintbrush tool by clicking on its icon.

0

Move your cursor into the painting window, and click and hold the mouse
button down.

0

Move your cursor around the window, keeping the mouse button down .
Release it when you like what you see.

~ Paint another line or shape in the same way.

CIJ Go back to the tool palette and choose another tool. Paint something with
this.

0

Time for fun. There are lots of tools and patterns. Check out several of
them. If you don't like your last step-spilling the paint bucket is commongo up to the Edit menu and choose Undo. This feature has saved a lot of
people a lot of grief.

SAVING YouR WoRK
Speaking of grief, another reliable source of it in the computer world is losing
your work.
In the last chapter, we simply moved files and folders around, and the
Macintosh kept track of what we were doing . With SuperPaint and most other
application programs, though, we need to save a copy of our work periodically.
This is because what you see on the screen, whether a simple drawing or a
doctoral dissertation, is on chips in a part of the computer called RAM, or random access memory.
This is to say, its present existence is in the form of electrons. Should there
be a power failure, or failure of a computer component, the electrons go away
and your work goes with it.
There's a simple remedy for it, and your friends ' horror stories are almost
certainly the result of failure to observe a few easy precautions.
[ ~ The most important precaution ~ also the easiest saue often .

WARNING
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Saving writes a copy of what's in RAM onto a disk. What's on disk is relatively permanent and reliable.

HOW TO SAVE
Go up to the File menu and select Save. Since this is the first time you're putting
a copy of your work onto disk, the computer has to know things such as a name
for the file and where to put it. It asks you in the form of a dialog box like Figure
2.2. This is initially a little confusing, so let's look at some parts of the dialog box:
The Save dialog box. This will look nearly the same in every program you use.
Disk name and
amount of free space.

Folder or
disk name.

""'I

(g)~~ flopp~ disk

Present contents of
folder or disk, if any.

..- 1

s

""'

~

(g) My floppy disk

784K auailab le

(
(

Eject
Desktop

"0
Saue document as:

I

I

Name for your painting.

® SuperPaint 3.0

/'
/

File format.
Leave SuperPaint
selected.

0

Saue as:

)+)+-

n

Saue

D+-

[

Cancel

)+-

IPICT

I

Buttons:
Save puts a copy of
Eject removes your
floppy from the Mac, so your painting onto disk.
you can use a different You have to name your
painting first.
one.
Desktop gives you a list Cancel removes this
dialog box from your
of all disks in the Mac.
screen.

• At the top right is the name of the active disk drive. On many machines there
are two disks to choose from: the hard disk inside, and the floppy you inserted
and formatted.
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Be sure to save your work onto the right disk, probably your floppy, with your
name as the disk name. If this first small box at the top left doesn't show your
name, click your arrow on the Desktop button to list all of the active drives.
Then double-click on your disk name.
• The largest box now lists the contents of your disk (or active folder). It might be
empty at this point.
• The next box down is labelled Save document as: and here's where you give
your file a name. You can call your painting "Rembrandt Redux" or anything
else except that file names on the Mac can't be longer than 32 characters, nor
can they contain a colon.
• Click in the Save box, and you'll be returned to your painting.
• All succeeding saves are much easier. The name and place are determined,
and the computer simply replaces the older version of your work with the
newer. So successive saves just update what's on disk with what's in memory,
and should take about five seconds.
As good habits are as easy as bad ones, please nourish the habit of saving your
work often .

ADVANCED PAINTING

OJ More tools. Back to going wow with the paint tools. Several of them have a
neat trick: click and hold on the icon, and a pop-up palette is displayed, with
more tools. Click on the one you want, and the tool icon changes to reflect
your choice. Try this with the Paintbrush tool. Change this tool back to the
original Paintbrush before going on.

I:IJ More features. The tools are lots of fun, and the menus have neat stuff. Go
to the Paint menu and choose the Brush Symmetry command. Click on
two or three lines in the symmetry box. In the illustration, we clicked on the
diagonal lines to make them heavy, thus active. Click OK, and see what the
paint brush does now. This is just a sample of the elegant features you'll find
in computer graphics programs.

@J Try a slanted paintbrush with Brush Shapes under the Options menu. You
can choose a pre-defined brush shape, or make your own, by clicking here
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The Brush Symmetry
dialog box. Click on
Mirrors, then on the
lines In the symmetry
box that you wish
SuperPaint to mirror
when you paint lines
with the paint brush.
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Brush Sy mmetry

0

@Mirrors

0

None

Radial

@2

06
07

03
04

OB

os

09

Cancel )

n

OK

)J

and there in the magnified view box. Each click you make on a white area
changes that pixel (the smallest dot visible on the regular screen) to black.
Click on a black pixel to change it to white.
Change the paintbrush shape. or design your own.
Click any shape to select that as
your paintbrush.

•

-"

• • -"'
••
/

•

•

:

X

X

/

••••
••
••••
••
••••
••
••••

Or, click in the large box, and then
click anywhere to create a custom
brush shape.

(

fl<wert

(

Cancel

)

~

OK

l
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.....

A custom paintbrush .

Simply click and hold
down the mouse button,
dragging the editing window, ta create the shape
you want.

••
•• •
••••

8J More fun. Use Fatbits by choosing the Pencil tool, holding down the
Command key (which , from one Macintosh to another, may have a cloverleaf or Apple symbol, or may say Command) and clicking on the part of the
screen you want to enlarge by 8x. To leave Fatbits, command-click on the
smaller view on the left side of the painting area.
Wtth the pencil tool chosen, we commana-clicked on the area of the
painting at the center of the dotted square on the (eft. Ihe screen
then divided into two parts, with the larger part on the right showing
an Bx magnification of the area within the dotted square on the left.
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I}] Options.

Many Mac programs use the double-clicking technique for various
things. Try th is on some tool icons such as the P enci l, Eraser, and
Paintbrush . Also, holding down the Option or Shift keys changes the way
some tools draw. Set the Paint Pattern to none in the palette, choose a
shape tool, such as the Oval, and then check out the Paint Multiple feature
under the Paint menu.

~ In general, get a little loose and have a good time. Wonderful for stress.
We used Brush Symmetry first, then a couple of freehand strokes,
then Paint Multiple. But what does it mean?

The other great antidote for stress is saving often.
Your first save was complicated, with t~e dialog box. Every succeeding
save of this file is very easy-just choose Save from the File menu,
and you're done.
N 0 T E

We recommend that you nourish the habit of saving at least every five minutes.

El
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SAVE AS
Let's take a break from all of this creative activity to look at a useful feature of the
Mac system. Let's say that you've named your painting "Monday Morning. " It's
fairly good, but you want to add to it, to make a painting called "Friday Night,"
while keeping Monday Morning intact.
You can do this by using a command on the File menu similar to Save, called
Save As. This creates a second copy of what you have on the screen , without
touching what you last saved to disk.

OJ Choose Save As, and get the standard Save dialog box, just as though you
were saving for the first time.

(I] Type a name for your new file , and click Save.
You're now working on your new file. The earlier version is dormant on your
disk. This feature has several uses. Incremental saves are valuable if you're not
sure about the additions you want to make to your painting.
You can also make several versions of one basic document, for different purposes.

COPY AND PASTE
Back to your painting, and another very useful feature: you can take just a part of
your file, and copy that to a new document.

OJ Select the Marquee, the tool that looks like a rectangle drawn with a dotted

.

line, which you'll see at the top right of the tool palette, just above the
Paintbrush icon. This tool is used to select part of a painting.

,

:t Use the Marquee, or
Selection Tool, to draw
a rectangle around the
part of a painting you
want to copy.

A [~

~~
i5 t

The selection tool
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[I] Put your cursor at the top left of what~ver part of your painting you want to
select.

@J Click and drag down and to the right, until the dotted rectangle you've drawn
encloses the area you want to copy. Then release the mouse button.
Part of the painting is selected: a line of mooing dots describes the
rectangle we've drawn.
/The selection marquee

~---------------------------------

1
I
I
I
I
I
I

0

Come up to the Edit menu and choose Copy.

[I] Choose New from the File menu.

~

N 0 T E

Conceptual point here : you can have more than one file open at a
time. This is handy for moving data from one document to another, or
comparing two versions of some work.
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[II Choose Paste from the Edit menu, to paste this part of your painting into
the new (blank) document on the screen.
I

We selected part of the original painting, copied It, started a new file,
and pasted the selection Into lt.

Untitled - 2 < 8 >

Copying and pasting uses a part of the Mac's memory called the
Clipboard . You can move data around any number of times. It gets
spectacular when you move something you've painted, or numbers
N 0 T E from a spreadsheet, into a paper you're typing. And we almost always
do it in the same way as you just did.

r:21

Because the Clipboard is memory (RAM, electrons), what's in it doesn't last
after you tum the Mac off. So we have another place to store data, one that lives
on disk. We call it the Scrapbook .

THE SCRAPBOOK
This is an Apple Menu item, a small program in the Apple menu, at the far left
of the menu bar. These programs are also called Desk Accessories.
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Their advantage is that you can run them at the same time as SuperPaint, or
another large program.

ITJ Take your cursor up to the Apple menu, at the far left of the menu bar. Click
and hold here, and move down to the Scrapbook.

@J Scroll through what's there with the horizontal scroll bar below the picture
window until you find something you like. Then copy it, using the Copy
command in the Edit menu (no need to select it-the visible picture in the
Scrapbook window is already selected).

0

Click on the close box to get rid of the Scrapbook and use Paste to paste the
picture you chose into your document.

You would copy something (either painting or text) to the Scrapbook just like to a
new document.

ON -LINE HELP
SuperPaint has a nice feature to assist you with menu commands , tools, and
other parts of the program. This is its Help function, which you'll find under the
Apple menu, as the second item. Choose this, and you'll see:
The Help dialog box. Scroll to the feature you want help on, click to
select it, and then click on the Help button.

SuperPalnt Help
Click ~

topic in U.list, tMn click U. H•lp
button to shov YlfOt'fn.ltion on tNt topic ( or
cbb~lidc tM topic).

Button f uMUeas:
Pr•viMS : 90 to Uw pnvious H.\> p_..
fhxt : 90 to Uw ntxt H.~ P•·
0... : c1osH Supw-P~ in t 3.0 .Wlp .
H.lp : shows inf onnat ion on tM ul+<:ttd topic.
Tepios: r•b.rns to this p~.

You c:..n U::U tht ltrt .at'ld ric;tlt ¥l"OW ktt.~s
to 90 to ttw pnvious or rwxt pq.

About SuperPain t
Airbrush
Aligning Objects
Arc tool
AutoTrace
Bezler Objec ts
Bezler Settings
Bezler to Polygon
Bit Depth
Brightness & Contrast
Bubbles
Calligr aphy Brush
Capture Defaults

~ (Neut) (Done)

(

Help

•
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This is a useful tool, although the information isn't as complete as
what's in SuperPaint's manual. On-line help is a feature of more programs all the time, though, simply because it's immediately there when
you need it.

PRINTING
Well, your painting is complete and anyway it's time for lunch. Let's look at how
to print.

OJ Save it first. Before you print, save your work one last time. A lot of things
can go wrong during printing, and most of them take your unsaved work with
them.

IIJ Check out your printer. See that it's on, has paper, and is connected to
your computer. Specifics depend on how your Macintosh is set up, and what
kind of printer you're using. You may need to access the Chooser, another
Apple Menu item that lets you, logically enough, choose a printer.
l j •

~.,_.

The Chooser dialog box, shown here selecting a Laserwriter.
Chooser

Sel ect e LeserWriter:
John·s RlSCy Leser

•

Pr~vi~w

Beckground Printing: @on

In:
v

A

PP

leTelk

@Active
0 lnective

0 Off

7. 1

2
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With your printer turned on and chosen,

@J Choose Print from the File menu. The Mac responds with a dialog box like
Figure 2.13, for a Laserwriter. The Imagewriter or Stylewriter dialog boxes
read a little differently.

~·-

The Print dialog box. Standard use calls for one copy, all pages, no
couer page, paper coming from the printer's cassette, co/or/grayscale
printing, and the destination Is the printer.

LaserWriter " John's RISCy Laser"
Pages:® Rll

Copies:IIMI
Couer Page:

®No

0

First Page

Paper Source: ®Paper Cassette
Print:

0

Destination:

®Printer

Black: & White

Pri nt Color Bitmaps as:

7.1. 1

D

O From:
To:
0 Last Page
0 Man ual Feed

n Print

D

D (Cancel )

@Color/Grayscale

0

PostScript ® File

®Gray (Faster)

0

Color

This is a colo r document. Please make sure the
"Color/Grayscale" button is selected aboue.

If an option is currently selected, the little circle to its left (we call them radio
buttons) are darkened. To change an option, just click on the name of what
you want. No need to click in the button itself.

8J Do it. Click on the Print button, and watch your artistry take shape on paper.
[I] Quitting the program. After printing has completed,

you'll want to leave,
or quit, SuperPaint. This command is on the Rle menu, and is the last one at
the bottom. If you have made any changes to your file since you last saved it,
the Mac asks you if you want to save these. Click on your decision, then see
how the computer erases SuperPaint's palettes and windows, and restores
the earlier screen of icons and folders.

Notice that in your disk window, in addition to the icons you saw there before you
ran SuperPaint, there's a new icon with the name of your painting.
To retrieve your disk, put your cursor on the disk icon at the right side of the
desktop, click on it, and drag it into the Trash. The computer should eject your disk.

II

WELCOME TO .. . THE MACINTOSH: FROM MYSTERY TO MAsTERY

What you have on your disk at this point is a copy of a document you
made with a program. You can re-open this document on any Mac that
has SuperPaint. If you try to open your file on another Mac that doesn't
N 0 T E have SuperPaint, you'll be told that "The application is busy or missing. "
All this means is that the other Mac doesn't have the information needed to
read your document. It surely has several other programs installed, but those
won't help.
So, if you're planning to move a file from one computer to another, check
first that the destination computer has the program that you need, or (if you own
the program), take it with you.

SuPERPAINT's

DRAw MoDE

What you've done already in this chapter is cover the basics of one kind of Mac
graphics. It's given you a good sense of how to make illustrations on a computer,
and how to Save As into a new file, and Copy and Paste from one document
into another.
This last section goes into more advanced territory, something that is of
some interest to most everyone , and of great interest if you want to go further
with computer graphics.
In terms of computer graphics, there's a major difference between painting ,
what we've done so far in this chapter, and drawing, another kind of computer art.
In the paint mode, we created shapes and textures, and all of this art became
fixed on the computer screen at the time that we painted it. Just as though it
were oil or fresco. On our screen , we can select part of it and move it, just as
though we had cut it with a knife.

If you select part of an oval and move it, the paint you've selected moves with
your mouse. The figure is no longer an oval.
This is because although you painted the figure as an object, once you finished and clicked the mouse somewhere else, the object lost its integrity, and
became simply a collection of black dots on the white screen. So you can select
some of those dots and move them.
Draw mode is another way of doing things. When you draw a circle, as
opposed to painting one, the object looks exactly the same. But when you select
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II

A piece of your "canvas"
has been selected and
moved.

:--\J--:
I
I

I

L - - - - - ...J

and move something, you can only move the object as a whole. It maintains its
integrity.
To check this out, go back into SuperPaint (if you've quit), and:

OJ Click on the Compass icon, partially hidden behind the Paintbrush icon, at
the top of the tool palette.
Much of the tool palette changes, to reflect the different features and
functi o ns of SuperPaint's draw mode. Note especially that the
Selection Marquee of the paint mode has changed to an arrow-the
N 0 T E corresponding selection tool of the draw mode.

~

The tool palette with the
paint brush in front as
the top icon (at left) and
then compass in front.
These represent the
paint and draw modes of
the program. Note how
some other tools In the
palette change or gray
out when you change
modes.
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Choose the Oval tool, and draw an oval.
The resulting figure has selection handles-four black boxes-around it.
Reselect the Arro_w tool, and:

@J Click and hold with the tip of the Arrow on a handle, and drag it in any direction.
You can change the size or proportions of the oval, but not the fact that it's
an oval.
Figure 2 .16

An ova/in draw mode.

The other difference between paint and draw modes is that, since a paint object
is a collection of dots, or pixels, it's painted at the resolution of your Mac screen:
about 72 dots-per-inch. It prints this way, even on a Laserwriter with a resolution
of 300 dots-per-inch.
A draw object, conversely, is stored in your document as a description of an
oval, or other shape. When you print, the object appears at the full resolution of
the printer.
Note the difference between the ovals in Figures 2.14 and 2.16, for example. The former is rough, or "jagged," while the latter is perfectly smooth.
One looked just as smooth as the other on the screen, but the higher resolution of a laser printer is available to your drawings, not your paintings.
The distinction is remarkable in text, where text you paint again has the resolution of the screen, while draw text benefits from as much resolution as your
printer can offer.
So when should you choose paint or draw modes? To an extent, your
practice with your own work determines this. Paint offers a much
greater variety of textures, and you have complete flexibility over what
N o T E you select, cut into pieces, and move around. With draw mode, you
have higher quality resolution, and you can continue to work with shapes and text
after you draw them.
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Text typed in paint mode can be jagged when you print, while text In
draw mode will be as smooth as your printer can provide.

Weave a circle

Weave a circle

BEllER CURVES
The precision of the drawing mode is complemented by a tool of remarkable
sophistication, enough so that its introduction made it difficult to justify not using
a computer for most illustration work.
This is a way to draw a curve that carries with it control points that let you
make highly precise adjustments to the shape of the curve itself-not just its
height or width.
Figure 2.18 shows two Bezier curves that a re copies of each other. The
upper one, though , is selected , and you see added to it straight lines that come
out from points on the curve: one at the middle, the others at the end.
Structure of a Bezler curve. The curve on top, an exact copy of the
one below it, Is selected. Control points let you make precise adjust·
ments to the shape of the curve.

--.. . +
00

00
~'

/ ~

0 ~

Freeha~ller
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These lines end in control points. Clicking and dragging any of those points
changes the shape of the curve. Moving different points produces varying
changes.
In SuperPaint, you begin a Bezier with the Freehand tool in draw mode.
Select it and:

GJ Draw any shape you like.
SuperPaint takes a moment to calculate a set of Beziers that closely match
your freehand path.
In Figure 2 .18, we've added lines going from the curve to the control points,
for sake of clarity. In SuperPaint, the lines don't appear, but the control
points do, as you see in Figure 2.19.
SuperPaint calculated
Bezier points for this
freehand object. Each
point on the curve is
either a hinge point (box)
or smooth point (circle).
The three cur;ue points
on the right are selected,
thus outlined, and their
control points show as
diamonds near the curve.

!

Of the points on the curve itself, SuperPaint distinguishes between corner or
hinge points and smooth points . Dragging the control points affects hinge
points differently from smooth points.
SuperPaint creates a hinge point where it discerns e nough of a change in
direction in the freehand drawing. You can, though, select a hinge or smooth
point and change it to the other kind.
Depending on how your computer is set up, what you drew may show these
points. If not, select it (you'll see the four handles at the corners), and choose
Reshape from the Draw menu. Your object then looks like Figure 2 .19.

C3J Click on any point on the curve, and watch its control points appear. Drag
these around, to see how you can precisely adjust a curve after you've drawn it.
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CHECKLIST
You've explored the basics of computer graphics in this chapter, and learned
valuable features of the Macintosh system in general. You should now be able to:
• open an application program and produce graphic work,
• save your efforts to disk,
• use Save As, to update successive versions of what you create,
• copy part of your work to a new file or to the Scrapbook,
• access on-line help,
• distinguish conceptually between painting and drawing, and use each mode to
its best advantage, and
• print a document.

OTHER CHOICES
SuperPaint's flexibility in using both painting and drawing modes is matched by
Canvas, a faster and more expensive program with a larger feature set, and a
toll-free number for technical support. Other programs offer either paint or draw,
not both.
For painting, take a look at UltraPaint, Amazing Paint, Cricket Paint, or the
program that started it all, MacPaint.
More sophisticated effects in gray-scale and color are available with paint
programs like PixelPaint, Digital Darkroom, Adobe Photoshop, lmageStudio, and
ColorStudio.
In draw mode, there are two broad types: polygon-based designs that have
some Bezier functionality, such as MacDraw, or dedicated Bezier instruments
such as Adobe Illustrator or Aldus Freehand.
The learning curve for these last two is steeper than for other kinds of drawing programs so, if you choose to learn one, take your time with it and don't
expect to master its techniques in a week. Output can be spectacular, though.
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At the next level are CAD (computer-aided design) programs-say, for the
next automobile you make, and imaging and rendering software, for something
that looks exactly like a color photograph, except it isn't. Claris CAD and Ray
Dream Designer are examples of these decidedly professional applications.

HELPFUL HINTS
While Bezier curve work and technical illustration can be done well with a mouse,
other input devices are preferable for paint (or bitmapped) mode. The best for
most artists is a tablet , on which you draw with a metal pen-like stylus: the
tablet's sensitive surface records your motions and pressure.
It's wise to look at the different modes of illustration-drawing, painting,
design, imaging-before investing time and money in a choice. More than other
kinds of programs we'll learn, graphics programs differ within their genre. The
best choice is one only you can make.
At this point, we can't emphasize enough the value of practice. Start a new
document, and play with SuperPaint's features. Don't be afraid of the computer
or the program. Just save a lot, and use Save As several times.
Every minute of what might seem like wandering around in the program is
actually important progress in using your mouse, scroll bars, menus, and other
features of this intuitive and friendly interface.

Q&A
Q: How can I remember to save as often as I should?
A: This is a habit well worth nourishing. Using a kitchen timer as you work is actually a good idea. A competent user saves her file every time she stops to adjust
the paper on her desk, or to think about what she's just done on the Mac.
Q: For graphics images that I use often, should I keep them in sep-

arate SuperPaint files or in the Scrapbook?
A: There are advantages to both. Saved in a separate file, they're easier to copy
onto a floppy and take to a different computer. Saved in the Scrapbook, your

CHAPTER

2

COMPUTER GRAPHICS

image library is a little easier to get at. Try both, and see what's more convenient for the way you work.
Q: I printed a graphic both on an Imagewriter and on a

Laserwriter. The Imagewriter output looks slightly squeezed
horizontally-a circle became an oval. How can I avoid this? ·
A: For the Imagewriter to match the Laserwriter as closely as possible, you need
to check the Tall Adjusted box in the Imagewriter print dialog box. This
widens all shapes slightly, so that the oval becomes a circle again.
Q: I closed a document without saving it. Is there any way to get

that graphic back?
A: No.
Q: Can I combine paint mode and draw mode graphics in one doc-

ument?
A: Yes, and that feature greatly enhances SuperPaint's versatility. Each mode
has its own layer, and you can switch from one to the other and put objects
next to (or on top of) one another.

SAMPLE ExERCISE

OJ Paint anything you like with SuperPaint. Use at least five tools and three fill
patterns, but try for more. Your painting should be at least three inches on a
side, but feel free to make it larger.

[II Use the Text tool to put your name in a comer of the painting.
@J Switch to the draw mode and add to your work. As you do this, ask yourself
which of these different modes seems to appeal to you more.

(HAPTE~
WO~D
P~OCESSING
In this lesson, you'll learn how to:
• enter word processing data
• use different type styles and sizes
• format text with italic, bold, and other character attributes
• check spelling
• use an electronic thesaurus
• find and replace any text in a document
• create and edit footnotes , headers, and footers
• work with the layout of a page
• work with graphics in a word processing environment
• check grammar electronically
• use outlining to organize your writing
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Believe it or not, you've weathered the hardest parts of learning computers. What
you've covered in the last two chapters won't be automatic for a few weeks yet,
but it's now just a matter of practice. And one of the nicer things about the
Macintosh's way of doing things is that most programs share details of operation.
You'll load a program, open a document, save changes, and quit in remarkably
similar ways from one program to the next.
Now let's look at a kind of program that you, either as a student or professional, may well use more than any other: word processing .
Plenty of people run around thinking that word processing on a computer is
a glorified typewriter-if so, it's mightily glorified. Your humble author gave away
his IBM Selectric once he had learned to word process, for two reasons:
• Like a graphics program, you can make unlimited versions of one file , undo
your mistakes, try lots of things without making anything permanent, save
copies on disk and carry them around, send copies to your friends or publisher
via telephone line, and produce a perfect copy from disk every time.
• Unlike graphics programs, you have available to you tools and capabilities that
writers not using a computer can only dream about. Monet might have seen
SuperPaint as a real convenience, but it's questionable whether it would have
made him a better painter. But there's little question that a word processing
program, with sufficient practice, can make you a better writer.
In this book, we'll be using Microsoft Word, one of the more powerful word processing applications available. Like SuperPaint, it has lots of tools, but we won't
switch among them so much. Instead, we start the program and enter text, or
edit what we've already written, and then use tools to format, check spelling, find
synonyms and so forth. So the keyboard is the locus of our main activity, with
other tools available as we need them .

OPENING AND STARTING

OJ Open Word, either by clicking on its icon to select it and then choosing
Open from the File me nu, or by double-clicking o n the icon . After a

moment, you get a screen and you're ready to type.
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Take a moment, though, to note how similar many aspects of the
screen are to SuperPaint. There 's a menu bar, an active window with
close, zoom and resize boxes and a title bar, and scroll bars at the botN o r E tom and right. Note also that the File and Edit menus have many
things in common.
Given that this program is designed for a completely different purpose than
SuperPaint, it's remarkably user-friendly that so much is similar.

[I]

Entering text. Time to remember how to type. Type a couple of lines, and
don't use the Return (or Enter) key.

Watch what happens to your text when you get to the right of the screen. It
wraps to the next line for you. No more stopping your train of thought when a little bell rings.
This is a good example of what a computer can do-keep the mechanics out
of your way to let you think. Use the Return key only to start a new paragraph.

FO RMATIING
We can choose the size of what we type, and make a basic change in the shapes
of the letters, by choosing which font we want. Here are some examples:
,. Fonts and sizes.

This is Palatine.

10 point

14 point

This is Helvetica

10 point

14 point

18 point
18 point

T~is

]Q poiNT

14

18

is PiEGNOT DEMi

pOiNT

poiNT

There's quite a variety available on most Macintoshes. As far as heights go,
72 points are an inch. Text in most books and magazines is 10 or 12 point type.
Word defaults to 12 point.
If you want to format text you're about to type:
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OJ Choose a font and size from the Font menu, and start.
But if you want to apply these changes to text you've already typed:

[IJ Click your mouse in front of any word and, holding the button down:
@J Drag through several words, then release the mouse button.
Note that the text used to be dark on light, but has changed to light on dark.
We've selected it.

0

Choose another font or size for your selected text, and watch it change to
reflect your choice .
This is a common couple of steps in word processing-we first select something, then modify it.

[I] Here's a good place to save for a first time. Saving often is a very good idea.
Make sure your work goes onto your disk, and ignore the Summary Info dialog box- just OK it.

FORMATTING WITH THE RIDDON
Let's do another kind of text formatting, and make some text italic, bold or
underlined.

OJ Choose Ribbon from the View menu. The Ribbon command is at the top of
the second set on the list. You should see this displayed at the top of your
text window:
Word 's ribbon.

r

a

File

Edit

Uiew

Insert

Draw mode
Super/subscript
Format buttons: bold, italic, underline
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Click on the Bold button, and type a couple of more words, then click again
on the Bold button to toggle that style off. Try the same with italic. Try both.
The underline style isn't as popular these days as these other forms of
emphasis.

Just as with fonts and sizes, you can select text first and then click a formatting
button, to change text already typed.
We'll look at more of this later in this chapter. For now, go back up to the
View menu and note that the Ribbon command now has a check mark next to
it, indicating that it's active. Choose it again, to hide it.

THE RULER RULES
The Ruler is another formatting tool much like the Ribbon. Choose it from the
View menu also.
Word's Ruler
Line spacing
Paragraph spacing

Tabs

\
4

Left indent

Current tab stops

Right margin

Another set of formatting icons is displayed along the top of the ruler. Below
them you see inch marks, with triangles at the left and right for margins.
To change the margins for text you've already written , select the text and
drag the triangles one way or the other. Note that the left triangle is split horizontally into two parts.
Moving the top part allows you to indent each paragraph automatically, without bothering to use the Tab key each time.
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The tab sets are several arrows pointing up. These are tab stops of different
kinds. The left-most icon, if dragged onto the ruler itself, sets a standard or left
tab stop. The next one sets a center, the next one sets a flush-right, the next one
(with a dot to its right) sets a decimal tab. (The last icon puts a vertical line where
you type the tab key.)
~•

Tab sets.

OJ Setting tabs. Drag a standard tab onto the ruler at the 2-inch mark, and a
decimal tab onto the ruler at the 4 .5-inch mark. Then type the following,
with a Return after each line, and pressing tab where shown:

March: <tab>

Expenses <tab>

<tab>

lncome<tab>

<tab>

Gambling losses<tab>

$514.85
$12.25
$14,449.80

Every figure lines up at the decimal point.

~ Drag both of those tab stops off the ruler-just down into the text area-and
let go. That erases them, and restores Word's default of left tabs every half
inch . Now drag a flush-right tab onto the ruler, at the 4.5-inch mark, and
type the following:

Henrietta <tab>

Lisa Oglethorpe

The Duke <tab>

Ted Hill

His Sister <tab>

Susan Elizabeth Thorncastle

@J Centering and justifying . The next set of icons on the ruler concerns
justification . The default is the first icon, which you see highlighted, and

which shows a series of lines even on the left and uneven on the right. The
second icon represents centered text, the third, right justified, and the last
one is full justified (at both the left and right margins), as are most books
published today.
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/~
lett

I

Center

N

or

~R'h

Justified

lg t

Although full justification has long been considered the most professional in appearance, recent research in reading has shown that left
justification, where there are no added spaces between words to make
E the margins come out even, is easier to read.

Titles, of course, are often best when centered , and you may have reason to
use flush-right. For any style-or font, or size, or any other attribute of your
text-if you select text first, then format, that attribute is applied to the existing text. If you do not select text first, the attribute you choose is applied to
whatever you subsequently type, until you change it.

8J Spacing. The next set of icons on the ruler spaces lines of text for you. The
first three choose single, 1. 5, or double-spacing, and the next two choose
closed or open paragraphs. Open paragraphs have an extra space between
them, as is common in a business letter.
otrtll

Spacing options.

[}] Try some of these tools, and then go to the View menu to put the ruler away.
As with the Ribbon, the command has a check mark next to it if it's active.
Many commands toggle like this.
As you familiarize yourself with Word, you may want both the ribbon and ruler
showing, to remind you of the features available. For now, though, hide them,
simply because it leaves more of the screen for your work.
All of the ribbon and ruler commands are also available through the menus.
More and more though, people seem to like tool palettes better than menu commands, possibly just because they're more visual.

II
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Let's take a second for a note on formatting: the ability of the Mac
to show you your formatting as it appears when printed is called
WYSIWYG : "What you see is what you get." It's a couple of orders
N 0 T E of magnitude nicer than the way other computer systems go about it
by, for example, indicating bold type in a normal shape but in a blue color on
the screen. Or a larger font shown in the same size on screen, but yet another
color.
Why is bold mapped to blue? Because they both start with the letter B? It's arbitrary and inefficient, compared to working with what you're actually producing.
WYSIWYG is part of another acronym, GUI, standing for "graphical user
interface"-windows, buttons, and icons. The Macintosh pioneered this way of
working, and it's been found to increase both productivity and satisfaction among
computer users, for many different kinds of work.
Simply put, the better the computer can show you how your work is going to
look, the easier time you have making your work look good.

COPY AND PASTE
This feature, which works just the same as in SuperPaint-except that you're copying text, rather than a graphic object, or area of the screen-is a real timesaver.

OJ Find a paragraph of your text you want to copy. Put your cursor at the left of
the text, and click, hold and drag to the right and down until all of the text
you want is selected.
[}] Choose Copy from the Edit menu. Then come up to the File menu and:

0

Choose New. When you have a blank screen, paste the text. Voila. Save this
new document onto your disk. Give it any name you want. At various times
in your computing , you'll note that shorter names are easier to work with.

There are lots of uses for this. A business may have a standard contract form, and want to enter varying terms and conditions for a particular agreement. By keeping the standard form as one document, and
SHORTCUT optional terms as other files, you can copy and paste from one to the
other, and individualize a contract or other document very fast, without retyping
anything each time.
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Copying text from a document, and pasting It Into another document, or a different page or place of the same document.
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SPELLING
Word processing programs can help not only the look and ease of your writing,
but also its quality. That's not as flashy, maybe, but in the end more satisfying.
Word's Spelling Checker finds some (not all) of your mistakes. Why not all? It
doesn't know the difference between "there" and "their," or between "too" and
"to." But it's a start.
To take a look at this, add some misspelled words to your file: mistakes you'd
expect a dictionary to catch.
[!] Type "A goood exemple is thes sentance." just as you see it here. Then:

0

Click your mouse to the left of the words you want to spell-check. Word
starts at the cursor and moves forward.

@J Choose Spelling from the Tools menu. Word finds the first misspelled word,
"goood," and shows it to us as in Figure 3.8.
At this point we can decide that "goood" is correctly spelled-it might be a
name, for example- and tell Word to Ignore its catch. If this word is a
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Word's Spelling dialog.
Spelling
Not in Dictionary: goood
Change To:

Ignore

Suggestions:

Change
Add

~ [ Ignore All)
) [ Chang e All)

l(

Close

'>WFWl>1 ) [ Options ... ]

name we've typed in our document several times, we can tell Word to
Ignore All.

If we decide the correct spelling is "good," we can have Word Change this
one instance of it or, if we think the word is identically misspelled at several
places, we can have it Change All.
If we want to add this word, say a specia lized term, to our own User
Dictionary , we can click Add. The word is then not flagged on subsequent
spelling checks.
After we do any of these things, Word then looks for the next misspelling.
At this point, the Suggest button has gray rather than black text within it. This
means that Word has already given us suggestions, and has no more to add.
Mac programs commonly show a command or button in gray text if it's not
available at the time. They change to black when their operation can be performed.

8J Save those changes. After a spell-check, or formatting or other changes, is
a great time to save your work. The changes you made are in RAM and
should be written to disk fairly often.

THESAURUS
Spell checking is fairly straightforward stuff. Going past that, expressive writing is
one of the best tools that powerful people have. A good vocabulary is a big part of it.
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A capable thesaurus won't provide all of this, but it's a help. And electronically, it's finally easy to use. Let's look at this elegant tool.
Word's thesaurus. Synonyms show in the box on the right for the
word selected on the left.
Thesaurus
Replace:
With:

[Replace J [Original)

meaning

~~u~n~·~·j~,jj~,j~,~~~~~~~g~

Meanings For: meaning
meaningful (adJ)
definition (noun)
purpose (noun)
Related Words

m

El n

Lool< Up J) ( Cancel J

Synonyms:
significant
poignant
eHpressiue
pointed
knowing

0

0

OJ Add these words to your open document: "The hidden archetypes of meaning."
[}] Click your mouse within the word "meaning. "

~ Choose Thesaurus from the Tools menu.
A window like Figure 3.9 is displayed with synonyms, of various parts of
speech , for the word you chose to check.

[I]

Peruse the list, noting that changing the selected word in the box on the left
gives you a new list in the box on the right. Click Replace when you find a
suitable synonym.

FIND
In a long document, you'll want to be able to find part of a word, any word or
multiple words. Any of these is called a string . To do this, go to the top of your
document, and choose Find from the Edit menu. This dialog box is displayed:

w
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The Find dialog box.
Find
Find What:

[

I
... I

!Format ...
!special

0

Match Whole Word Only

f' inti N(m1

(

Cancel

»
)

Search:

0

Match Case

This allows you to search for any part of your text. The Format and Special
menus let you search for formatting rather than text itself . For example, you
could change all instances of underlining to italics.
If you specify Match Whole Word Only, your search for "end " ignores
"bend," "send," and "depend. "
If you specify Match Case, your search finds , for example, all occurrences
of "BASIC," (a computer language), but not the generic word "basic. "

REPLACE
This is a feature that power users like a lot. It lets you utilize shorthand as you
write, and then replace it with longer expressions or technical terms.

[I] In

you r docu me nt , tell us a ll about the fi e ld o f "Agriculture and Life
Sciences. " Use that long phrase at least three times in your essay. But don't
even type it once. Put in some shorthand instead, such as / a . After you're
done, go to the top of your document and:

@J Choose Replace from the Edit menu. You'll see the dialog box shown in
Figure 3.11 .

@J Type/a in the Find What dialog box. Type the full title in the Replace With
dialog box. Then click on Replace All and be thankful you don't use a typewriter anymore. Especially if your field is biology or law.

CHAPTER

0

WORD PROCESSING

r•• Word's Replace dialog.
0

Replace

I ([

Find What:
~
! Format ..... ,L.:..,.__ _ _ _ _ _ _ _ _ _ _ _____;

ISpecial

I
ISpecial

Hnd

D

B•~pi!H:e

·
..... ,
·

~=====~

( fl(~p!d( •~ !HI

I

I

Cancel

Replace With:
Format ..,..., ._____ _ _ _ _ _ _ __ _ _ _______,

0

N•~H t

..... ,

Match Whole Word Only

0

Search:
Down

I

Match Case

1.....1

FOOTNOTES
Automatic placement of footnotes in Word is easy and, much more importantly,
footnote numbering updates automatically as you enter or delete notes at various
points in your document.
When you're at a point in your text you'd like to reference:

OJ Select Footnote from the Insert menu. You'll see this:
,

• oJtt"-4

Placing a footnote. Use Word's Auto-numbered Reference whenever
possible.
~Auto-numbered

t

Reference

or
Footnote Reference Mark:

I

I

OK

D

(Cancel)

-Footnote Separators
(Separator ... ) (Cont. Separator ... ) (Cont. Notice ... )
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Word asks you whether you'd like to use its automatic numbering reference,
or another of your own. In almost all cases you want to use auto numbering.
Click OK, and note that the small window at the bottom of your screen is
ready for you to type in your footnote. When done:

0

Close the window by putting your mouse on the thick black bar that separates the vertical scroll bars of the main window from those of the footnote
window. Note how the cursor changes shape. At this point, drag that thick
bar down to the bottom of the footnote window, or double-click on it, to
close the footnote window.
Footnote and main text
windows.

..,."*t-t~
;F·:·=t;-:·t---

Main window

;§'"'
~

:m::

Separator bar
..,.""t---i:O!:t:!:!:tl:r- Footnote window
'

The especially nice part of footnotes, automatic numbering, is that say you decide
to add a n'ote between existing notes 21 and 22. Just go ahead and do it, and
Word renumbers 22 to 23.
Later on, you may want to copy a quote you've referenced as footnote
26 into a new paper. Copy the quote, being sure to include the footnote number. Paste it into your new paper, at a point following footN 0 T E note 5. Your reference now shows footnote 6 , in the body text and in
the footnotes.
This feature alone is worth a change from a typewriter for any academic work.
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HEADERS AND FOOTERS
For longer documents, people often want a few lines at the top or bottom of a
page that stay the same on every page.
Choose Header from the View menu. The three icons above the typing area
will, if clicked, insert page number, date and time. The ruler and ribbon, if you
want to display them, work the same way in a header or footer window as in any
other window, for formatting.
'

Word's Header window. Enter text as usual, and click on Icons above
the text entry area to insert that data within your text.

:::o
~..

Untitledl :Head er

I!§J

~

[ Same

fl~

!'rl.'uious)

~ ' \ ' \ ~e
-~Date

Page number
!header

l¢ 1

Foot er s work just like headers and you can have both on one page.

But you won 't see either as they'll actually appear in your document
unless you're in Page Layout view or Print Preview.

PAGE lAYOUT
Word's normal view shows you your main text, graphics (if you've added
any), and nothing else. Page breaks are indicated by a dotted line, and you can
display tab, space, and paragraph marks if you want.
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When you need a more complete look at your page, you can switch from
normal to page layout view.
Choose Page Layout from the View menu. Scroll if you need to , and see
that your header, footnote and margins now show as they'll appear on the page.
Some people prefer to work in this view a ll the time, and that's fine . The
downside is that scrolling from page to page is slower.

PRINT PREVIEW
Both page layout and normal view show you your document at 100 percent size.
Unless your screen displays a n entire page, you may want to see each whole
page at one glance , to confirm that margins, spacing, type size and such , are
really what you'd like to print.
Choose Print Preview from the File menu. You'll see:
•

•

IJ."'

The Print Preview window. Click Close at the top right when you're
done.

Margins, visible because the Set
Margins icon at left is selected. A
margin's handles are at the bottom of
the left end of the line. Drag a handle
to change it.
~

Page layout is a special view described on
the last page. Close takes you back to
normal view.
~
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INSERTING GRAPHICS
Most word processing programs let you paste a graphic, perhaps something out
of SuperPaint, into your word processing document. High-end word processors
like this one or WordPerfect have drawing modules built-in.
Word's drawing module is a fairly primitive one, and really is useful only for
basic illustration, or last-minute editing of a graphic after you've already placed it
in your Word document.

OJ Choose Picture ... from the Insert menu. From the dialog box, select and
insert an available graphic.

0

Double-click on the graphic to open it into an editing window:
Word's graphic module. A tool palette similar to SuperPaint's Is at lef t.

Remember that SuperPaint has both a painting and drawing mode of operation .
Word's module is draw only and does not offer freehand or Bezier curve tools.
An advantage to a built-in drawing module is that you can prepare graphic
work in a program dedicated to it, then import it into Word and scale , crop,
rotate, or make other final adjustments to it while you're in the environment that
produces the final product.
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Word's drawing tools.

Selection tool

IL1

J\

Text tool

"' LJ

0 0
0

',

() C{Q

Or, you can integrate graphics and text more quickly than you can working
with two programs. It's certainly a convenience.

HELP!
Online Help is a nice feature that you can call to the screen to answer quick questions about program operation. You can access this help feature in any of three
ways:

OJ Go to the Window menu and choose Help as the first command. You can
also go to the Apple menu, choose About Microsoft Word, and click on
the Help button in the copyright notice box that appears. Easy enough.
Here's the elegant way: go back to your document and:

[I] Hold down the Command key which, according to your model of
Macintosh, may have an apple or cloverleaf symbol on it , and press the
Question Mark key. See how your cursor itself has changed to a question
mark. Then:
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Pull down any menu and select any command you want help on. Word goes
right to that part of the help file, instead of making you find the topic yourself.
Word's on-line nelp dialog.

Help
Double-click the topic you want:
Microsoft Product Support
Aligning and justifying text
Borders and shading
Canceling and undoing commands
Clipboard
Columns
Copying and moving text and graphics
Co unti ng text
Customizing menus and key assignments
Customizing your 'Work environment
Defaults
Deleting text and graphics
Documents: Creati ng
Opening
Vie'vli ng
Saving
Closing

GRAMMAR CHECKING
This part of Word is a nice help in constructing tight, effective writing. It checks
your output against a large number of rules, covering difficulties such as wordy
or redundant expressions, inappropriate prepositions , informal expressions,
cliches, weak modifiers, and vague quantifiers. Also overlong sentences, like this
last one.
Depending on your writing skills, you may want to use this tool often, or you
may prefer to use it as an occasional check of writing habits. Some use of it is
probably valuable for everyone.
To look at this, put your cursor at the top of your document, and choose
Grammar . .. from the Tools menu. You'll see the dialog box shown in Figure

3.19, which, in this case, tells your humble author that he's used a stock phrase.
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Word's grammar checker, with a sentence found and a suggestion given.

Grammar

rs-~n_n_:e-:-~-~-:-~-y-ou--ca_n_t-~s_t_b_ot-h-.---------------,~{}~ n~(~~l~g~n~o~re~~~l
(

Ctwn~J(~

)

(NeHt Sentence)
( Ignore Rule )
(

Close

)

(

EHplain...

)

(

Options...

)

As you work with this tool, your decisions on the validity and efficacy of its
various comments and criticisms depend on your judgment. But options are nice
to have.

OUTLINING
Once our writing is spelled correctly, offered rich use of synonyms, and grammatically proper, a larger question comes up. This is one of organization.
Look closely at what you read, and you'll see that professional efforts show
careful craftsmanship. Paragraphs follow logically, and each one contains a distinct idea.
A substantial help in achieving this kind of quality is offered by computer
outlining. Word's oultline module is again an effective tool.
As well, outlining in electronic mode is so fast and easy, it becomes a good
way to start almost any piece of writing.
With Word, you can switch back and forth from outline to text at any time, to
maintain the good organization of your piece while adding details. To check this out:

OJ Start a new document (choose New from the File menu).
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~ Choose Outline from the View menu.
You're given a new ruler, and an icon-an outlined minus sign-appears to
the left of your cursor.

@J Type the first line as shown below, and press Return.

8J Click the right arrow in the ruler to move your next line to the right.
ITJ Complete this example, using the right and left arrows.
I

A sample outline in Word.

D
~

.. + ... +>

Growth and Maturity
+
1
2
3
4

0
§I

~

ff

~

~~--~--~--~~--~--~--~--~----------~·0

o

Coming of age in America
o Cultural influences
c
The school environment
o Popular heros
c
Musicians and TV stars
c
Nwsmakers
o MoraJ development
o History and literature
c
Classic exam pies
c
Currentwork
c
Direct instruction

-=-

!heading 4

N

o r

[I]

This would be an interesting tool if it only did this much. But an outline
in Word is simply another view of a text document , and you can go
back and forth between the two views. You can thus reorganize your
E piece as your thoughts cohere.

Click and hold on a heading icon (plus or minus sign, depending on whether
it has subheadings), and drag it elsewhere in the outline.

II
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If your heading has body text with it, such as a paragraph, the whole paragraph
moves. Really an effective tool.

OTHER FEATURES
Check out the Word Count feature on the Tools menu. This also counts lines
and paragraphs.
Try Find File on the File menu. You can search for a document by any of a
large number of criteria:
Search options from the Find File command.

Search
File Name:

II

tt

Title:

J)

(Cancel)

Rny TeHt:

Driues :

IStoryuille

Subject:
Ruthor:

1·1

File Types :
Readab le File s

I

Uersion:
Keywords:
Finder Comments:
!<Created
@ On Rny Day

OK

0

I

From:

Search Options:
Create New list

I

~:''''
· [ID
To·• ..~:'.:: .:::\'2 liD By: I
., , LL .:':·
.J ..•
{)

1·1
1·1
II

lastSaued ----------------~----------~,--.======~

@On Rny Day

0
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CHECKLIST
This session has given you all you need for competent and effective word processing. You've covered:
• character attributes and formatting,
• copying and pasting text,
• spell-checking and thesaurus,
• finding and replacing text,
• footnotes, headers, and footers,
• page layout and preview features,
• graphics in a word processing environment,
• grammar checking and outlining.
which is really quite a bit.

OTHER CHOICES
We've learned a popular word processing program, but it's only one of many.
The basic operations we've covered here are mostly the same with all of them,
but advanced features differ. Which should you buy and use?
Since the market is so big, there's lots of competition and various ideas about
which one's really the best. The answer is none of them, since each tool is optimized for a slightly different use. WordPerfect is an excellent tool for serious academic writing, and has elegant page design capability, a comprehensive drawing
module, and the best macro feature in town. WriteNow is a clean , fast program
that gets in the writer's way very little , but lacks a few advanced features .
MacWrite Pro and Nisus are others. One is right for you.
There are more specialized products you may want to look at: More, for example, is a workhorse for many uses. A much smoother and more powerful outliner than
what we've seen, effective tree and bullet charts, and extensive graphing capability.
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HELPFUL HINTS
When you learned SuperPaint, you of course worked mostly with the mouse, and the
keyboard was only occasionally of use. But with word processing, we spend much of
our time typing, and use the mouse for a menu command only every so often.
Power computer users like to keep their hands on the keyboard most of the
time and , for that reason, Macintosh programs have many keyboard equivalents
for menu commands. These do the same thing as using the mouse and the
menus, and are often faster. For example, Command-S to save your changes.
Take some time to practice these.
Word and most other applications list keyboard equivalents next to the command on the menu, as well as providing tables of them in their manuals.
Word also lets you customize menus and keyboard equivalents. You could put
a command on a different menu, or give it a new or different keyboard equivalent.
Keyboard equivalents become very useful when you find you' re invoking a
command a lot, but need to use your mouse every time. Although the mouse is
certainly intuitive, there are times when a keyboard command is just faster.
This is partly because we think in different modes, and these are directly
related to what we're doing at the time. Thinking in the kind of spatial mode that
occurs when we're moving a mouse is different from the more text-based thinking we do at the keyboard.
The experience differs among individuals, but we find that there's an advantage in continuity as well as speed if, when working on the keyboard , we have
program commands available there too.
As with choice of programs and graphics modes, the decision here is yours.
The name personal computer means more than that it sits on your desk, and others don't use it. It's something that can work the way you think.
If you intend to do very much word processing at all, it will be worth your
time to learn features such as glossaries and style sheets , which simplify repetitive tasks and save a lot of time. Accuracy of spelling and consistency of formatting can benefit from these tools. Macros, such as WordPerfect and Nisus have,
are also powerful tools towards productivity.

Some writers find they work best in outline mode, moving to full text after
their outline is complete and revised. This may not be an easy habit to develop,
but many good writers swear by it for organization and coherence. The computer
certainly makes it easy enough.
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One glaring anomaly in this world of high-tech word processing: the keyboard in front of you. The key layout, called Qwerty for the first six letters on the
top row of keys , was designed to be awkward , to slow typists down, so early
manual typewriters wouldn't jam.
Your Macintosh isn't about to jam, but you're using a key map that lets you
type only 100 English words from the home row, where your fingers rest. The
alternative and ergonomic Ouorak ke y map, by contrast, lets you type 4000
words from the home row.
With Qwerty, you do more work with your left hand, just because more people are right-handed. Dvorak uses the right hand more, but it's surprising how
much it alternates the hands, producing a smooth and even flow. This is largely
because it places the vowels under the left hand , and the most common consonants under the right. We're using Dvorak to write this book. Wait, there's more.
Studies say that the fingers of the average typist move sixteen miles in eight
hours. On the Dvorak map they move one mile. There are portents here for
speed and accuracy. Of greater significance, you can type all day without getting
tired or, much worse, acquiring a repetitive-motion injury such as carpal-tunnel
syndrome.
Free software is available to change key maps. Ask a Mac users' group for
Electric Dvorak. Find a users' group per the Tech Note in the Introduction. Some
typing tutor programs can teach you the keyboard. But for all its advantages, and
an inception in the 1930s, Dvorak's still not too popular- such is (in this case)
the curse of a standard.

Q&A
Q: I choose a different font from the menu, but it doesn't change

what I have on the screen.

A: You have to select existing text for your cho ice of font to app ly to it.
Otherwise, your choice affects what you type afterward.
Q : I click on the Bold or Italic buttons, and the re's no effect.

A: Style choices, like font choices, are applied to existing text only if it's selected
first. If you don 't select anything first, but click Bold or Italic, that style then
governs what you type after you make the style choice.
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Q: I change margin, tabs or alignment in the ruler, and only part
of my text changes to match.
A: Word applies these changes only to the paragraph your insertion point is in,
unless you select more than one paragraph worth of text.
Q: I pasted text, and it appeared in the wrong place.

A: Text pastes at the insertion point. First click where you want the text to
appear, then choose Paste.
Q : The Find option doesn't find what I'm looking for, but I know

it's there.

A: Make sure that you're searching in the right direction. Word looks forward or
backward, whichever you tell it to. Also, make sure that you haven't added
anything, even an extra space, to what you're telling it to look for.
Q: I want to delete a footnote. I erased all of the text in the foot-

note window, but the number still appears in the main text.
A: The footnote itself is still there, although there's no content to it. Delete the
number in your main document, and the note and its text will be gone, and
succeeding footnotes renumber to reflect the deletion.
Q: I want to move a graphic I've inserted.

A: You can do this only in Print Preview mode. Click and drag to reposition it.
Q: I placed a graphic, then made some changes to it, and it now
has fewer colors than it used to.
A: Any editing of a graphic in Word reduces the color information to the eight
colors available in this program. Consider making all changes in the original
graphics program, and then placing it in your Word document.
Q: The grammar checker flags things I think are silly. What can I

do?

A: This module functions with a list of rules. You can turn off those which cause
it to stop at things you don't want to change-passive constructions , for
example.
Q: I like the Dvorak keyboard, but no one else who uses my com-

puter does.

CHAPTER

3

WorD PROCESSING

A: All of the programs that convert a Mac keyboard to the Dvorak map include
an easy way to switch back and forth. Put a sign on the computer saying
how, to keep everybody happy.

SAMPLE EXERCISE
Enter these two passages: "Playscript" and "Roberto's Lines" as separate documents. Then, with both files open (go back and forth using Word's Window
menu), copy your choice of Roberto's lines and paste them into the script. Your
finished product should look professional: don 't copy the numbers in front of
each of Roberto's lines, and be careful with the number of spaces between each
character's line.

PLA YSCP.IPT
The scene between Samantha and Roberto opens in a desolate and ghostly glen
in the forest at midnight. Fog swirls about their knees. Glowing pairs of wolfish
eyes dance mysteriously from behind hideously misshapen dead trees. The duo
face each other, their movements expressing great agitation.

Samantha: The gods themselves may have no hope for you! The whole of
humankind is fluent on computers , and you de ign not even to
glance at them. Your view of your future is as cloaked in mist as
are these forlorn tree-stumps, and your sense of your abilities (relative to current markets) is as leaden and opaque as this night air!
Roberto:

[insert choice from Series 1)

Samantha: Fool! Why can you not comprehend? The world will pass you by.
Not to be computer-literate in this age is not to be able to think at
all!
Roberto:

[insert choice from Series 2)

Samantha: I can waste no further moment with so befuddled a lummox as you!
I'm off this instant to take the Cornell computer course that produced this book!
Roberto:

[insert choice from Series 3)
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Samantha: Yes! Is that what it took to make you see the light of common day?
Roberto:

[insert choice from Series 4]

Samantha: It's no use! (She storms off, her gown raising eddies and whorls in
the heavy fog. In the distance, we see lightning.)

RODERTO'S LINES:
Series 1:

1. You learned computers in high school. What do you want from me?
2. There just aren't any football computer games I like.
3. If my grandpa ran his farm without computers, so can I!
Series 2:

1. What does "think" mean?
2 . I'm sure it's a passing fad.
3. I'll wait until they make one that fits in the dashboard of my 3 00ZX.
Series 3:
1. Hey wait. Maybe even I could pass that course.
2. Isn't that the class where computers are painless?
3. Someone said that was a course that was actually useful!
Series 4:
1 . But-I'd only take it if I could learn to tally up hockey stats.
2. But-my frat's computer is broken-even though it looked like a football,
last Saturday night about 2 a.m.
3. But-{You can make up an answer here).

(HAPTE~
INT~ODUCTION
TO SP~EADSH EETS
In this chapter you'll learn:
• what a computer spreadsheet is and how it works
• entering, selecting, and formatting data
• using Microsoft Excel's tool bar
• making formulas to automate and speed calculations
• using on-line Help
• relative and absolute addressing in formulas
• specifics of previewing and printing a spreadsheet
• displaying and checking formulas
• producing different kinds of charts from data ranges

II
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With graphics and word processing, you're at this point as knowledgeable as a
large percentage of computer users. With the addition of spreadsheets-a structured way o f working with numbers-you' ll be more accomplished than most
people who sit down in front of a PC! So off we go.
Spreadsheets were what gave personal computers their first real start in the
marketplace. They demonstrated decisively to a lot of people in different professional or educational situations that the PC was something that anyone could
benefit from .
These peoples' vantage point, back in the computer's ice age, was quite different from yours. You've just explored highly sophisticated versions of graphics
and word processing conceptions. In the beginning, the advantages these programs had over conventional artists' tools and the ubiquitous typewriter weren't
quite so convincing.
Conversely, the difference between a conventional financial , statistical or scientific worksheet, and the electronic versions of each , was enough to settle the
question right away. The revolution had rather inauspicious beginnings, though.
Back in 1979 there were a couple of funny guys in a garage in Cupertino,
California, who invented and brought to market a novelty called the Apple, and
everyone's first question was, "How nice. What do I do with it?"
Of the myriad answers of varying coherence , the best was expressed by the
writer of Visicalc, a program that produced what looked like an accountant's
worksheet, but with two stupendous differences.
The first was that each cell , or area of the worksheet that could hold a number or some words, could also hold a formula that could reference , or access
information from, any other cell in the worksheet.
Without formulas, cells are just places to store numbers and text. You could,
for example , manually add cell Aland cell A2 and put the answer in cell A3.
•

'

·

~••

Cell A3 Is the sum of AI
and A2. If we change the
ualue In AI, we must
manually change the
sum In A3 to reflect that
change.

D
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What A3 then contains is a value that could be Al plus A2, or your sister's
street address. Only you know. And if A2 changes, A3 then doesn't mean anything. But on a computer, if what's in A3 is the formula "A l p lus A2, " A3
remains accurate. And , if you have another formula in cell H6 that references
A3, H6 remains accurate too, and so on forever. It's a pretty good boost in productivity and potential for accuracy.

Cell A3 holds a formula
for Al plus A2. If we
later changed the value
in A2 to 6, the sum In
A3 would automatically
update to be 8.

D
A

I

1 2
~
-::----+·····································..·
2 3
~
3

=A1+A2

i

The second reason involves the use of numbers in making predictions.
Where the economy goes next year is a function of quite a lot of things, and an
accurate forecast is tremendously valuable. By organizing formulas in a worksheet
to predict, say, interest rates, you can make changes here and there in prices or
GNP and produce any number of "what if" scenarios.
You can a lso optimize solutions, working backwards from the numbers you
want to see, to the numbers you need to have in order to get what you want to
see, for instance, to determine affordable interest rates for monthly car payments.
This is a powerful tool for allocating resources and minimizing waste. It's a highly
visible and specific example of how technology, including computer technology,
can really work for the better.
A computer spreadsheet is such an intelligent tool for numbers that you
might think it's hard to learn, in some way that graphics or word processing isn't.
Wrong . It's all very easy to do and, in terms of raw computing power, you can do
more with a spreadsheet than any other kind of program. So let's look around
Microsoft Excel.
Double-click on the Excel icon to start the application. After the program
loads, you should see a screen like Figure 4.3. Notice the similarities, such as
windows, menus, scroll bars, and zoom box, to other Mac programs. Now look
at the differences: along the top, just below the menus, you'll see the tool bar,
and then:

iii
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• Reference to active cell. With 16 million cells available, this is nice information to have. Depending on where you have scrolled to, the active cell might
not be visible in the window.
• Active cell (with a thick border around it). Whatever you type is going to go here.
• Check box. When you enter information in the active cell, it isn't 'fixed ' until
you click in this box, or move the active cell with the Tab or Return keys, or
an Arrow key.
• Edit line . This shows what you 've entered in the active cell. Note that
depending on how you've formatted your worksheet, the cell itself may not
display much of what you've put in it. The edit line shows more, and is generally easier to read anyway.
• Balloon Help o ffers the regular help balloons and, in Excel, is also where
you'll find the program's Help feature. (If your Mac is using System 6 instead
of 7, Balloon Help won't appear on the menu bar, and Excel's Help appears
under the Window menu.) There's also a single help line at the bottom left of
your screen.
• Black rectangles at the top of the vertical scroll bar and at the left of the horizontal scroll bar. These allow you to split windows so you can look at two parts
of your file at once. This is a nice feature common to Microsoft programs.

A new Excel window.

reference to active cell

black rectangle
tool bar

check box
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ENTERING DATA
Note that the worksheet window, below the menus and tools, is divided by dotted
lines into several rectangles, or cells, and that each can be identified by its vertical
column letter, and its horizontal row number. Thus the cell at the top left is cell Al.
In Figure 4.3, cell Al is identified as the active cell. If you typed anything at
this point, it would go into this cell. Any cell can be active, and it will have the
heavier line around it that you see around cell Al here.
You could then click on another cell, and it would become active. Whatever
you typed at that point would go into that second cell.
You could also use your Arrow keys, or the Return or Tab keys, to move
from one cell to another.

OJ Use your Arrow keys to move around the visible part of the worksheet.
Another way to move the active cell is just to click on any cell. Note that the
cell reference , at the top left, shows which cell is active and the edit line, to
the right of the check box, has a blinking cursor-or, if there's data already in
the active cell, the edit line reflects this.

(I] Type the information shown in Figure 4.4.

Don't worry if, when you type a
long string of text, not all of it appears in the cell itself. Try to work from the
edit line above the worksheet. After you fix the active cell's data by clicking in
the check box, what's in Al spills into Bl if there's nothing entered in Bl.
Your first worksheet In Excel.

Then save your work-this isn't too soon at all for a Save.

iii
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SELEOING RANGES OF (ELLS
Now that we have some data, let's format it. The text in cells Al through A12
would benefit by being in bold type.
The first step is selecting what we want to work with. This is the standard
Macintosh paradigm: select something, then choose what to do to it.
The quickest way to select a block of cells like Alto A12 (such a block
is referred to as Al..A12 in spreadsheet land} is to click and drag,
much like in word processing.
N 0 T E

OJ Click in cell Aland hold your mouse button down.
C3J Drag to cell A12. When this range of cells shows as selected, release the
mouse button.
Another way to select a range is to select the cell in one comer of the
block you want to work with. Go to the diagonally opposite comer,
hold down the Shift key, and click on that cell. Note that this paraN o r E digm works with a lot of data on the Mac: in Word, for example, you
can click to set the cursor in front of a group of words, then Shift-click your
mouse at the end of the group.
You can also click on a column letter or a row number to select that entire
column or row. Try this. Click in any non-selected cell to deselect the selected
area.
Or, you can select the entire worksheet by clicking on cell AO, the top-most
left cell in the window (to the left of A and above 1}. Try this too.
As a note, since one of the things you can do with large amounts of
data selected is quickly erase that data accidentally, it's a good idea to
save before selecting much of anything. Then again, it's a good idea to
WARNING save before doing much of anything at all.
New computer users generally get into most of the trouble they get into
because they don't save often enough. We wish to reiterate that this is not our fault.
With your data in Al through A12 (or Al..A12} selected:
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OJ Choose Font from the Format menu. You'll see a dialog box like Figure 4 .5 :

.

~ltt"lll

Excel's font formatting dialog box.
Font
Font
Chicogo
Courier
Oecolloge
OemoFont
Geremond

'
I Geneuo
Color:

Si ze

Q '9""" 0

~
14
18

<> ~'o

((

Styl e
l8l Bol d
O ltelic
0 Underline
0 Strikeout
O Outline
0 Shodow

(
0

Cancel

,
l

Normol
Font

I

1111 1
~Semple

IRutometlc 101 _

OK

(

AaBbCcTyZz

Help

l

I

ITJ Confirm your choice of bold text by clicking in the appropriate box, and then
clicking OK.

TOOLS OF THE TRADE
Above the edit line are icons for useful tools for many of the most common ways
you'll be manipulating your data. Parts of the tool bar are:
Excel's tool bar.
File commands:
New document

Autosum
Formatting:
Bold
Italic
Increase font size
Decrease font size

Help
Chartwizard
Paste formats
Copy

Bottom border
Outhne border
Autoformat
Center across columns
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All offer commands that can be addressed more specifically through the
menus, but which are immediately available in their most common forms here.
If you don't see the tool bar, go to the Options menu and choose Workspace,
to display the toolbar.

Let's start exploring these by formatting some more of the data we've just
entered.

FAST FORMATTING
Excel gives you a lot of flexibility to format your worksheet, an especially valuable
feature when laser-printing files for reports and presentations, but also a useful
feature simply for ease of recognition of different parts of your work.

ITJ Select cells C2 through F3 (or C2 ..F3), and click on the Bold icon in the tool
bar.

[II Then click on the Alignment Center icon, the middle of the three in that group.
Another nice aspect of formatting is changing column width or row height.
These features are available from the Format menu, allowing precision. A
quicker way is to position your cursor at the border between two column
headings (where the letters are) , and see how the cursor changes shape as
shown in Figure 4.7 , between the column headings A and B.

•:rr.ng

A formatted worksheet.

D

My First Worksheet
Ad+

B

I

C

I

DIE

I
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Click and drag either to the left or right , and the columns change width
accordingly. Try this on rows also.
Now let's format the numbers as shown in Figure 4.7. We could have typed
these dollar signs, but why not just enter numbers, then select a range of cells
and format them as currency? To do this formatting, though, we have to go
to the menus.

CiJ Select C5 .. E8 and, from the Format menu, choose Number. Your dialog
box should look like Figure 4.8.

The Number Format dialog box.
Number Format
Ualue Type

Format Codes

All

a

OK

~

Cancel
[1(~!(~1 (~

Time
Percentage
Fraction
Scientific

Help

Code
Sample: $2,345.22

~ Format all of the dollar values in cells C5 to E8 as currency. Use the cents
option, as highlighted in the example.

WORKING WITH A WORKSHEET
So far, what you've done could be done with pencil and paper (or at least a fancy
typewriter). Here's where we leave the ground. We 'll take these income figures
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and apply formulas to them , both to ensure the accuracy of calculation results (if
the formulas are accurate) , and to automate copious quantities of work.

If the formulas are accurate? Yes. Not that it's hard to make accurate formulas, but spreadsheets become such great time-savers that lots of people get sloppy
with formulas, then wonder how they could make a mistake with a computer.
This points up an old slogan in the computer world: "Garbage in, garbage
out. " Formulas are easy, but beg to be checked. Let's enter a formula first.

OJ Find the total income for October. That would be the sum of cells CS
through C8. Let's put that total in ClO. So click in ClO, to make that the
active cell and so that whatever we enter next is going there.

[2] Watch the edit line, and type an equals(=) sign.

In Excel, all formulas begin

with an equals sign. Type this:
= C5+C6+C7+C8

(no need to capitalize the letters) and then click in the check box just to the
left of the edit line.
Wow! and congratulations, you've just entered your first formula.
Half of the point of this is that should you find later that the actual figure
for bootlegging for October were not accurate, you could change it, and
your total income for October, in cell ClO, would change automatically.
N 0 T E

Slick, but too much typing. So let's use a shortcut to find the total income for
November.
@] Click in cell DlO, and then on the Autosum icon in the tool bar, then in the
check box. Excel goes looking for something to add up, and suggests C l O,
the closest. Nope. Drag through D5 .. D8, and notice how the formula in the
edit line changes to reflect your choice. Now click in the check box. Smooth.
Let's have Excel do even more for us. If the Mac can copy and paste graphics
and text, why not formulas?

0

Click in DlO, and choose Copy from the Edit menu. Then click in cell ElO,
where we want the totals for December, and choose Paste. Voila , there's
the December total.
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~

Excel gave us the December totals because formulas normally reference the cells relative to the cell where you're entering the formula . It
moved everything it referenced one cell to the right, because you
N 0 T E copied and pasted a formula one cell to the right.
Now we'll put in the category totals. Click in FS, and let's get the total for the
category Bootlegging.
Instead of using the Autosum button, this time we'll enter the Total function
(or SUM) in the same way we enter Excel's hundreds of other functions :

ITJ Come up to the Formula menu, and choose Paste Function. Scroll down
the Paste Function list. Impressive, no?

[I] Select SUM and click OK.

Note that the function , properly preceded by the
equals sign , is now on the Edit line, with the blinking cursor between the
parentheses. OrDepending on how your copy of Excel is set up , you may see
"(numberl,number2, ... )," with "numberl " selected. Drag through "numberl ,number2 ,... " leaving the parentheses, to select this text, and press the
Delete key on your keyboard.

@J Click and hold on C5 and drag to cell ES. Watch the Edit line as you do this.
Click on the check box.
To add formulas for the other category totals:

[:.±:] Click in FS

and choose Copy. Then drag to select cells F6 through F8.
Choose Paste. Starting to see how much time this thing can save?

Note that totals you're adding from cells already formatted as currency also
show as currency.

[II Put the total for the quarter in FlO. It's probably easiest to copy a formula for
one of the monthly totals and paste it in FlO. Then what we want to do is put
this same value in Cl2. So click in Cl2, click in the edit line, type =FlO, and
click in the check box.
So whatever's in FlO also appears in Cl2. This is a simple trick for moving
information around a worksheet, especially a large one.

~ Save your work again. Command-S is the best friend you have at this point.
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A

SECOND SEGION

Let's do an expenses and totals section of the worksheet.

ITJ Scroll down to a blank area of your worksheet, say Al S, and enter what you
see in Figure 4 .9 .

•

~W..JI

•

The Expenses and Totals section. In cells C28.. C31, don't enter text

I in parenthese: enter formu las that compute these.

_0
A

[I]

!

B

!

0

My Fi rs t Workshee t
C

!

D

;

E

'

F

, '0

Total the months and categories. Include the cells that indicate Car Payment,
even though we haven't figured that out yet.

~

This is another fun part of spreadsheets: We can include that payment
in a formula and , when the payment data becomes available the formula accurately includes that expense.

N 0 T E

And now's a good point to save again. You've done quite a bit so far.
It 's actually a good idea to save more often tha n reco mmended he re .
Experienced computer users hit Command- S almost every time they stop typing to look at something.
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At this point, we can figure out the car payment:

ITJ Enter the data in A36 .. B38 of Figure 4.10. Then Click in cell C21 , in preparation for entering the payment formula.
•• ' r.r~ltll

Car loan and payment
data.

[I] Look up Microsoft

Excel H elp under the Help balloon menu, to learn how
to figure the monthly payment.

.'

Excel's initial Help window .

0

[Contents][ Search ][

I

:»·

B(dcl\

][ History ][

I

M1 crosoft Excel He I p Contents
Product SJm;1o rt

Using Me rosoft Excel
Basic Conce~Qts
Worksheets
Charts
Databases
Macros and OJstomization
Using Workbooks
!rlP-O rting and Ex~Qo rting
Linking and Embedding
Printing
Managi.!J.g Files

¢1

0

Microsoft EHcel Help
·< <:
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You have the raw data already. What you need is the o rder of parameters
that the formula argument requires. That's just the order of things we enter in
the formula.
So scroll to the Reference section of the first Help window, and then:

• • iiTmZ!•J'...w

Scroll to Worksheet Functions under Reference.

0

(

0

Microsoft EHcel Help

(Contents )[ Search
:»·

)[

Back

](

History

)[

·<<:

l

l

Microsoft Excel Help Contents
Product &lP.P-O rt

0

Reference
Commands
cefinitions
Error Values
Ke:Y.!;1oa rd Guide
Macro Libra rx
Parts of the Me rosoft Excel Screen
Tools
Using Mcrosoft Excel with ~ tem 7
I
""th Data Access
Wo rksheet Functions
~

v

¢r-@J

-

J

I

I

1¢

{}
Q]

Click once on Worksheet Functions, once on Financial Functions, and
then scroll down to PMTO.
It tells you that the argument is: PMT (rate, nper, pv, fv, type) and explains
what those mean.

8J Exit Help and, with C21 as the active cell:
0 Enter the formula for your car payment by entering =PMTO through pasting
the function. Select and remove the text, if any (another description of the
order of parameters) between the parentheses, or just click between the
parentheses, so that what we enter next goes there.
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II

Excel Help's explanation of the PMT fun ction.

D
(Contents )( Sear ch

0

Micros oft EHcel Help

)(

Back

)(

History

)(

·«:

)(

l

>-:>

~

PMT(rate , nper.PY. fv, type)
~ turns

payment fo r an investment based on periodic , constant
payments and a constant interest rate .
• Make sure that you are consist ent about the units you use for
specifying rate and nper. If rate is pe r year then PMT returns
t he number of payments pe r yea r and nper is the number of yea rs.
• Fv and type are optional; if omit ted, PMT uses 0 .

Examples
PMT(S%/ 12,1 0,0,1 0000,1) =-$963.9 4
PMT(S%/ 12,1 0,0,1 0000) =-$970.37
PMT(1 2%/ 12,5,- 5000) =$1,030.20

¢1

0

T¢ Q]

We're going to enter parts to the formula a different way this time: by clicking directly on the cell which holds the value we want to go in the formula.
(]] Click on the monthly rate, and type a comma.

[I]

Click on the number of months, and type another comma, and then:

0

Click on the principal, or present value, of the loan .

~
[!Q]

Click in the check box to the left of the edit line to fix the formula.
Now scroll up to see what's in C2 1. That is the correct payment and, per
accounting procedures, it's a negative value. What we want is a positive value
to add to other expenses, so:

~ Go to the edit line and add *-1 to the end of the formula (after the last parenthesis) and click on the check box again. The value should change to positive,
but stay the same figure.
We're going to copy this formula to get car payments for the other months,
but let's be careful here. Remember that our copying and pasting of formulas
so far has used the default relative addressing, no t a bsolute addressing .
Here's the difference :
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Light arrows represent relative addressing; the heavy arrow absolute
addressing.
We wanted October's income total from October's figures, and
November's total from November's figures. So we just took the SUM formula in ClO and copied it to DlO. Dl O then addresses cells In the same
relative position as ClO"s formula does.
The formula for the car payment, in C21, uses data in B36..B38. If we
copied C21 to D21, the formula in D18 would address data in the same
relative position as C18 does.
But since there's no data in C36.. C38, and the data in B36..B38 are valid
for all months anyway, we need to make the formu la in C21 absolute, so
that we can then copy it anywhere and it will continue to reference
B36.. B38.

113S
3SO
ISS

12S

!so
4S
12S

~ ~~~'""

f-# f!.!:.!!vmenl

I

•PMT 837 ~38 *-1
_/_

.I"

23 Monlhl total

/

1
~~~;~-----------~-----------~---------~
~~~
~r
7//
'------~--~

26

uarterly flnanclel

Rt~_rl

/_'

_L
_L

!

l

33

34 l oan dele
35

JL

..L_
~

27
28 Gross Profth
29 Income tax rtte
30 rex vltholdi
3 1 Net Income
32

,....,

~36:-+:•"'•f,;;mo="'n'-"1"'~-:-=,---4.1~"'.1ql
~ ~':!:~~~tterut rete
~

12 00

- ,._,
-

,...., , .

1.1'--------+-1
....

We stipulate absolute addressing in spreadsheets by means of dollar signs in
front of the cell addresses.
So let's change the formula in C21.

8:2J Click on that cell, and you should see (on the edit line):
=PMT(837 ,836,838)*-1
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Change that to read:
=PMT($8$37 ,$8$36,$8$38)*-1
If you get tired of typing dollar signs, putting your cursor within any
cell address and typing Command-T toggles the dollar signs (both the
first and second ones, independently) on and off.
SHORTCUT

~ Copy this formula to 021 and E21.
~ Put in the category and monthly totals for the expense section. Your
Quarterly Financial Report should now be complete.
Sit back for a moment. This is a lot of pretty sophisticated stuff. But what you've
just done is master a big part of spreadsheet operation. Relative and absolute
addressing are not easy concepts to grasp, so you might want to go through this
exercise again sometime this week. Pat yourself on the back for having done
this- and never needing to go back to manual calculations again.

PRINTING
Printing from a spreadsheet is much like printing graphics and word processing
files , with one big difference. Since spreadsheets can get so large, Excel asks you
which part you want to print. So the first step is:

OJ Set the print area. Select the area of your worksheet you want to print.
Then use the Options menu to Set Print Area. Note the dotted line around
this part of your sheet.
[}) Choose Print from the File menu and notice that, in addition to the usual
items in the dialog box, there 's a Print Preview below the paper feed
options (as well as on the File menu itself, should you want to choose it for
one occasion, rather than as a default. Better to leave it checked in the dialog
box, though). This is a real time- and paper-saver with spreadsheets.

@J Click on the words Print Preview to turn on this check box. Don 't click in
the box-it takes too much of your time to guide the mouse to it. Click on
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The Print dialog box, with Print Preview checked.

LaserWriter "John's RISCY Laser"
Pages:® Rll

Copies:J•J
Couer Page:

® No 0 First Page

Paper Source: ® Paper Cassette
Print:

® Black ll' White

Destination:

® Printer

[8'J Print Preuiew ~

~Print
_®Sheet

0

0

Notes

0
0
0
0
0

n Print n

7.1.1

From:

D

To:

D [ Cancel J

Last Page
Manuel Feed
Color/ Grayscale
PostScript® File

[

Print Using Color
O Both

Help

l

I

the words, and then click OK. Excel gives you a view of your print area,
reduced as necessary to fit your screen .

8J When you actually want to print what you see , click Print. For now, click
Close to return to your working document.

DISPLAYING FORMULAS
Another (!) nice thing about electronic spreadsheets is that you can print them
showing the actual formulas , rather than the values they produce.
This is especially helpful for error-checking because, with the great savings in
time that spreadsheets produce, users tend not to check their formulas enough.
The classic story tells how a company lost over one hundred thousand dollars
on a bid because of one error in a formula. Since then, many corporations ask
you to print worksheets with formulas displayed so that an associate can check
them. To do this:

QJ

Choose Display... from the Options menu, and select Formulas from the
resulting dialog box.
You may end up with columns wider than needed to see entire formulas. If so:

0

Double-click on the line separating two column letters for a 'best fit' , or click
once on the line and drag to set the desired width.
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II

· ?•c; Values are displayed In the illustration on the left; formulas on the
right. A label on a calculated number is no guarantee of its accuracy.
Checking formulas is one of the most important parts of working
with spreadsheet programs.
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If the increased column widths make your printouts larger than one page,
you can reduce the font size for the worksheet, or print it out sideways (in
landscape orientation , rather than portrait).
To do this, go to the File menu, and:

@J

,

Choose Page Setup. In the resulting dialog box, note the options for orientation, header and footer, and margins. Then go to Print Preview to see how
this looks. Note also that you can omit gridlines and row/column headings
?•r~

The Page Setup dialog box.
laserWriter Page Setup
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from printing. You can also prevent them from displaying, a choice made by
choosing Display from the Options menu. What displays and what prints are
independent here, something of a departure from Mac WYSIWYG.

GRAPHICS
Here's the most fun part of the Excel program. It also bears on an important fact
about information: although the numbers might be valuable and useful, they're
often less understandable as numbers than as charts.
Excel lets you take numbers and make charts- and you can include these
charts, as well as the numbers, in your word processing documen ts. You can
also work up nice presentations , with numbers and graphics for slides or
brochures, right out of the Excel program.
It's so easy that users tend to produce charts that are beautiful but not very
useful. Have an idea what you want to say with a chart before you make it.
Let's make a presentation, including numbers and chart, of your income for
the last quarter. First, let's copy that part of your sheet to a new one.

OJ Select cells Al through FlO .

0

Choose Copy from the Edit menu.

@J Choose New from the File menu, and specify new worksheet.

0

Choose Paste from the Edit menu, and save this data to disk.

These are the numbers we'll present. To make a chart:

OJ Select the income categories in AS through A8.

0

Hold down the Command key , and drag through the totals in F5 through
F8. This is called selecting discontiguous regions of the sheet. With these
two areas selected:

@J C lick on the ChartWizard tool in the tool bar. Your selected areas now
have dotted lines running around them.

0

Click in the top left corner of A12 , and hold your mouse button down.

CHAPTER

4

INTRODUGION TO SPREADSHEETS

@J Drag to the bottom right corner of F24, and release the mouse button. You'll
see the first of a series of dialog boxes asking you for specifics about your chart.

[!} Click Next in the ChartWizard-Step 1 of

5 dialog box. Click Next on
each of the succeeding series of steps, to choose:

• chart type: Column
• format: 1
• Excel's suggestions for the Sample Chart
• the second set of suggestions. Click OK.
Presto. Excel has drawn a chart of the numbers you selected , in the area you
selected.
: We 've drawn a chart on the worksheet, to complement the correspondlng numbers.
Worksheet2
A

8

C

0

E

F

G

H

~~~~~!f~!~~!~!l§~~i
$10,000.00
$8,000.00
$6,000.00
$4,000.00
$2,000.00
$0.00
Boot legging

Bribes

Protection

Nice, but we wanted a pie chart. To fix that,

QJ Double-click on the chart, to put it into its own window.
bar has changed as well. Now we can modify the chart.

Note that the menu
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[}] Select Pie ... from the Gallery menu and choose option 6, which includes
percentages, and click OK.
Excel's Gallery of pie charts. Any chart can be changed from one type to
another-or from pie to line, bar, etc.-at any time. after you make it.
Chart Gallery

Pie

.,
4

'

OK
Cancel

I

NeHt...
( Preuious ... )

Help

Pretty nice, but 'twould be better with a legend. So, from the Chart menu:

W Choose Add Legend. There you go-not bad for a day's work. To finish up:
GJ Choose Attach Text from the Chart menu, and OK the resulting dialog
box, indicating that you want to attach text to the title. The word Title now
shows in the Edit line.
[}] Double-click on the word Title to select it, and type in Category Totals.
Click in the check box. Then , with the title still selected-it has handles
around it, to show it's selected-

0

Choose Font from the Format menu and choose what font, size, and style
you'd like for your title. Then click in the chart window's close box. You should
end up with something like this, pretty professional by anyone's standards:
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Your finished presentation. With the chart selected, but not in its
own window, you can move It around on the worksheet.
Worksheet2

• BootleooT1g

2 1%
- 3 2%

6%0

0

Bribes

• Protection

41 %

CHECKLIST
It's hard to overestimate the value of what you've learned today. Business, government and education rely on fast numbers and meaningful presentation to
make intelligent decisions. The ability of the personal computer to do so well in
this area was historically the largest single factor in convincing people that their
desk should have space for one.
Spreadsheet features you can now use include:
• data entry and formatting with dialog boxes and the tool bar,
• formulas ,
• cell addressing, relative and absolute, and
• structured graphics.
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OTHER CHOICES
Excel's main competitors are Lotus 1-2-3 and Claris Resolve. Both of these and
Excel are written to exchange data with Lotus' best-selling spreadsheet for the
IBM PC.
Lotus for the Mac has the feature set to match Excel, adds three-dimensionality to spreadsheets, and is a well-designed tool. Resolve is less expensive but also
noteworthy and is, like Lotus, a newer entry in the marketplace than Excel.
Choice of program in this area is a difficult one.

Q&A
Q: Is there a shortcut to select the entire worksheet? I want to do

global formatting.

A: Click in cell AO, so to speak-the blank box above row 1 and to the left of
column A.
Q: My screen doesn't show the tool bar.
A: Choose Workspace from the Options me nu, to give you choices about

what Excel displays.
Q: I want to format my numbers as currency, but the Format com-

mand doesn't work.

A: As in word processing, you have to select first, then format.
Q: Excel is representing my formulas as text.
A: For Excel to recognize a formula as such, it needs to begin with an equals

sign.
Q: I enter a formula in a cell, and then get "REF!" or "NUM!" as a

result.

A: Your formula makes an incorrect reference, or it attempts to divide by zero.
Be patient and methodical when checking formulas.
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Q: I'm having trouble printing, and getting the parts of the work-

sheet I want on one page.

A: Changing font size (or the font selection as well) can help here. So can using
the landscape orientation .
Q: When selecting cells, when do I use the Command key or the

Shift key?
A: Selecting a range, and then holding down the Shift key to select further,
works as in Word: you'll select everything between the original selection and
your more recent choice. The Command key, conversely, lets you select discontiguous regions-groups of cells separated by other cells you don't want
to select.
Q : My chart seems too small for the size window I give it.

A: Excel makes good use of white space, an important feature in presentation.
Simply put, charts and numbers are easier to comprehend if there's empty
space around them. Matching chart size to the numbers behind it takes practice-formatting the numbers as larger is one option.

SAMPLE EXERCISE
Start a new worksheet to hold and present data about an interest of yours that
doesn 't relate to finance. Since spreadsheets are stereotyped to finance, many
computer users lose sight of their myriad other applications- a shame , because
almost any time you have a list with more than one column , a spreadsheet can do
that for you. Clubs, collections, car repair records ... and then see how helpful formulas and charting can be.

(HAPTE~
ADVANCED
SP~EADSH EETS
In this chapter you'll learn:
• Balloon help for spreadsheet use
• multiple worksheets
• linking two worksheets to a third
• combining worksheets
• working with split and multiple windows
• naming and locating spreadsheet regions
• attaching notes to worksheet cells
• altering variables to predict outcomes
• solving backwards from an outcome to its components
• advanced charting functions
• macros
• multitasking
• publish and subscribe
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In the last chapter, we looked at an application that you might use more in a business environment than any other. Excel is also an especially large and complex
application, but current trends in software are producing programs like thesethere are enough features fo r everyone , and so many that most users don't
explore all of the application's possibilities.
This chapter explores some of Excel's advanced features , for two reasons:
first, it's such a useful tool, and second, it demonstrates that with applications like
Excel (and FileMaker Pro, which we'll look at in the next chapter) , there's simply
a great deal that these programs can do.

ON-LINE HELP
In the last chapter, we looked at Excel's context-sensitive help, available from
System Ts Help Balloon menu (or Window menu for a Macintosh on System 6),
and noted Excel has a second Help function , in the form of one-line guides at the
bottom left of the screen. Excel has a third kind of help, the help balloons themselves like those in the Finder. To use these, Balloon Help must be turned on.

W Start up Excel in the usual way.
l2J Choose Show Balloons from the Help Balloon menu.
~ Move your mouse over, for example, Excel's tool bar. You should get informative balloons about that tool or part of the screen.
Note that a ll tools are still operational. The process of drawing balloons slows
operations down a little, though , so users usually turn Show Balloons off after
they learn a program .

MULTIPLE WORKSHEETS
Assume that you are a Superintendent of Schools, and are preparing budget proposals to present to the School Board for your elementary school and high
school, reflecting a target increase for the coming year of 5 percent. The principals of your two schools, Auburn and Cedar Ridge, have prepared two Excel
worksheets for your use.
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~ Enter, save and close these two worksheets, as shown below.
Estimated budgets for two schools.

D

0

Auburn

D

0

Cedar Ridge
A

I

B

I

C

I

D

I

~

At this point, let's say that these two worksheets have been prepared for your
use, and are on your disk.
All you have to do now is find them, and it's sometimes easiest to do that in
the Finder, the part of the Macintosh we covered in chapter 1. It uses windows and icons to show what's on disks and in folders, and to copy files from
one place to another.
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The Finder has another function, that of searching all of the disks in a
computer for a certain file. We looked at this in Chapter 1. What's
important to realize now is that this tool is available to us, no matter
SHORTCUT which program we're in, by switching back to the Finder for the search.

~

Make your Excel window(s) smaller than screen size-especially, leave some
room on the right, where the Finder shows disk icons.

[QJ Look at the very top right of your menu bar. Since you're presently in Excel,
you'll see a miniature version of its icon, as in Figure 5 .2.
The Excel icon (left) and
Finder icon {right), as
seen at the right of the
menu bar when these
programs are active.

[I]

Click on that icon, and you'll see a menu drop. You'll see a list of open applications, programs currently running, and the Finder is one of them.
The Finder is always running. Right now, Excel is in front of it on your
screen, much like one window in a program can be in front of another
window of the same program.

~

[II

Choose the Finder, to bring it to the front of Excel. The Finder's miniature
icon now shows at the right of the menu bar, again like Figure 5.2.
Use the Find option from the Finder's File menu to locate the Auburn and
Cedar Ridge files: Move them both into the same folder, if they're not already
together.

[2J Select one of them and then, holding down the Shift key:
~ Click on the other to select it as well.
We call this Shift-clicking, and use it a lot on the Mac·to select multiple items.

~

Choose Open from the File menu (or type Command-O).

This amazing machine goes from the Finder back to Excel, and opens both of these
Excel files. This is a great 'power feature' that experienced Mac users just love.
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Now that the individual schools' worksheets are open, let's make a new sheet
for your consolidated budget.

QJ Start a new worksheet, and type in the information you see in Figure 5.3.
Column A is a bit narrow for your use so, after entering the data, widen it by
double-clicking on the line in thecolumn headings (between A and B), so that
the contents of A3 ("Target increase=") is completely visible in the cell.

[I) Save this worksheet. This isn't too early to save it. Call it Con.Budget.
Your Consolidated Budget worksheet.

@J Enter a formula in 08 to give us the goal for salaries for 1995, which will be
the 1994 figure plus the target increase of 5 percent. This is =C8 *(1 +83)
where (1+83) amounts to the present value plus the increase, or 1.05 percent.
We want this calculation in 09 through 012 too, but if we just pasted it as is,
we'd end up with the same problems with relative addressing we found in
chapter four. So,

8J Change the formula in cell 08 so that B3 reads $8$3. Just click in 83 in the
formula, and type Command-T. Copy it, and paste it into 0 9 through 012.
Just select the range 09 .. 012, and choose Paste.
Note that a single dollar sign before B3 (or before the 3) would not work for
our purposes- that would hold only the vertical (or horizontal) component
absolute, while we need both components absolute.
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While we want B3 to be an absolute reference in this formula , we do not
want this for C8, so that the pasted formulas accurately address the various
categories of expenditures.

ITJ Enter Total Budget in A14. Enter a formula that totals expenditures in column B. If you like , you can click B14 and then click Autosum in the tool
bar, but note that Autosum suggests the range B8 .. B13, while your layout
has left B13 blank. Fine , but should you later enter a number in B13 , the
total in B14 includes it.
This can spell eithe r convenience or disaster, so it's good either to change
the formula, or keep in mind Autosum's way of doing things.

I1J Copy this and paste it into C14:E14. For these formulas, relative addressing
is just what we want.

[I] Save again at this point. You've done a

lot already.

Here's a good place for what's called a Power User's Tip. If you ever want to
make a lot of money fast, publish a book of these tips. Computer users go crazy
over them.
This tip is: what if you make a mistake in a formula-one of your references is wrong , say, and you can 't find it. You could if you had
another five minutes but, just at this moment, you need to do someSHORTCliT thing e lse with the worksheet. For example , you may need to help
someone who's just called on the phone.
Excel won't let you do anything else until that formula 's right-so edit out the
equals sign, and make it into text. The cell just displays the botched formula as
though it were text and, when you have time, you can come back and fix it.
Back to business: let's look at how we can greatly magnify the power of a worksheet, by linking two or more together so that they can literally talk to each other.

LINKING WORKSHEETS

OJ Look at Excel's Window menu. You should have three o pen worksheets at
this time. What we're going to do is /ink information from the Auburn and
Cedar Ridge worksheets into your Consolidated Budget.
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Rather than just copying information, linking creates a dynamic relationship between cells in different wo rksheets , so that should the
Auburn s heet later be revised , th at alteration updates yo ur
N 0 r E Consolidated sheet automatically.

[I] Bring the Consolidated sheet to the front with the Window menu.
@J Click in E8, and we'll enter a formula that links to the estimated salaries for
the Auburn and Cedar Ridge schools.

GJ Type an equals sign and then, with the Window menu,
Linking data from the Auburn and Cedar Ridge sheets into the
Consolidated worksheet.
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ITJ Bring the Auburn sheet to the front and click in its cell 08 .

IIJ Bring Cedar Ridge to the front, and click in 08.
[I] Then

click in the check box to complete the formu la. This brings
Consolidated to the front again , and E8 should be the sum of DB for both
schools' worksheets.

Linking data is a powerful way to use a spreadsheet. Take a moment to
review what you've just accomplished. Repeat the steps if you don't understand the concept behind this.

[I] Repeat this for Books, Maintenance and Utilities.
Entering data in a linked worksheet is the same as entering data in any other
worksheet:

~ Increase the 1994 figure for transportation by 5 percent in your Consolidated
sheet, since transportation is not included in each school's sheet, to complete
your estimated costs for 1995. The formula for this is =Cll *l.05.
An elegant feature worth a quick look is how Excel maintains links, whether documents are opened or closed.

ITJ Close your Con.Budget worksheet, saving changes.
[I] In Auburn, change 08 to $520,000. Close it, saving your change.
@J Open Con.Budget again . Excel asks if you want to update references to
unopened documents, in this case Auburn. Click Yes.
Excel knew that you had changed Auburn, and that the change would reflect in
Con.Budget. This works only as long as you don't change the name or location
of Auburn, since that's how Excel identifies the links between worksheets.
As well , Excel gives you the option to open any sheet linked to the one
you're working with, by the Links option on the File menu. But why have all links
open all the time? It just takes up memory.
Rather than link separate worksheets, a nother way is to combine small
sheets into one large one. This option doesn' t let others update the smaller
pieces to a big puzzle, and it gives the user the additional headache of having to
navigate around a larger worksheet (although Excel has several features to make
navigation easier}.
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The dialog box from the Links command. Here, Auburn and Cedar
Ridge have been closed, with Con.Budget remaining open. The two
lines In the Links box describe the path to the two closed files: they're
on a disk named Storyville, In a folder named Desk, and so on.

1. 1 .

Links
link Type:

IEHcel links

!ol

links:
Storyuille:Oesk:Manuai:RS ... :Auburn
Storyuille :Oesk:Manu ... :Cedar Ridge

~

~

OIH~n

(

Close

l

)

( [ IHUHJ•~ "')
( IJplil~ tP )
(options ... )

{>

0

(

Help

)

fl(~<l<l Oni~J

But earlier versions of computer spreadsheets didn't allow a linking structure,
and many users learned to combine smaller sheets into larger ones. So let's combine ours.

!IJ Open Auburn and select the range Al:D13. Do this either by clicking in A1
and dragging to D13, or by clicking in A1 and Shift-clicking in D13.

[TI Copy this , then bring Con.Budget to

the front, activate A17 and select

Paste. Excel pastes from the top left.

[I) Do this for Cedar Ridge, pasting from A33.
Now, even though the Auburn and Cedar Ridge sheet information is contained
within Con.Budget, the links in Con.Budget remain with the separate schools'
sheets. We need to change this.
So let's revise some formulas . We'll simply go back to estimated salaries in
the Auburn and Cedar Ridge areas of Con.Budget, and include those in the formula in E8 in Con.Budget.
Overall, an easy maneuver. The only difficult part might be scrolling from
one point to the other without getting lost. A major difficulty with large work-
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sheets is seeing what you need to at one time. Con.Budget, in a real implementation, could easily be larger than your screen . Two useful features here are split
windows and multiple windows .

!JJ Look at your scroll bars. Just above the top arrow on the vertical bar, and just
to the left of the left arrow on the horizontal bar, are the two small black rectangles used to split windows, as shown in Figure 5.6.

Black rectangles to split
windows.

'"-11

[}] Click on the rectangle in the vertical bar, and note how the cursor changes.
Drag down to about the middle of your screen. Excel has split the window,
and you can scroll these two panes vertically, independently of each other.

~

Do the same thing with the rectangle on the horizontal bar. Move this to
about the middle of your screen. You now have four window panes, and can
scroll to move around each.
One worksheet, shown in four independently scrollable windows.
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Some word processors have windowing capabilities too. They're a convenience
for word processing, but necessary for serious spreadsheet work.
The other way to increase your access to a large worksheet is by creating a
separate new window of the same document:

GJ From the Window menu, choose New Window. Your new window is displayed in front of the old one. To move among the various windows you can
create, use the Window menu to bring one to the front, or:

[I] Choose Arrange ...

from the Window menu to have Excel make an arrangement for you of your choice-try Tiled for now. Then pull down the Edit
menu, where the second item Oust past the extremely valuable first item,
Undo), is the command to repeat your last action: in this case , select
Repeat New Window . Do this, then choose Arrange All from the
Window menu again.

@] Revise your formulas for column E of Con.Budget so that they now reference
Auburn and Cedar Ridge information not on their separate sheets, but from
their areas of Con.Budget.

~

As a general rule when entering formulas, try to use Paste and the
mouse , rather than typing. Saves lots of mistakes! Speaking of
Save ... have you lately?

N 0 T E

NAMING REGIONS
Another way to navigate is to give an area of your worksheet a name. You can
name a cell you use often, such as the Target Increase value (B3) of Con.Budget.
You understood "Target Increase" much faster than "B3, " right?

OJ Select B3 and use Define Name from the Formula menu to name this cell
"Target_Increase." (The underlined space between the two words is necessary because Excel doesn't like range names with spaces in them. Excel does,
however, prompt you to name the cell with the text in the cell to the left or
above, if any.)
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Define Name Is a most useful tool for Identifying cells or regions of
worksheets. We selected B3 first, then called up Define Name. Excel
suggests the text found In the cell to the left of 83.
Define Name
Names in Sheet:

~

Name:

Refers to:

1=$8$3

~

OK

,

Close

Add
Delete
Help

[1]

N

Now select 0 8 and select the reference to $B$3 in the edit line Oust doubleclick on it). With that selected, choose the Paste Name command in the
Formula menu, click Target_Increase, and click OK. Then click in the
check box to confirm this change in the formula.

o

T E

In a large sheet, you could name all sorts of key cells, then construct
formulas using Paste Name. At any point your formulas would tell
you, in plain English, just what you're doing. This practice also obviates a major source of errors.

You can name a range, or selection of cells, just as easily, in order to make
that area of your sheet easier to find .

~

Select the part of Auburn 's budget that you pasted into Con.Budget
(Al7:D29) and name it Auburn. Then use GoTo under the Formula menu to
move to that section of Con.Budget. Downright spiffy.
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NOTES
Excel allows you to attach a note, something like a Post-It note, to any cell. This
is useful to include non-printing information to yourself or to others who will be
using your worksheet.

GJ Select A8, and choose Note from the Formula menu. Click in the Text Note
window, and type includes new positions. Click OK.

ITJ Click cell Al , and choose Find from the Formula menu. In the dialog box,
type new positions in the Find What box, and click on Notes in the Look In
box. Click OK, and Excel goes to the cell containing that note.

~ If you had the same word, or string of characters, in more than one note, you
could find the second occurrence by choosing Repeat Find at this point
from the Edit menu.

THE WONDERFUL WORLD OF 'WHAT-IF?'
We've covered what Excel can do for us as long as we're doing all of the thinking,
low-level as well as high. But a different order of magnitude in the usefulness of
personal computers comes along when we let them do the low-level thinking,
freeing us to spot trends and make decisions.
To begin with, one of the nicest features of electronic spreadsheets is that, by
altering one variable, you can predict the effects of several different possible outcomes.
In school budgets, different banks' home mortgage offerings, or any number
of scenarios, your ability to make a cogent decision depends on being able to see
results of calculations that include several changing factors . Let's do some of this
with our school budgets:

GJ Bring Con.Budget to the front.
[I] Change the 5 percent target increase to 3 percent, then to 10 percent.
Watch column D as you click on the check box in each case.
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If you have constraints in one category of expenditure, and wish an overall target

increase for planning purposes, this is one way to find it.

THE SOLVER
So far, we've put in numbers and looked at the calculated result. What if we were
shooting for a result, and wanted to know the numbers needed to reach it? We'd
be calculating backwards from the solution to its components, and Excel can do
this rather well.
This type of calculation is trivial where our paradigm is linear, but considerably
more complicated where it is non-linear, for example in cases of diminishing returns.
Say your company makes widgets. As you increase advertising, profits
increase but by a diminishing amount. Somewhere along the curve, there's an
optimum amount o f advertising for your widget. Let's find it. Our marketing
model is:
Unit sales= 12 * (Advertising+ 5000) "0.5
so that advertising adds to the baseline of 5 ,000 units people will buy anyway,
but with diminishing re turns. Ten thousand dolla rs in advertising yields 5 ,511
units sold , $20,000 yields sales of 7 ,115 units, while $50,000 returns sales of
10,553 units. What's optimum?
Our complete model is shown in Figure 5.9. We want to maximize the value
of 811 by changing, in this instance, the value of 87. So:

•

Solu er.eK

A marketing model.
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IIJ Start a new worksheet, type in this model, display values, and:
0 Open Solver from the Formula menu. You'll see a dialog box like Figure
5.10.

I

The Solver Parameters. You can fill the Set Cell and By Changing
Cells boxes by typing, or by clicking on the worksheet cell you want.
Soluer Parameters

(
I(

Set Cell :
Equal to: @ MaH

Q Min

0

Ualue ot:

Jo

By Changing Cells:
1$8$7

I(

Close

Guess
Options ...

Subject to the Constraints:

I

Solue

~ (I
o(

Change ...

)
) (

Reset All

Delete

) (

Help

Add ...

'

Drag the dialog box out of the way of your marketing model if you need to
and, with the cursor in Set Cell:

@J Click in cell

B 11 of your worksheet. The absolute reference to that cell
appears in Set Cell.

0
0

Set Equal to at Max.
Click in By Changing Cells, then click in cell 87 of your worksheet.

~ Click on the Solve button at the right, and watch the fun .
You should have reached a solution of $ 15,737.
This is a nice tool to have . If you like, you can solve for more than one variable at a time. You can then go back to the "what-if" paradigm , this time with a
multi-dimensional perspective on the situation . Tell your competitors not to play
too much golf.
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GRAPHICS
As previewed in the last chapter, a particularly nice feature of spreadsheets is their
ability to create graphs and charts from your data. Nice, because good charts can
convey meaningful information much better than the numbers themselves.
Bring your Con. Budget sheet to the front again with the Window menu. We'll
try a 3-D column chart of Books, Maintenance, Transportation, and Utilities.

OJ Select these cells, using the Command key to select discontigous regions:
A6; A9 .. Al2; D6; D9 .. D12; E6; E9 .. E12.

III Click on the ChartWizard tool in the tool bar. Note that the cells you've
selected have shimmering marquees around them.

@J

Draw a rectangle on your worksheet below the numbers, to cover about A16
through F40 . You can move it later. The first of the ChartWizard dialog
boxes appears.

• Step 1: Click Next to confirm the cells you've selected.
• Step 2: Double-click the 3-D column chart type.
• Step 3: Double-click chart type 6 .
• Step 4 : Here's your sample chart. Check that the radio buttons for Data
Series in Rows, Use first row for Category (X) Axis Labels, and Use
first column for Series (Y) Axis Labels are all selected. Click Next.
• Step 5: See that Add a legend? is not selected. Click OK. Your chart
appears as part of the worksheet, with handles around it. Note the icon row
at the bottom of your screen, should you wish to change chart types.
At this point, the chart is part of the worksheet. It can be moved or resized, but
not edited. To do that,

liJ Double-click on the chart. It reappears in its own window, and the menu bar
changes to list options appropriate to graphics.

[I] Add a legend from the Chart menu. We didn't add a legend as part of the
ChartWizard sequence because we wanted a better look at our chart first.

~ Click the chart text tool (fourth from the right on the bottom row of icons).
Then click in Excel's edit line.
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IIJ Type Estimates in these categories are lower than the goal figures, and
click the check box. This text appears in your chart, with handles around it.

[I]

Move and reshape this text so that it is on two lines, and is displayed at the
bottom of your chart.

~ Click the close box of the chart window, so that the graph once again shows
as part of your Con .Budget worksheet.
By now your effort should look something like Figure 5.11 , except of course that
you probably didn't name it "Figure 5 .11" when you saved it. What did you name
it when you saved it?
Numbers and accompanying annotated chart.

D

Books

Iii Maintenance
Uti ities

•

Transportation

0

Utilities

1 995
(est.)
Est imates in these categories are lower
than the goal ~IJUres.

-0
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While you've just made a nice presentation, you can also move charts
or numbers right into a word processing or desktop publishing document. Inclusion of graphics in a larger report does a lot for readability
and interest, and for your ability to convey meaning concisely and well.

When you do that, one thing to consider first is the finished size of the chart that
you want. It's best to resize a graphic in the original program, rather than letting
the receiving program worry about it.
Here's how to move a chart into a word processing document:

CD Double-dick on the chart to put it in its own window.
C3J Use the resize box to make your chart an appropriate size.

0 From the Chart menu, choose Select Chart.
8J Use the Copy command from the Edit menu to copy your chart to the Clipboard.
0 Open the Scrapbook, and paste your chart there.
When in a word processing or desktop publishing program, you can paste a chart
from the Scrapbook into your paper, just like anything else. Proofs for this book
were done entirely on a Macintosh , copying, for example, Figure 5 .11 from
Excel into a page design program such as you'll learn in Chapter 8.

MACROS
Here comes one of the more sophisticated parts to Excel, or to computer usage
in general. Up to now, you've done everything step-by-step, and have gone
through many steps twice to repeat an action after making some change to relevant data.
For example , if you were making several charts, each to reflect some change
in the worksheet information-graphing several 'what-if ' scenarios, for
instance-you'd select the ranges of cells you wanted to graph, then go through
all the steps of creating a chart.
Why not tell the program the sequence of steps you wanted it to perform
each time? Have it record that sequence, and play it back for you on command?
This is actually a kind of programming, called a Macro.
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Let's try this with our graph-making, to automate the procedure of creating a
chart. Let's try a pie chart this time, and let's create it in its own window. We can
paste it onto the worksheet later on. So, close the chart window presently open
and, with it back in your worksheet with handles around it, press the Delete (or
Backspace) key to remove it from Con.Budget. Let's make a chart macro.

ITJ Select the cells you want to graph. (This is the step we do not want to automate, since we'll be changing the data to be graphed each time.) For this example, select all of the expenditure categories, and the 1995 estimated figures.

[II Come up to the Macro menu, and choose Record ....

Excel asks you for a
name for your macro. Rather than "Record1, " let's try "Pie.Chart. " Put a
period rather than a space between the words, as spaces won't work.

Excel also asks you for a keyboard equivalent-Option and Command
key-so that you can play this macro just by typing simu ltaneously
Command, Option, and your key. It suggests a, and that's fine. Next, we
want to store this macro in a non-global Macro Sheet , as should be the
default. Click OK.

,

II""'
"1J"Ji.:l
.... ~__.....

As named here. this
macro will play every
time you type
Command-Option-a.

Record Macro
Nome:

IPle.Chort

Optlon•3S Key:

I ~

,

~

~

1r ore Mocro In
0 Globol Mocro Sheet
®Macro Sheet

OK

I

~

To edit the global macro sheet, choos e
Unhlde from t he Windo w menu.

Excel is now recording what you a re doing. Take your time, as it's only each
step that's recorded, not the time in between.

@J

Choose New from the File menu, and select Chart from the dialog box.
Click OK A bar chart is displayed in a new window.

0
0

Choose 3-D Pie from the Gallery menu. Pick chart type 6.
Add a legend.

~ Choose Stop Recorder from the Macro menu. Delete the existing chart,
then test your new macro. Select the expenditure categories and 1995 goal
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figures, and type Command-Option-a. Hey there. You've just done some
computer programming.
There are many kinds of macros in different programs. All are great
time-savers and, more importantly, can minimize mistakes because the
steps taken are less prone to the errors that humans tend to make
SHORTaiT when performing repetitive tasks.
But they can also create mistakes if not thought through carefully.
Keep macros short and sweet, so they do only a few steps. You can later
combine, either by chaining or nesting macros, so that one larger macro
plays several small ones.
The big advantage here is that should you later decide to make a change in one
step, you only need to re-record the one small macro that contains that step.

ITJ Save your macro. From the Window menu, choose Macrol. Save this onto
your disk-the default name is fine. Now look at what you've got:
Starting in Al, you should see this sequence:
Pie.Chart (a)

Your title (command equivalent)

=NEW{2,2)

Choosing New with the second option: Chart

=GALLERY.3D.PIE(6)

Choosing Gallery, 3D-Pie, then the sixth option

=LEGEND(TRUE)

This step added the Legend

=RETURN()

Macros always end with a Return

There are four things of interest here:
• You can go to a macro you've recorded and edit it, once you know the code.
This is a very handy time-saver.
• You can learn that code by recording some macros, and then looking at what
you've done.
• You can take only the macro document, which you've just saved onto your
disk, and take it to another computer that uses Excel. Open that macro sheet
and use the macros you've created to work with other data.
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• You can have several macro sheets: one for your income statement, another
for your balance sheet, and open and close them as needed.
Here's a big tip, though: The major mistake people make with macros
is that they record one, and then go off and play it, or do something
else, without stopping the recording! Remember that Excel records
WARNING everything you do until you tum the Macro Recorder off.

MULTITASKING
Now that you know how to use both Excel and Word, let's look at a big step up in
PC operation: how to use two programs at the same time. This is not just so that
you can work up a spreadsheet for a while, then do some word processing.
Rather, you can include numbers or a chart from Excel in your Word document
much faster, by having both open at once.
Allowing multiple programs open at once is automatic-you can open a program and then simply open another one. To test this:

OJ Open a chart in Excel.
I2J Click on the small icon in the Application Menu at the far right of the menu

.

bar. You'll see a menu drop, which shows you the programs currently running. Choose the Finder.
'

[I]

The Excel icon (left) and
the Finder icon (right), as
they appear on the
Application menu.

Open Word , and type a few lines like what you see in Figure 5.14. Press
Return twice, to move the cursor to open space in the document.

GJ Go back to the application menu, at the far right of the menu bar, and switch
back to Excel.

ITJ Select your chart, and choose Copy.
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Switch back to Word , and paste the chart there. Figure 5.14 shows this
sequence .

..

With both Word and Excel running, we created a chart In Excel using
the Auburn worksheet. Then we copied It, switched to Word, and
pasted it into our document.
We could also use the Scrapbook, or System 7's Publish and
Subscribe capabilities. Publish and Subscribe would create a dynamic
link between the two files. lf we should revise the chart in Excel, the
Word file would automatically update to reflect the change.
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This is quite a bit faster than using the Scrapbook, and opening and quitting each
program in turn. But there 's a much more sophisticated version of this routine,
available only in System 7. The difference is this: in the preceding sequence, you
copied and pasted a chart as a graphic, and that graphic is then fixed in your
Word document, even if you or an associate makes a change in the original chart.
What if you could dynamically link the Excel chart to the Word file, so that if a
later change were made to the chart, it would automatically update the Word file?
In other words, you could publish the chart, and the Word file would , as it
were , subscribe to it. If the chart changed and were, so to speak, a later edition ,
the Word file that subscribed to the chart would include that later edition.
Here's how to do this.

OJ Switch to Excel , and select your chart.
0 Choose Create Publisher from the Edit menu. You'll see:
,

,.,

The Publish dialog box. At the left is a preuiew of what's selected.
Locate your disk, as though saufng a file. Click Publish to put this
edition on disk.

I[g) M!J FIOPP!J Disk ..,..I

Preuiew
:·,

!'
~~
-~

'
'
'

t..:

Hub urn

Q

(
(
(

0

·····-······-·-··-·····-······-····

t".l I:H< ~>I [ hnrt
Ll IHoni HP.IH>r t

...
......... l
a- ..

[g) My Floppy ...

a. ,..

Name of new edition:

I IEHcel Chart Edition # 1

······················-···············································!

I

)
Desktop )
New LJ )
Eject

(

Cancel

l

K
(

Publish

D

Options

l

Check that the Preview is what you want, and follow normal Mac desktop
steps to publish this.
This is called an edition , and will be available to every program using System
7's publish and subscribe technology.
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Switch to Word, put your cursor where you want this edition to appear, and
choose Subscribe from the Edit menu. You'll see:
• Locate the Edition. again check to see that the preview Is what you
want, and click Subscribe.
Preuiew

I(g) My Floppy Disk ..-1
0 E11cel Chart Edition #I

(g) My Floppy D...

m

Eject
Desktop

(

Cancel

([ Subscribe

0

)

D

Again locate the edition, and subscribe to it.
The visible results match Figure 5. 14, but there 's a big difference. The chart
in Word updates automatically whenever the chart in Excel is revised.

This procedure doesn't require that both programs be open at once. We did it
that way this time to look quickly at how it works. But once a n edition is published and subscribed to, the subscriber updates every time it is opened.
To be sure, this feature requires that all of the subscribing documents-any
number of them- be on the same disk as the publisher, or on the same network.
Or keep the publication on your floppy current with the Excel chart on computer
1 , and insert it in computer 2 before opening the Word document subscribing to
that edition.
You could do this just as easily going the other way: you could publish something in Word. Excel has a text box feature, and you could subscribe it to the
Word file. Or, you can publish a document in one program, and subscribe to it in
other files in that same program. Excel doesn't need this, with its linking capabilities, but you might find it useful in Word.
For example, you're doing a catalog full of detailed descriptions of merchandise. Your specialists in different areas would be working up capsule depictions.
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You could go ahead and put the overall catalog together with their first drafts,
and when their work was finished yours would be too.
Publish and subscribe offers substantial potential especially for group efforts
on a computer network. Say your graphics department on the fifth floor is doing
the illustrations, marketing on the second floor is making the worksheets and
charts, and you're putting it all together.
At any point in your work, your efforts are current with everyone else's. And you
won't miss a crucial revision in some numbers because the interoffice mail was late.
Note that as of this writing, not all Mac programs use publish and subscribe
yet. If you're preparing to buy a program and want to use this technology, check
first to see whether it's included.

CHECKLIST
As you've seen, there's a lot of features in a spreadsheet program. After this second chapter with Excel, you've learned to:
• work with multiple worksheets,
• link worksheets,
• work with split and multiple windows,
• name cells and regions and add notes,
• solve for different variables,
• use 3-D graphics,
• make macros,
• work with multiple open applications (multitask}, and
• publish and subscribe.

HELPFUL HINTS
The key here, as before, is practice. Once you learn the features, though, tutorials tend to be less useful than cooking up a project of your own.
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If you can design a worksheet to fit your business or a course you're taking in
anything from economics to statistics to genetics, you're finding program tools that
meet your needs. This kind of personal involvement gives you a sense of active
exploration of the program, and you'll do a lot very quickly that you can be proud of.

Especially quickly, if you work with multiple programs open. Your Mac can
open several programs at once, depending on the model and how much RAM it
has. Mac power users run a bunch of programs at once: graphics, word processing, page design-why not?
You most often see Mac power users in the store, waiting while technicians
install more RAM in their Mac. How much RAM is enough? We think it's like
money: You think that if you have just a little bit more, you'll have enough.
Anyway, at this point you can add "Competent on electronic spreadsheets
and computer multitasking" to your resume. You fought and beat both graphics
and macros, and you can do high-quality and useful work with spreadsheets, and
can multitask effectively. So take the weekend off-you've earned it.

Q&A
Q: Is there a shortcut for changing relative cell addressing to

absolute?
A: In the Edit Line, click the address you want to change, and press CommandT. You' ll see that this toggles from completely relative, to first address
absolute , then second, then both. Keep pressing Command-T until the
address is right.
Q: I can't see all of the data I've entered in some cells.
A: The column isn't wide enough. Put your cursor between the column labels,
for instance, A and B, and click and drag to change the column width.

Q: Linking cells among different worksheets doesn't work.
A: You need to start in the worksheet you want to link to. Type the equals sign
to begin the formula , and then go to other worksheets for their data.
Q: I've linked data from other worksheets into the active one, but

I'm not getting the correct result.
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A: If you linked the cells correctly, the problem's most likely that you moved, or
changed the name of, the sheet you're linking from. Excel then has no way
to determine where your source data is.
Q: I'm constructing a large worksheet, and am having trouble

finding parts of it.

A: Naming cells or regions, linking together smaller sheets, or using split or multiple windows all help. The linking feature to connect smaller sheets is often
the most useful.
Q: I recorded a macro for my worksheet, and it ran fine at the

time, but I can't access it now.

A: You've closed the macro sheet , a separate document that stores macro
instructions. You may have done this simply by quitting Excel and starting
again later . Open the macro sheet from the File menu, as you would any
other document. That's an important concept-macros aren't saved within
the worksheet in which they were created.
Q: I can't subscribe to a chart I published earlier.

A: It may not be on a mounted drive-that is, on a disk your Mac can find. If the
disk is available, finding the publisher is a matter of searching for its name, as
with any other file.

SAMPLE EXERCISE
Create a new worksheet in Excel, and make a chart from it. Publish the chart.
Then open Word, enter some text and then subscribe to the Excel chart. Format
your Word document for a professional and pleasing appearance. Then go back
to Excel and make changes, save them, and note how they a re reflected in the
subscribing Word file. Remember that as long as the disk you saved your publication on is available to your Mac, all editions you make continue to subscribe to it.
Data is then forever current. Consider the possibilities.

(HAPTE~
DATAGASES
In this chapter you'll learn how to:
• create a database and enter records
• change the design, or layout, of on-screen and printed data
• set up automatic data entry
• generate reports
• find and sort data by a variety of criteria
• pre-define values and constraints, for speed and accuracy
• use formulas in calculated fields
• create custom reports including graphics
• add macro, or scripting, functions

WELCOME TO ... THE MACINTOSH: FROM MYSTERY TO MASTERY

After number crunching, database applications were the first major use of computers in the business world. A database is simply a collection of orderly information-where "orderly" is something you define and structure.
Examples of paper databases are the telephone book, a recipe file, and the
library card catalog. On a computer, a database gains orders of magnitude of flexibility and power over the paper examples, and offers a great tool for almost any
area of endeavor.
Today we'll learn an exceptionally flexible and elegant Macintosh database
called FileMaker Pro, and how we can make information work for us.
But since FileMaker's flexibility is supported by one big structural difference
from the other Mac programs we've learned, it's a little confusing at first. Let's
get the concept.

WHAT'S DIFFERENT ABOUT A DATABASE?
The other programs give you a place to start work-SuperPaint gives you a blank
painting area, Word a new sheet of paper, Excel rows and columns of empty
cells. These programs provide an environment for you when you start them up.
FileMaker is different-the first thing you do is build your own environment.
This is because there's quite a difference between a phone book and a recipe file,
even though they're both structured information.
The phone book, for one thing, has a different kind of information than the
recipe file. We define one kind of information (which we call a fie ld ) in the phone
book as a name, and another kind of information as an address.
Recipe card files, as well, have fields for names, ingredients, and cooking
time. In fact, the first thing we do when beginning a database is figure out what
kinds of information, or fields, we want to include.
Our second question is where these fields are going to go on a page, or card.
The New York City telephone book puts all of the names at the left, and phone
numbers at the right. The phone book on my desk puts four boxes on each page,
with a name at the top, address in the middle, and phone number at the bottom
of each box. Their layouts are different.
Similarly, my recipe card file has a different layout than The Starv in g
Student's Cookbook, even though the data for the recipes, especially the good
ones, is similar.
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Components of a database file.
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-

I
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-

I

j,

second record

l'

'----

liD#

-

IName

IAddress

'----

I City

-
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I Zip

I
I
I
City field

I

...tJ

Zip field

ID#
Name
Address
~======4 ._

______ One kind of layout. The boxes could

City
State
Zip

easily be moved around to change
layouts. The fie lds or records would not
be affected.

In a cookbook, a single recipe is a record.
So when we start FileMaker Pro, we'll keep fields and layouts in mind, plus
the records, that together make up a database. FileMaker has us handle these
three parts in separate modes:
• The Field Definition mode allows us to create and edit fields, but we won't
be able to see the data in those fields. In the phone book example, we would
work with kinds of information such as name and address, rather than any
actual information of those types.
• The Layout mode is how we place fields on the screen, or the printed page.
We can put Address to the right of Name, or below it. Again, while I'm in this
mode, I can't see any actual addresses.
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• The Browse mode is FileMaker's term for the mode we use to enter and
retrieve records.
A record in the phone book is all of the information on one person-her name,
address, and phone number.
In the Browse mode, I can find anyone's address, or sort addresses by street or
zip code. But I can't change fields or layouts unless I go into those other modes.
When using FileMaker or any database, the most important thing to remember is what mode you are in. It sure saves headaches.

CREATING A DATABASE

QJ

Double-dick the FileMaker Pro icon. In the first dialog box:

0

Click on D esktop and then on the name of your floppy, which you of course
inserted in your computer a minute after you turned it on . Then click the
Open button. Be sure you're creating this file on your disk.

@J Then click on New in this dialog box, as in Figure 6.2, to create a new data file.

.
,

•

.

.

Creating a new data file.

I[g) M~ Flo pp~ Disk .,.. I
Q

[g) My Floppy Disk

Deskt op

l
l

( Netwo rk

)

(
(

Eject

Ne w

I
"0

In the second dialog box, shown in Figure 6.3 :

OJI(HI

Cnn cel

~
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Naming a data file.

I(g) M!J FIOPP!! Disk ""' I
~

(g) My Floppy Disk

~
Create a new file named:

IPerson nel

I

(

Eject

l

(

Desktop

l

n

New

(

Cance l

H
)

8J Type in Personne l for the name. Confirm that the name and disk drive are
correct, and click New again.

(I]

Define fields for your data file , as in Figure 6.4. Start with fD#, and define
that as a field of the number type.
Creating and defining fields.
Define Fi elds for " database"

0

I

fi~lds

Vi~w by cr~ation ord~r

Nam~

Tl

Name i~I_D4~----------------------------------~

;..· Type ····-···················································· ·················································~
1

® TeHt

3€T
Number 3€N
Date
3€D
Time
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0

Picture
3€P :
or Sound
0 Calculation 3€ C
:0
0 Summary 3€S
:..........................................................................................-...................................:

0
0

~

(
(

Create

~(

[ hiH\Ijf~

J ( nupli< nh• J

U<~le1<~

l(

OpHonL,

Done

j
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Define these other fields, and their types, as in Figure 6 .5 . After you type the
name for a field , and press Create, just go ahead and type the name for the
next field .
•

0

o}to]l

A List of fields.

Field Name
ID#
First Name
Last Name
Street
City
State
Zip
Phone No.

Type
Number
Text
Text
Text
Text
Text
Text
Text

Click Done.

When you leave the Field Definition mode, FileMaker takes you back to the mode
you were in last. In the case of a new data file , it takes you to the Browse mode.
The word Browse is displayed o n the bottom area of the active window, just to
the right of several icons, to confirm this.
This is where we do most of our work. In Browse mode, we can look at any
record, such as any individual name and address in our personnel file. We enter
all data, edit it, sort it, or find one or more records while we're in Browse mode.
Since this is a new file, you're now in the first (blank) record . The book icon
at the upper left, as in Figure 6.6, tells you how many records there are in this file
and which record you are on.
Enter the data for the first record only shown in Figure 6. 7 .
Use the Tab key to move from field to field . Pressing the Return key adds
lines to the field guide.

If you accidentally press Return, press Delete to remove the extra line, and
then use the mouse to first de-select and then re-select the field. (The line stays
until you de- and re-select.)
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FileMaker's Layout mode. Click and drag to move a field. The tools
along the lower half of the left side allow you to add graphic effects
much like SuperPaint's.

ID•

!

(!D.~........................

Fi rst Name

!f.i.r.s.t..N.e.m.e................................................................................-........)

L ast Name

(L.e.s.t..N.e.m.e.................................................................................- ........1

street

(S.tr.e.e.t.............................................................................................-........1

City

(C.i.tij ...................................................................................................._.......l

State

(S.tfl.t.e............................................................................................................)

Zip

(Z.iP...................................................................................................................I

Phone Number

(P..h.o.o.e...N.umb.e.r..................................................................................)

Layouts :

1

DAIS]
[Q]Q]2J

In layout mode, you can rearrange the fields (or boxes) that hold names and
addresses. You can also add another arrangement of fields:

W Choose New Layout from the Edit menu, or type Command-N.
~

Choose Standard, as in Figure 6.9, name it Address Book, and click OK.
Layout types. Each one offers an arrangement of fields appropriate
to a specific use, implied by the layout's name.
New layout
Name
r Type--- - - -- i @Standard
J
0 Columnar report
i 0 EH t ended columnar
0 Single page form
i 0 l abels
0 Enuelope
Q Bianlc

i

I

!

[ Cance l J

[!

OK

)J
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After you add a layout, the book icon at the top left lets you scroll among the
diffe rent layouts you have. In Browse mode, the same book scrolls among
the records in the file. Note Figure 6 .10.
• •JIJUIJ

lLay out

The book icon lets you move around in your file. In Browse mode, It
moves among records; in Layout mode, among layouts. Click on the
lower page to move forward; on the upper page to move backward.

1

#

I..,."'F-- - - - - Pop-up menu for layouts.

r--::;i!Ft - - - -- Ciick to move backward among records or layouts.
~-~
131~1------ Drag to move forward or backward.
{>

~+----- Click

to move forward.

F==:=:!l

L ___::....~----- Number of the record or layout you are on.

Records:

s•

Number of records or layouts in the file.

At this point, the book icon tells you that you now have two layouts. You
could scroll among your layouts. But since both of them are identical at the
moment, let's change the new one.
We do this by clicking on a field to select it, and then dragging it around, or
resizing it with the handles at the corners-much like o bject handles in
SuperPaint's draw mode. A lot of tools in various programs share design and
functionality. This makes learning much easier.

,

•

The ID label and the
field, shown unselected
(top), then selected.

m•

. . . .... . . . . . . J

!lD.~

• ID••
• •

l10-~·-· · · · · · · · · · ··I

You can also change the text format and style options for a field when it is
selected. You can select multiple fields by Shift-clicking, or using a selection
rectangle-again, much like in SuperPaint.
Note that the bold text next to the fields is just a label-not part of the data.
This supplemental information makes data entry more convenient.

E
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Move an entire object by clicking and dragging in the middle of it. Resize it by
clicking and dragging a corner handle.

~ Shorten the First Name field, and move the last name field up onto the same
line. You have to shorten it as well, so it will fit. See Figure 6. 12.
Your modified layout.

Layouts:
2

ID •

~lQ.~........................I

Name

IE.i.r.s.t..N.e.m.e.........J IL.e.s.t..Nam.e................................................J

street

l.s.tr.e.e.t.........................................................................................................l

c;ty

State

z;p

Phone Number

I.C.i..l!J ...........................I ~ IZ.i.P......................J

!P.hone. N.u.mb.eL..............................................................................I

ITJ Change the text label for this line to Nam e. Do this by using the text tool
(denoted, as in SuperPaint, by an A). Choose this, click your text cursor in
the middle of the "First Name" text, drag to the left to select the word "First,"
and press Delete.

0

Move and resize the State and Zip fields so they are on the same line as City.
Shorten the fields so they all fit.

For more precision in moving things around, select an object and press a
directional Arrow key on your keyboard. Each press moves the selected
- - - object one pixel. This feature is becoming standard in Mac programs,
SHORTCUT thank goodness.
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GJ Move the Phone Number field up to fit underneath the other fields. Move the
text labels after you move the fields.

!IJ Return to the Browse mode by the Select menu, or the menu at the bottom
of the window, or by typing Command-B.
Your first record, for Molly J ones, hasn't changed at all in terms of the field
definitions or the data in them, but the layout of the fields has changed.
We've now been in each of FileMaker's three modes. You can see how changes
made in one mode don't affect what you've done in the other two. It's frustrating
to forget this and try, for example , to find data while in layout mode.

A UTOMATIC ENTRY
FileMaker automates several aspects of data entry for you:

[I] Choose Define Fields from the Select menu, and click on the State field, as
in Figure 6.13. Click on the Options button .

•

llifiil·li--

Click on the State field, then on Options (or press Return: the heavy
border around the Options button means that the Return key will
press this button).
Defi ne Fields for " Per sonnel"
1~ 1!1

N.,...

• 10"

* Fir's t Nvnt

Numbtr

t Lut Namt

h xt

t Strut
City

Tt>et
Ttxt

9 fitlds

Ql!1i2u

Ttxt

*
*• PhonoNumbtr
Z1>

Ttxt
h xt

Name
- Type- - - - - - - - - - - ,

II
j

@TeHt
O Number
O nat e
O llme

XT
XN
XD
XI

0

Pic ture
XP
or Sound
0 Clllculatlon X C
o summllry xs

( renll'

JR Options... )J

LhUIH.JI~ J ( Duplica te J
Delet e

) (

Done
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IIJ Click on Data and type NY (See Figure 6. 14). Click OK, and when you're
back in the dialog box shown in Figure 6.13 , click on Done to return to
Browse mode.
· •

'

Entry options for a field.

Entry Option s for TeHt Field "S tate"
:-· Auto-enter a ualue that is
!.',.:

0

!0

the

··---·,

n:i·:(;·~i.iia'ri···[l~li(i.................-;;.1

.

a serial number:

- uerify that the field ualue i s -

i1 0

i.!

!

I

1

0

n 0 t em p t y
unique

0

1

i
!

an eHisting ualue

!

Ii nincrement
eHt ua I u e
r~~.~. .~. ~.~·=···=·~·~··.~.~~···=. =.]
. I i 0 f type r~ui1)-I)P.·r···l
i
by [";-···································-············-··! i I o from ['·····························-························-················!!
0

l.-~~.~~~J~~. . . . .::.:. ·.: :.:.:. : . :. . : ~:~: :. : . J..l

l. . . . . . .~.~...r:::·::~::.:.::;;;.~:;:::;:.~~:;:::::JJ

!····0·-;·;·~ ·~·;·~ ·;·; ···~·~·~·;·~·;·~·~·;~~·~···~;··~·~~·~·~·~·~·; ·~ ·;·~·~ ···~·~ ·;·~ ·~ ·;··········-······l

I 0 Repeating field with a maHimum of rJ.·············I ualues i
j

0

Use a pre - defined ualue list: ( [tilt

l..l?.. ~.~·~·~· ·~·~-·~·~·~·~·~·~·-~~~.~.-~.-~1·1·~·:· ·-· · J ~.~~

.... ..t...

@J

;j·;~~;~·~;~ ...

)

~ .(~.~~.~-t.I!.~.~.~.~..J. . . . . . ..;

( Can cel )

K

OK

J)

Enter the rest of the records shown in Figure 6. 7. For each new record,
choose New Record from the Edit menu (or type Command-N}. Within
a record , use Tab to move from on e field to t he next, Shift-Tab to
move back.

If you need to move from one existing record to another, click on pages of the
book icon at the top left of the window, or click on and drag the bookmark. Or,
type Command-Tab to move forward or Command-Shift-Tab to move back.

Here's a good place to discuss a major conceptual difference between
databases and the other kinds of programs we've worked with. Since
with a database you mostly enter and manipulate data , rather than
N o T E make many changes in it as you do with word processing, spreadsheets, or graphics, FileMaker saves for you automatically, at short intervals.
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REPORTS
With databases, we do three basic categories of things to data: enter, manipulate,
and report it.
A report is really just another layout, but one that's meant to be printed, or
used on the screen for quick overviews of records.
Since we don't need to put every field in a layout, we can make up a list of
our personnel with, say, just their first names and phone numbers. It's a handy
list for informal use.

OJ Go to Layout mode, and create a new layout (choose New layout from the
Edit menu or type Command-N). Give it the name List and choose
Columnar Report as the type.
• • •ru '>Julf ..~ Starting a report.
New Layout

I

Nam e l ust
r lype
0 Stlmdard
® Columnar report
0 EHtended columnar
0 Singl e page form
0 Labels
0 Enuelope
O Biank

(

Cancel

I

~

OK

~

Make up a list layout containing seven fields, like Figure 6.16. From the field
list in the box on the left:
• • •nr~ilffill

Field order fora Report.
Set Field Order
Field list
10#

First Name
Last Name
Street
City
Stat e
Zip
Phone Number

Field Order

Q ( Clear All

(

M<WO

'

OK

:0 (

Cancel

I
)

• 10#

•
•
•
•

First Name
Last Name
Street
City
State
• Zip

jQ

I •

I

tQ

iii
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[II Click on the field you want to appear first on the list.

We've chosen First
Name. Note that with something selected in the box on the left, the Move
button in the center is now dark.

@J

Click on Move. The First Name field appears in the Field Order box on the right.

0

Repeat this for the other five fields shown in the Field Order box. As a short
cut, you can double-dick on a field name to move it.

0

Click OK to return to Layout mode. Make sure that View as List on the
Select menu is selected-has a check mark beside it. You should see something like Figure 6. 1 7.
· •

Beginning of a list layout. Note the Header, Body, and F.. . (Footer)

boxes at the left of the data area. These are the parts of the layout.

0

Oops. We didn't want to include ID numbers in this layout. Click on the ID#
field and then Shift-dick on its label, to select them both. Press Delete.

UJ Drag each label up to the top of the H eader part of the layout, and put them
closer together, so that they fit on one line, as in Figure 6. 18.

liJ Click toward the bottom of the Header box (at the left of the Header part).
This selects it. Drag it up so it allows only room for the single line of labels.
Also make the Footer box as small as possible.
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Your modified list layout.

IIJ Do the same for the fields, and for the body part of the layout. It should now
look like Figure 6. 18.

II§J Return to Browse mode . Your re cords should show on the screen a s in
Rgure 6 .19.

~

~

!<i!l

~

EJJ

Molly

Jones

122

Ithaca

NV

14860

Kay

Green

25 Seaview Sl

Dryden

NV

13053

David

Harris

705 Court St.

Ithaca

NV

14850

e

Daniel

Green

17 Eddy Sl

Ithaca

NV

14 850
1302 1

Ei!al!ll!a

Ia!!.!!!!!!!.

RteOt'ds :

Unsortf'd

James

Chapin

65 North Sl

Auburn

NV

Lisa

Schmidt

27 Seaview Sl

Dryden

NV

13053

Nancy

MacMillan

43 Lynn Sl

Ithaca

NV

14850

Catherine

H arris

705 Court Sl

Ithaca

NV

14860

E
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If any of the records are cut off at the end (someone's last name only partially
shows, for example), this is because the layout for that field isn't big enough. Go
back to layout mode, and lengthen that field a little.

~

A list is a nice way to display the part of your data you want to use.
Remember that all of the data you entered in each record is still there,
even though ID and phone numbers aren't displayed in this layout.

N 0 T E

See that at the bottom right of the loose-leaf book icon at the top left of the
window, there's the number 1. And, just to the left of the word "Molly" in the first
record, the twin vertical lines are filled in.
You're at this point in record #1, even though you can see all the rest as well.

FINDING BY CRITERIA
A large part of database use is finding information. When we use the telephone
book database, the find criterion we have is generally just a complete name. With
the phone book in an electronic database, it would be just as easy to find all of the
people whose first names are Kay and whose last names begin with a letter
between A and M and who live in a zip code lower than 14000.
Not to mention all of her neighbors in lower than 14000 who drive a late-model
car, like pizza, and go to a movie a week. Demographers and advertisers can't
get enough of this.

[!]
~

~

Choose Find from the Select menu, or type Command-F.
Click in (or Tab to) the second field, and type =green. There is no need to
capitalize.
Click on the Find button at the left of the window, or press Return.
FileMaker shows you the first record it's found , and the number of records
that contain your criteria is displayed below the book icon to the left of the
data, as in Figure 6 .21.
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Ill

The Find dialog box.

:o

Perso nnel

I

lust

B

Fi~N>rre

i !=green

i

s-

lAst Nome

I

i

~

§!;!!!!.

~

f!J:
Q

_~ c::::~:J c:::~:~~:::==~:l

!!

R•qu•sts :
1

Oomit

I!J
Find ll

S~mbols

j(

1oo l... li11111IIEI

Find

0

1¢1

1¢ 121

•Jf'"411 All records in Personnel whose last name is Green.

-o
lust

0

Pe rsonn e l

I

B

Fi~Norre

~

s-

~

s-

~

Kay

Green

25 Seaview St.

Dryden

NY

13053

Daniel

Green

17 Eddy St.

Ithaca

NY

14850

~

Rtcords :
8

Found:
2
Unsorted

1oo l...li11111IIEI

Brown

1¢1

0

1¢ 121
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Since we're in a list layout, with each record on a single line, FileMaker is
able to show us more than one record. Had we been in our original layout
when we went to find the last names of Green, we would see only one record
at a time. We'd then simply scroll through the records.
As info, the equals sign told FileMaker you were looking for an exact match.
If you had not typed the equals sign, you'd have gotten everyone whose last
names contained "green."

This points out that even as nice a program as this one only gives you what
you ask it for. Always take a critical look at what you put in and what you get
out. Garbage in ... garbage out.

0

Choose Find All from the Select menu to get back to your complete list after
finding something.

[I] Find these records:
··All of the people who live in Ithaca.
• All of the people whose first name starts with D.
•All of the people with zip codes lower than 14000. Hint: use the< symbol
from the Symbols submenu you get by clicking on the Symbols icon at the
left. Your find criterion should read <14000.
Finding the first set after the second set doesn 't find a subset of the
first set, or all of the people who live in Ithaca and whose first name
starts with D. To search for multiple criteria, put them in the initial
N o T E search mask. (Figure 6 .20 is a search mask. You could put something
in every field in the mask, and the Find would then be those records that satisfied
every criterion you entered.)

SORTING
The other primary way to manipulate information in a data file is sorting.
FileMaker lets you sort by, for example, last name and then sort by first name. All
of the people whose last name is Smith would then be alphabetized by their first
names, as in the telephone book.
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In database lingo, the telephone book has two levels of sort. Sometimes
more levels are desirable-the redoubtable Macintosh database Double Helix has
32,767 levels of sort.
We won't use that many today, though.

OJ Choose Sort from the Select menu. You'll see a dialog box something like
what you used to move fields into a layout. Here , though, we 're telling
FileMaker which field we want it to sort by.

[I]

Click on Last Name, and then on Move . Last Name appears in the Sort
Order box.

•iJ•HU~•1t'#..t

Last Name selected as the Sort Order. This dialog box defaults to
Ascending order (A to Z); leave that selected.

IE1191ish

Sort Records
Field List
ID#
First Nome
lost No me
Street
City
Stote
Zip
Phone Number

~

@J

*

.....I
_,I Q

[ >M<n•(J >)

n

Sort

[ lln~or t

0

.•1 ®
l1. 0
1.• 0

Sort Order
l ost Nome
[ Cleor Rll )

[

Done

ll
l
l

0
D Include summory fie lds

Ascending order
Descending order
Custom order bosed on field's uolue list

Click on Sort. FileMaker sorts the records as requested.
But note that within the last names, FileMaker didn't change the order of first
names as entered. So the alphabetical sort isn't complete.

8J Again choose Sort, and click Clear All to clear the sort order. Then select
Last Name as the primary key, and First Name as the secondary key-just
select Last Name first, and First Name last, so to speak, as in Figure 6 .23.
Try it now.
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l ;;r •Hfi',.;w_,.

The Sort Order now begins with Last Name (the primary sort key) and
follows with First Name (the secondary key).

IEnglish

Sort Records
Field list
ID#
First Name
Last Nam e
Street
Ci ty
State
Zip
Phone Number

,Q

(Clear

Sort Order
Last Name
First Name

All) *

( >!'-1m• <~ >)

*

...I

••• Q
•••

K Sort n
( Unsort )

lo

(

Done

)

0
0

Include summary fiel ds

•• 1 @Ascendin g order
1•• 0 Descending order
1.1 0 Custom order base d on f ield's ualue list

See how FileMaker has sorted all of the records by last name, and then without changing the order of last names, has sorted the records within each last
name by first name.
This is useful if your records share a lot of data, such as the name
Smith, or residence in a city. Multiple levels are, though, useless when
you're sorting by a unique field, such as an ID number, as the primary
N o r E key. All othe r keys are then meaningless. Similarly, if you're using ID
number as the third key, no succeeding key will have any effect.
Speaking of ID numbers, call up the Sort command again, click Clear All to
clear the Sort Order, double-dick on ID Number in the left box to move it to the
right, and then sort by this criterion. It should work just fine , even though the ID
number field isn't part of this layout.
Why should it have to be? You might want that sort, perhaps if ID number correlated with seniority or department, but you might not want to have your screen or
paper cluttered with the ID numbers themselves. Or ID numbers might also be confidential access codes you don't want to print needlessly. Fairly elegant stuff.
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ADVANCED FEATURES
While what we've looked at so far would suffice for much basic data manipulation, it's at this point that applications like FileMaker take off.
Why limit ourselves to handling data that we've entered, when a good database can produce calculations, updating automatically each time we add a record,
and thereby go a long way towards managing information as well as providing it.
In this section, we'll have FileMaker calculate several fields for us, and make
things easier for us in other fields.

ITJ Go into layout mode, and select layout 1. As with many parameters of the
program, this selection stays in place until you change it.

~ Choose Define from the Select menu. We 're going to add some fields to
your datafile.

~

For some of these fields, we'll provide a list of entry options. Then
when we enter data in these fields, either a list pops up with choices or
FileMaker checks our entry for accuracy.

N 0 T E

These features have two advantages: they save us typing time, and are also
good ways to prevent mistakes.

@J Create a field called Position (of the Text type).
~ Click on Options in the Field Definition dialog box. You used this dialog
box to auto-enter the state when you originally entered data. We now want to
enter a list of possible occupations for our personnel.

@J Click on the option Use a pre-defined value list, as shown in Figure 6.24.
Figure 6.25 pops up automatically.

@J Enter the possible occupations as shown in Figure 6.25. You'll need to press
Return after each entry.
This list pops up when we enter the occupation for each record in Personnel.
It beats typing it every time.
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· ,

~•

Click on ause a predefined value list:" from the Entry Options dialog box.

Entry Options for TeHt Field " Position"

r· Ruto-enter a ualue that is
D the

:... Uerify that the field ualue is ........... 1

iD

..............:;;;:')

i"(:·i·:(~-~i·1'i'(i'ii'''ii~i'i(~

D a serial number:
neHt ualue
[..i... ................................
increment by

!

''

(1:::::::::::::::::::::::::::::::::"::::::::::::::::::.]

not empty

i

D unique Dan eHisting ualue

ID

of type !. N.i1.ii\ ·i)·~~·r · ..:;;;:l

II

, •••.•.••.••..,,._,:_.........................................................................::::::::::::::::::::.{!

D data !

,

l

t ............................. ::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::~..

.

. .

.

........1

!""[j"';~·;·;;·;~·;·;;·;·~ ·;~~-~·;;·;·~·;-;;·~;·~·;·~;·;; ·~;-~: ~;-~;·~·~;·:::·~:·;~~·~;·;·;;·;; ·;~·;~;·;~·~;·~

!

D Repeat ino field with a maHimum of ['}............ ualues
,

~ Use a pre-defined ualue list :

l... ~. ~-~-~-~. .~.~. .~~~-~-~-~. . '.'.~.:. .~. .~i·I·~-:.........

( Edit

~-~·j·~·~·~ ... )

J. . ~.~:. . !~ (.I·(·I·~ \~-~-~.:.:.:.J. . .
t.. ..

..

!

I

( Cancel )

n

..

OK

J]

m

A list of occupations.
Di splay Ualues for " Po sition"

~

Racketeer
Gun Runner
Drug Smuggl er
Heauy
Computer EHpert

to
( Cancel

0

l~

OK

l)

Next, define a field called Annual Salary (of the Number type) , and again go
to the Options dialog box. But instead of a list here, we want to enter a
range within which we know all salaries will fall. That way , we won 't go
putting extra zeros on someone's paycheck. It's our money, and FileMaker's
going to keep it that way.
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Figure 6 .26, a nd type those figures where

shown. Then OK this.
· •

• Annual salary will be between 15000 and 75000.

Entry Option s for Number Field "Rnnual Salar y"

,. . ~:~~e~~·~:.z1.i~i:i ·~~~;:.~.~ i.~···~·l· · · · ··l
1

r·· Uerify that th e field ualue is ··········· 1

...

:

I

l

r-··--··--····-·--·--,1

! 0 a seri al number :
! neHt ualu e
l

!1

i1

I
II

~-:::::::::::::::.:-::::::::::::.-:.:·:.-;::::::.·::::::::.:·:::.j

j increment by ! 1

!

J

,...................~. . . . . . . . . . . . . .. . . . . . . . . . . ..,. . . . . . . . . . . . ..::. . . .,. .. . . . . . .~ I

j 0 data 1
J
L.....................~ .....:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: ....

!0

not empty

'

I 0 unique 0 an eHis ting ualue i
I D f ~ ~·;··;;:·;:·;:;~::·······i
0

i

tl

...··

---

~

from 15000

ll

to 75000

l........ ......................................................................~ ··'

·····0···;~·;·;;·;~·;·~·;·;···;~~·;;·;;·;·~·;·;;·~~~·;·~·~;. ·~;·~:·-~;·~;·~·~;·::·~;·;~·;·~;·;·;:.~-~~~~~·;;·~········· ......]

0
!0
j

!

Rep ea ting field with a maHimum of j J.

j ualues

~-·-··'

Use a pre- defined ualu e lis t : [ f:dit llnlut~s ... )

l....c.?...~.~.~-~...~.~...~~.~ .~.~·~···~~~.~...~...~i·l·~·:· ..·····...~....~.~:..t...~:..(~·(·~·~..t~.~ .:.:.:.

i

I
I

[ Cancel )

J... . . . ...I n

OK

n

~ Define a Marital Status field (text), and make the entry option a pre-defined
value list of two possibilities: M or S.
Now we're going to get a little fancy, and define a field so that FileMaker calculates, on the basis of what it finds elsewhere, what to put into that field.

BEJ Define a field called Benefit Rate.

Make this a calculated field, as shown in

Figure 6.27.
You'll see a dialog box like Figure 6 .28. First, though, let's look at what kind
of calculation we're going to do.
Remember that we have a Marital Status field which, for each record, is going
to be either M or S, per the list. For payroll purposes, we want this new field,
Benefit Rate, to be .3 if the person is married, and .2 if she or he is not.
The equation is:
If (Marital Status="M",.3,.2)
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· ,.,...,. Type "Benefit Rate," then click on Calculation as field type, then

click on Create.
Define Fields for "Personnel"
Name

11

I

Vi~w by cr~ation order

TyP.e
Text
T~xt

T~xt

*Stat~

T~xt

*Zip
* Phone Number
* Position
* Annua 1 Salary
* Marital Status

T~xt

Auto-enter Data

T~xt
T~xt

Value List

Number

Rang~

T~xt

Value List

I

Name Benefit Rate

I 8~:;:: -:~
Date

Tl

T~xt

* Firs t Name
* Last Nam~
* Stre~t
*City

'0

fi~lds

3€D

--~-~;:~:~~ --~;
@ Calcul ation 3€C

I

l....?._~~-~-~- -· · · · · · · ·~--~·-· · · · ··?.. ~.~-~-~-~-~-~- -· · · ·~-~-- · ·'

~

(
(

Create

~ ( Ou1ionL.

[hntHW

) ( Ilupliu~ tt~ )

Il<~l<~1 (~

l(

)

Done

and the commas have special meaning, in relation to the "If" starting the
equation. If FileMaker finds an M or, to put it another way, if this If function
is true, the program returns a value of .3 for the Benefit Rate. If the If function is false, it enters .2 in this calculated field.
We call this an "if ... , then, else" kind of equation. If the proposition is true,
we then get what's after the first comma. Or e lse, we get what's after the
second comma.
Enter this formula this way:

8JJ Scroll through the list of functions on the right side of the Calculation dialog
box until you find:

If (test,result one,result two)

@l Double-click on this, and see that it appears in the box below. It's much better than typing, as it obviates mistakes.

@

Double-click on "test" to select it.
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Tools for making a calculated field.

Options for Field "Benefit Rate"
Operator s

Fields
ID"
First Name
Last Name
Street
City
State
Zip
Phone Number

Benefit Rate =

00 000
0~ G00
C!JO CD00
I0 @J8
CDO
~
b

Hl~ll

:;t;:·

"'
~

and
or

$£

~
:

:£:~:

illlD
0

Functions
Abs (number)
df
Atan (number)
Average (repeating field ''''''
Cos (number)
Hi:H
Count (repeating field) ''''''

Date- (month J day 1 ye-ar) iHlji

~
0

DateToText (date)
Day (date)

I f (Marital Status= "M ", .3, .2)

I

Calculation result is Number

0

.,..1

( Cancel )

Repeating f ield with a maHimum of ['}."............!ua lues
: ................. ;

n

OK

n

~ Double-click on the field Marital Status from the list in the box on the left.
Scroll if you need to. The field name now shows as the test.
The importance of double-clicking on a field in a list rather than typing field
names is that if you typed "Marital Status" and spelled it even a little differently, FileMaker wouldn't know what you wanted to do. Garbage in ....

~ Click just after the words Marital Status in the formula, and then double-click
on the equals sign in the list of operators.

~ Click on the button in the calculator showing double quotation marks. The
quotes land in the calculation box, and your cursor lands between them.

G2J Type a capital M.
~ Drag to select the words "result one," and then go to the calculator. Click on
the decimal point and the numeral 3 . All right, type .3 if you really want to.

~ Similarly, replace "result two" with .2.
~ Click OK when your screen looks like Figure 6.28. You've got the idea.

~ Define the other calculated fields as shown in Figure 6.29 .

II
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Formulas to enter.

Tax Rate

If (Annual Salary < 30000, .15, .28)

Monthly Pay

(1- Tax Rate) * Annual Salary I 12

Benefits

Annual Salary * Benefit Rate I 12

Taxes

Annual Salary * Tax Rate I 12

When your field definitions look like Figure 6.30,
!.JU'

• •

W.l Resulting field definition.

Define Field s for " Pers onn el"
Name

16 fields

I

View by croation order

TyP.e

*Zip
* Phone Number
* Positbn
* Annual Salary
* Marital Status
* Benefit Rate
* Tax Rate
Monthly Pay
Benefits
Taxes

*
*
*

Tex t
Tex t
Tex t
Number
Tex t
Calculation
Calculation
Calculation
Calculation
Calculation

..-1

Value List
Range
Value List
= lf(Marital Status= "M",.3,.2)
= lf(Annual Salary < 30000,.15,.2B)
= ( 1 -Tax Rate) * Annual Salary I 12
= Annual Salary * Benefit Rate I 12
= Annual Salary * Tax Ra te I 12

I

Name
~----------------------------------------------~
,... Jyp e-····································································-···································1
[ n~n h) J [ Op1 ionL. J
0 TeHt
31:T
0 Pictu re
31: P
i 0 Number 31:N
or Sound
!
[ hnn•.J•~ J [ Ilupli< 11 h~ J
i 0 Dat e
31: 0
®Ca lculation 31: C !
0 Time
a& I
0 Summary a& S
Ilel<~1<~ J[ Done
L·-·--·-·----·····-····-········-·-·-···-···-·········----·····-·----·········-···-··i

!

i

!

i

l)

~ Click Done to return to Browse mode. We're almost done with the design of
this datafile, but we need to format a few fields.

~

Go into Layout mode, and click on the Position field. You' ll see handles
appear around it.

~ Choose Field Format ... from the Format menu. You'll see Figure 6.31.
~ Click on Use Field's Value List ... , and click and hold on the boxed words
Pop-up List. You'll see a menu drop.
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Formatting a field that has a value list.
Field Format for " Position"
Dlspl ny Type - - ---------·-·--··- - - - -·····--

0

St nndord fi el d

0

In( lud~ u•~rUtal ~e s·oll bar

®IPop-up list
0

.,..I using

fiel d's uolue list

lnGiude - ouler ... • it em

j

! Repetitions
J

Show

I

II~" ••<lrtl< ol

1
0

•

1•1or fie ld 's I defined rep etitions.
-

... I oricnt ilti<HL

··---

-------------·---------

Selec t entire conten t s or fie l d on en try.
( Cancel J (~)

~ Drag to Pop-up Menu, and release the mouse button. Click OK.
~ Format Marital Status the same way.
~ Select the Monthly Pay field , and choose Number Format ... from the
Format menu.

~ Format this field to display a decimal number, with fixed digits after the decimal point as 2, and to display the notation Currency.

[QQ] Select both the Benefits and Taxes fields (click on one, then Shift-click on the
second), and format them this way too.
Go back to Browse mode, and:

~ Enter the data from Figure 6.32. Click and hold on the pop-up menus to get
the value lists-drag to the one you want, and release the mouse button.
••· IHJ.i:j[•.JlOil.

Updates to records.

ID#

Position

Annual Salary

Marital Status

1382
2120
3855
4996
5033
6280
7407
8761

Your choice
Your choice
Your choice
Your choice
Your choice
Your choice
Your choice
Your choice

40000
35000
30000
35000
15000
35000
20000
75000

s
M
M

s
s
M
s
M
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You'll need to click outside your last entry for the calculations to appear.
After you enter the first record, stop to look at the calculation results. Do they
look accurate?
Until you gain experience knocking off formulas , make sure one doesn't
knock you off first. Spot-checks are most helpful here, as in spreadsheets.

CUSTOM REPORTS
A common and powerful use of databases is to produce any kind of piece of paper
where some of what's printed on it is the same for all copies, and other parts are
specific to one person or event. Examples are pay stubs and form letters. Imagine
sending a form letter to all the advertisers who send you form letters!
Rather than be so esoteric here, though, we'll design a pay stub for our personnel datafile. This is a good example of the flexibility of a database's layout mode.

ITJ Go to Define mode, and create a field called Whole Name. Define it as a calculated field , and specify Calculation Result is Text below the formula
area in the calculation dialog box.

C3J Enter the following formula, made up of the First Name and Last Name fields,
plus the punctuation. Use the mouse as much as you can , choosing from the
field list and the calculator keypad area. Put one space between the quotes:

First Name&" "&last Name
A calculation that returns text may seem strange at first, but look at this.
Whole Name is a calculation of First Name, one space, and Last Name.

If we didn 't have this nicety, we'd have to make the First Name field long
enough in this layout to show longer first names.
This would leave a gap between the first and last names of those with shorter
first names. Anything printed this way would simply look unprofessional.

@J Create another new field and call it City State Zip.
Make the calculation result text here too, and enter this formula:
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City&", "&State&" "&Zip
Again, keep one space between quotes (or after the comma following
"City"). Go back to Browse mode.

GJ Make a new layout. Name it Pay Stub, and choose Blank as the type.
[}] Drag fields from the toolbox onto the layout, as you see in Figure 6.33.
Dragging a field from the toolbox into the blank layout.

~ Scroll to the fields you want, as in Figure 6.34. De-select Create Field
Label, and click OK.

•"'ff• Specifying fields In a layout.
PhOOf' Numbt r
Position
"-MUi1 Sal1r~

M1ritil Status
Btotfit R1tt
TIX R.att
Monthly POll

B•nofits

Taxts

D Create

field labe l

[ Cancel ) ([

OK

J)

WELCOME TO ... THE MACINTOSH: Fr.OM MYSTEP.Y TO MASTEP.Y

[!] Create sufficient space in the

header for a title. Think of something fun .
Make the title and labels with the text tool in the toolbox.

0

Format all text (as opposed to fields) with a different font. Figure 6.35 shows
Palatine. The title shown is 24 point.
· •

The finished pay stub. The Annual Salary, Taxes and Benefits fields
were formatted flush right (with the Text Format ... command), so
numbers would line up. To move any element In the layout with precision, you can select it and use your keyboard's arrow kevs to move
the object one pixel (screen dot) per keystroke.

!!0
lP·~ S11Jb

~

0 !!

Personnel

I

Corney University

~ ~- ___:':'~·:::~~~:~'::.:=;:;,;:-~;---- r.~1· :!~.;'l·
1

1

L•vouts :

lW.hole..N.am.e.........................................................l

. . . ..

6

EIAISJ
O ls.t[e.e.t .......................................................................l
!QIQIQJ !Cltv...stille. Zip.......... ... . ............. ...)
(EjrJL....- ... 1

Taxes withheld:

I. . . .Aonu.e.l...S.e.l.e.cij
I
Tau~

Benefits:

1..

Annual Salary:

0--~~~·

~~l•lbliil

• ..9l•lbli l

!Monttlly..P..e.y._.)

.fl.eneill~

EB~I-1~
1 00J~flllll[l:l

E3)

L•~oul

[}] Check to see that all currency fields are formatted as such, with two digits
past the decimal point.
For more complicated forms , you can certainly use the same field more than
once in a layout.

SCRIPTS
FileMaker, like Excel, has a built-in language to automate repetitive tasks, and
assiduous use of such features is one mark of the accomplished computer
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user. So let's look at FileMaker's implementation of macros, which this program calls scripts .
These are less complex than what you learned with Excel. Each script in
FileMaker does a small, predefined action, which can save time , or facilitate
another user's work, or both. Scripts can be combined with other scripts. Let's
make a couple.
First, by way of setup:

DJ Do an alphabetical sort, with last name as the primary key, and first name as
the secondary. Then go to the list layout. OK, we're set.

[I]

Choose ScriptMaker from the Scripts menu. You'll get a dialog box like
Figure 6.36 , showing what scripts were already made for this document, if
there were any, and your cursor will be in a title box, ready for you to name
the script.

Define Scripts for "Personnel"

r di1 ...

0

~------------------------------------~

Script Name:

18] 1nclude in menu

( Ilupliu~ t!~ )
( Uele1 <~ )

n
@J Type Alpha List for the name of the script, and press Create.

Done

J)
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You'll get a dialog box like Figure 6.37 , showing you script functions available. File Maker has suggested, in the box on the right, several of the functions available from the box on the left. We want to keep most of these , but
we don't want this set of automatic steps to include printing the llst, so:

., . ..

Options for a script. The commands checked will be performed every
time you run the script.

Script Definition for "Alpha List"
Availabl• St•ps
P•rform Script [...]
Paus•/Res um• Scr ipt

H

0

I"'"....................................................................... h
Go
Go
Go
Go

to Layout (... ]
''''"
to R•cord/R•qu•st (... ]
''''''
to N•xt R•cord/R•qu•st (... ] :m:!
to Pr•vious R•cord/R•qu•st i!m!

Go to Field (... }

:::::~

Go to N•xl Fi•ld
Go to Previous Field

:mH

Alpha List N

** Go
Ent•r Browse Mode .1!
to Layout IN List N]
t
t
t
t

Page Setup (R•store, No dialog]
Find All
Sort IR•s tore, No dialog]
Pr int( ]

li!l!!

0

Click on Print [) to select it, and click Clear at the bottom of the window.

[TI Click OK, and then click Done to return to the file.
-'

As further setup:

[I] Sort by ID number, and switch to the Pay Stub layout.
[I] Make another script, and name it Payroll. Again, clear the

print command.

OK and be Done with this.

~ Pull down the Scripts menu, and note that you have two new menu comma nds: Alpha List with Command- 1 n ext to it , and Payroll with
Command-2.

CHAPTER

6

0ATAI3ASES

[!QJ Choose each command, and see how you can select either layout and at the
same time sort your data with the sort order most useful for that layout.
This works for about anything that FileMaker can do. You can also make life easier by first making small script modules, and then chaining or nesting different
ones as you need them.
Scripting is especially handy for a data file , since computer documents like
this are more likely to serve multiple users than an average SuperPaint graphic,
Word letter, or even most spreadsheets.
It's also most often the case with databases that the user may be unfamiliar
with most computer operations. Their work may require them to sit down at a
computer only occasionally and pull certain information out of the data file.
It's just this sort of scripting automation that could allow the instructions for
the occasional user to read something like : 1. Double-click on "Client File "
icon. 2. Choose "New Clients " script. 3. Get list off printer.
You might have done that by having FileMaker take today's date from the
Mac's clock and subtract from that the date the client was signed up. Your script
does a find in that calculated field for all records with values less than 30, sorts by
zip code and then name, goes to a list layout and prints it.
Your office mates would think you're pretty good on a computer. Then
again, you are. Once more you've learned a major program in a chapter. This
has been a productive effort because, on odds, a database of some sort may be
the computer application you use most in college or business in almost any area.
It's not just having information or using it in the form in which you got it-it's
managing it. In the information age, this is good stuff to know.

CHECKLIST
Your tour through a computer database has taught you:
• how to use records, fields and layouts,
• automated or regulated data entry,
• finding and sorting by criteria,
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• calculated fields with if-then statements, and
• custom reporting.
all of which offer insight into an area of major power for the personal computer.
It's literally true that what sits on a desk today can do what needed a mainframe
ten years ago, and an army of clerks ten years before that.
In our exercise, we only hinted at the value this kind of program has for data
in large quantities. Why not keep employee records for your company of 50,000
this way? It's fast and accurate. Make lots of backups, though.

OTHER CHOICES
FileMaker is an easy and elegant tool for these uses. Its major competition is
Panorama, a similar product except that it's built for speed. It accomplishes this
by keeping all records in RAM instead of on disk, as FileMaker does. The tradeoff
is that, for most PC systems, RAM is more limited than disk space, limiting with it
the number of records you can have in one file.
Both FileMaker and Panorama are called flat-fil e managers : you have all
fields for one record in one file . Imagine a more complex program, with which
you could have two different files on employees, for example: one file would have
fields containing non-sensitive information, the other might have employment
and salary history.
Access to the second would be limited but, when used , the program could
relate one file to the other, and any two fields , each from one file , could be
viewed, or made part of calculations, as though they were fields in one file .
Such a relational database is more complex in use but can offer great power.
Look at Double Helix, Helix Express, Fourth Dimension, Omnis, or Foxbase as a
next step in exploring information management on the Macintosh.

HELPFUL HINTS
As with many kinds of programs, finding a project to learn FileMaker on is especially helpful. And especially easy, since there's a use for a database almost
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everywhere you look. No organization these days can live very effectively without one.
When you have a chance, you might want to explore mail merge (also called
print merge), in which a database and word processor work together. You can
customize 100 letters to clients or friends with data from FileMaker, to look like
each letter was an individual effort. Two programs working together this way add
an order of magnitude to the flexibility and power now available to you.

Q&A
Q: I seem to get lost in FileMaker.

A: Unlike many other programs , FileMaker (and databases in general) are
modal in design. When you're in one mode, such as Layout, you can't perform some functions without switching modes first.

Q : I'm in Browse mode, in a list layout, and can only see a few of
my records.

A: You performed a Find, and now can see only what matched your criteria.
Choose Find All to see all your records again.
Q : It's difficult to position fields and their labels precisely in a
layout.
A: The invisible grid that makes objects jump from point to point as you drag
them is most often a help, but gets in the way of fine positioning. The best
solution is to drag objects to approximately where you want them, and then
use the Arrow keys on your keyboard to move, one pixel per keystroke, the
objects into place.
Q: How do I save in FileMaker?

A: The program saves for you, either after there's been no input for a minute or
two, or after a specified number of minutes. You can set this in the Preferences
dialog box, but the default-save on idle-is fine for most purposes.
Q: I think I've lost some data.

A: This is hard to do in FileMaker. You may have had a system or hardware
malfunction or, more likely, your data is still there but just hidden in one of
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several ways. Review this chapter's discussion of different modes, change layouts, and use the Find All command.
Q: My calculated fields don 't work.
A: You have to specify exactly what you want FileMaker to calculate. For example, placement of commas and quotation marks are important in If functions.
In general, try to click or double-click on as much as you can in the Options
dialog box, rather than typing formulas. As a special note, make sure that if
you want the calculation result to be text, that you so specify it.
Q : I was working with a datafile when my computer crashed, and

now I can 't open the file.
A: FileMaker has a nice Recover feature, on the File menu, to dig data out of a

corrupted file. Follow its instructions carefully, and you should be able to
recover records, especially, which are most often more important to recover
than are layouts. With this as with any program, though, the importance of
backing up data can't be emphasized enough.
Q : I'm in a layout like the Pay Stub in this chapter, and want to

edit some field names.

A: You can't do this in layout mode. You can edit labels or miscellaneous text,
but you'll need to go to field mode to change field names.
Q: My script doesn't do what I programmed it to do.
A: Until you really get the hang of scripting, it's best to keep them short, test
them first , and then build larger scripts from these smaller ones. It's a powerful and versatile tool, so don't give up easily.

SAMPLE EXERCISE
Take some data you already have-from work, a club or a hobby, anything that's
intrinsically interesting-and put it in a datafile. Try to separate data into as small
chunks as possible. For your CD collection, for example, be sure to put artist and
title into different fields. Sort, find, and print your data. You may well find collections more useful, because you now have access to what's in them that you didn't
have before.

(HAPTE~
CONCEPTUAL
NAVIGATION
AND HYPEf\CAf\0
In this chapter, you'll learn about a program that supports a different kind of
thinking and expression, valuable for planning , presentation and education.
You'll be able to:
• make a HyperCard stack
• add buttons and link them to stacks and cards
• work in HyperCard's background layer
• work with text in fields and add graphics
• use HyperCard's scripting language for impressive special effects
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This is the point in this book where we do something really new. What we've
done up to now has of course been using new tools, but our results have been
similar to what we produced before computers.
SuperPaint, for example, gives you a lo t of both options and fun when you
paint. But you're still working with the equivalent, high-powered though it is, of a
paintbrush or drafting tools. Word processing, with all of its spell-checking and
fonts, is placing Roman letters and Arabic numbers on the equivalent of a sheet
of paper. You may never go back to a file cabinet after using FileMaker, but the
analogy still applies.
What we're going to look at now is not another new and improved tool for
an existing idea, but a new idea itself or, more precisely, a radica l conceptua l
innovation.
There are two points of interest in a radical innovation: first, no one can predict its appearance and second, it's hard to recognize it for what it is. Invention of
the airplane and submarine, for example , were not radical innovations, and so
many people, Jules Verne among them, were able to predict their appearance.
The airplane a nd submarine were new things or tools , but not new ideas,
because people had watched birds fly and fish swim for some years prior to figuring out how to do mechanically what these animals did naturally.
The wheel, by great contrast, was a radical conceptual innovation. No one
could have predicted its invention, as the philosopher Karl Popper points out ,
because to do so would be to invent it. No one could have thought of what the
wheel did and how, and described it, without thereby inventing it. Such is the
nature of a new idea.
The second thing about new ideas is that their value is so hard to recognize. One great story concerns the inventor of the Xerox machine-granted ,
not a radically new idea , but new enough. Ask your stockbroker if she wishes
she had bo ught Xerox stock at its initial public offering , or if she actually
prefers going to work every day. Then tell her that the original Xerox machine
was built in the inventor's bathtub, because he couldn 't get funding to develop
it properly.
Why not? Because no o ne saw the value of it. The inventor, so the story
goes, was a draftsman in a patent office who got tired of reproducing drawings all
day. He came up with his idea and went to his company for development funds.
His boss said, "Why do I need this machine? That's what I pay you for."
What we're going to look at is a radically new idea in software-and its value
may be ha rd to appreciate at first. The concept was described in 1946 by
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Vannevar Bush, and the software was developed by Bill Atkinson, one of the
Mac's most creative designers, and released in 1987. Not bad.
What it does is mimic how we think, or can think. Ever leave your house
thinking about one thing, and arrive at work or class thinking about something
entirely different, and wonder how your thoughts managed to take such a complex path? We think in association , or by linking, and many educational
researchers consider that creativity is in large part the ability to make more links,
and less direct ones. The very process of finding meaning in something is often
just linking it to other things.
But the best links are often the hardest to see. Dreams and other symbolic modes
of thought sometimes help. The discoverer of the benzene ring could not figure out
the molecule's structure, until he had a dream one night of a snake biting its tail.
Conscious thought is not that much different. Brainstorming, a large part of
which is random association, is a good example. And psychologists know the
value of free association.
The great epistemologist Gilbert Ryle, one of the first to figure out what mind
really is, thought that this associating or linking couldn't take the linear path we
suppose it does. He wrote that once Euclid had his theory, he could explain it logically, step-by-step. But the steps he took before he had it were, Ryle said, closer
to a "wrestling and wriggling" of thought-explosions of associations, so to speak.
HyperCard is simply a way to make links. Of course, we did that with Excel
and FileMaker, but those were highly structured links , while HyperCard is as
unstructured and flexible as you can be. Hypertext, the concept, is no more and
no less than the idea that anything can link to anything. HyperCard, the program, is a tool to do this.

Its metaphor is stacks of cards. Each card can have graphics on it, or text or
both. HyperCard has painting and writing tools to make the content of a card
nearly anything you want.
These cards can have buttons on them, much like buttons in dialog boxes,
but this time you choose what a button does when you click it. You can produce
animation and sounds, and you can give the user choices: click one button or
another to run right or left, literally or figuratively, in a maze or a learning program that you can design and build yourself.
The point is subtle. Every choice , every idea, has a result-the user can
explore something at her own pace and in accord with her own interest.
Hopefully someday more education , whether in school or business training, will
work this way.

II
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THE BASICS
When you start most programs by double-clicking on the program icon (rather
than a document icon), you 're given a new work area. FileMaker asks you to
open an existing database, or structure a new one.
HyperCard's a little different. Every time you double-click on the program
icon, you go to a 'home base' of sorts called the Home card. This starting point
facilitates your moving around to other cards in one stack or several stacks.
The Home card is part of the Home stack. Every card is in one stack or
another.
The Home Stack.

Hom€'
You move around in HyperCard primarily by clicking buttons, and the Home
card has several, each for a different card or stack. One button might take you to
a game, another to a tutorial, a third to an address book.
You can navigate with menu commands as well. They're on the Go menu. Two
you'll use often are Home, which takes you to the Home card, and Recent, which
shows you miniature views of the forty-two most recent cards you've been on.
To start, while you're still in the Finder:

OJ Make a copy on your floppy of the Home stack that comes with HyperCard.
You'll be making changes to the Home card as we go, so best not to change
the original.

[I] Double-click on your Home stack. This takes you to the Home card in that stack.
At this point, you have access to several other stacks, through the buttons for
them on the Home card.
Note that your cursor has changed from an arrow to a pointing hand. This
indicates that you're in Browse mode. Like FileMaker, HyperCard 's Browse
mode is where we look at things.
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HyperCard's Home card. Each icon, such as those for the Tour or Help,
is a button. Click on that button to go to a separate stack of cards.

Home

Welcome to HyperCard

~

HyporCord Tour

® 1987-1991 Apple Computer, Inc.
All Rights Reserved.
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Art Bits

HyperCard's Hand cursor. Click on icons (buttons) with this.

Let's take a quick look at the HyperCard Tour stack, the one at the top left of
the group.

OJ Click once with your Hand cursor on the HyperCard Tour button.
Depending on your computer's setup, you may get a standard open dialog
box, asking you where this stack is.
You'll then get a nice introductory screen, and the instruction to click your
mouse anywhere to begin.

[II

Click your mouse, and you go to the next card, with a text introduction. It just
seems to be a change in display.

WELCOME TO .. .THE MACINTOSH: FROM MYSTERY TO MASTERY

@J

Click again, and the two buttons (which, this time, look like buttons) give you
the choice between Looking at or Working with HyperCard.
Time out. Note that the program is giving you a choice of ideas. Not much of
one in this case, but the concept is important.

0

Click on the S ection 1 : Looking at HyperCard button.
The next and succeeding cards have an arrow or two at the bottom right.
Click on the Next arrow for the next several cards, to follow the analogy of a
rolodex file.
Note, though, what happens when you get to the card demonstrating how the
cards can go in a stack. Animation is a HyperCard specialty, and very easy to do.

liJ Continue with the tour, for a succinct overview of what it's like to browse
through an interesting, interactive stack.
Make sure you understand what the Go menu does. Especially, test going to Home,
and then back to where you were. Choose Recent to see thumbnails (miniature
views) of the path you've taken. Click on a thumbnail to go to that card.

MAKING STACKS
This book takes up where the tour leaves off. In our exercise, we'll make new
stacks, add text, graphics, and buttons, and make those buttons do things.
Since we first need to give ourselves permission to do all of this neat stuff:

ITJ Choose Home from the Go menu to go back to your Home card.
[I] Press the Left Arro w

key on your keyboard. You should see a card like

Figure 7.4.
The levels 1 through 5 are access privileges to the program. As the capsule
descriptions show, each higher number lets you make more changes to stack
components. Let's do this right:

@J Set your user level to 5

0

by clicking on it.

Press the Right Arrow on the keyboard to go back to the Home card.
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a

The Preferences card in the Home stack. Here you control the extent
of changes you can make to cards, buttons, and other parts of
HyperCard stacks.

Home
Other settings:

0

BlndT)'I)r>CJ

0 Po..,, Keys

Note that while on the Preferences card, we were in the Home stack, not the
Home card. Hereafter when we say Home, we'll mean the card.
Speaking of stacks, though , let's create one. We do this in just the same way
as creating a new document in any Mac program:

QJ

Choose New S ta ck ... from the File menu (not New Card from the Edit
menu). You'll get:
The New Stack dialog box. Although all cards in one stack must be
the same size, you can set any size. For now, leaue card size at
Standard. Uncheck Copy current background, and check Open stack
in new window.

Ijg) M~ Flopp~ Disk • I

g•

D~"·~~
~
[ De•ktop ]

0
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IOuperPol nt
0

I Cord size: jsto nd ord I

I
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This stack will be a small paint program, using HyperCard's graphics tools.
So navigate to your floppy, choose a name you like ("OuperPaint" isn't too
bad), set other options to match Figure 7 .5, and click New.
Your new stack now has one card , and it's blank.

~ Click on the Tools menu. You'll see the palette shown in Figure 7.6 .
HyperCard's tear-off tool palette. The three major modes are accessed
by the tools at the top; Icons below the dotted line are paint tools.
Button

Field

Paint

You 'll see also that the top left icon , the Hand tool (or the Browse tool) , is
selected. We'll get to the Button and Field tools in a little bit.
For now, note an interesting thing about this menu: You can tear it off the
menu bar, and put it anywhere on the screen. To do this:

liJ Click and hold on the Tools menu.
~ Drag your mouse away from the menu bar. Note the dotted line following
your mouse.

@J Release the mouse anywhere on the screen.
stay open, as in Figure 7 .6. Elegant.

HyperCard's tool palette should
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Put the Tools palette in the painting window and, while watching the menu
bar, click on any paint tool. See how menus are added to the bar, to reflect
the paint mode.

IIJ Tear off the Patterns palette, in the same way. Your card, while blank, should
resemble Figure 7. 7.
Your new stack, with paint and pattern palettes torn off and placed
within the drawing window.

You can now go ahead and paint something. Note the many choices in the Paint
and Options menus. Also, try double-clicking on some of the paint tools, to
access other options. Double-clicking on the Hexagon tool, for example, lets you
change the number of sides of objects this tool paints.
Should you for some reason be interested, the object in Figure 7. 7 was created in one mouse drag with the hexagon tool, and Draw Multiple selected
from the Options menu.
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BUITONS AND THINGS
Now that we have a neat little painting program (actually, one with some impressive features), let's go back to the Home card, and make a button that goes to
this stack, just like the HyperCard Tour button went to the Tour stack.

lJJ Go Home , either by the Go menu, or by pressing Command-H.
Let's see what's behind one of these buttons. We do this by holding down the
Command and Option keys while clicking on a button.

0

Hold down the Command and Option keys, and click on the HyperCard
Tour button. You'll see something like this:

on mouseUp
go to stack "HyperCard Tour''
end mouseUp
with perhaps some more added, depending on your exact version of things.
But what's important to us is these three lines. They 're s imply a set of
instructions beginning with "on mouseUp"-that is, when you release your
mouse button after clicking on the Tour icon.
The next line, in plain English, tells HyperCard to go to the Tour stack. The third
line tells HyperCard that it shouldn't do anything else as a part of this mouseUp
sequence.

n

~

This is a script . It's a set of instructions to HyperCard written in
English, but with some conventions, telling it what to do.

N 0 T E

All of the animation, sounds, and special effects that you found when you took
the tour were done with scripts. It's easy with a little practice, and lots of fun.
In fact, we'll have HyperCard write our first script for us. But first, to make a
button:

lJJ Click on the Button tool.
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See how the appearance of your Home card has changed. There's now a
solid line around each button, as in Figure 7 .8.

liJ Choose New Button from the Objects menu. You'll see a moving dotted
line (a marquee) around the new button in the center of the card.

A new button appears In the center of the card when you choose this

command from the Objects menu, with the button tool selected.

Home

Welcome to HyperCard

HyperCard Tour

4

HyperCa rd Help

Appointments

Addresses

Puzzle

~

~

Practic~

!D1987-1991 Apple Computer, Inc .
,....-----.1111 Rights Reserved .

New Futures

L-T-~_r_~--~;_t~ 1'W.. ~J !.!.
1

1

*

@J Click on your new button, and drag it off to the right, where there's blank
space on the card.
Remember that in FileMaker and in SuperPaint's draw mode, you could
reshape a rectangle by clicking on a comer handle and dragging.
It's the same thing here, except that there aren't handles on the comers of
the button's rectangle. Reshape using the right lower comer.

8J Reshape your new button until it's about the same size as the buttons to its
left.
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Hmm. It still doesn't look as nice . So make sure your button is still selected (a
marquee around it), come up to the Objects menu, and:
[}] Choose Button Info.... You'll see Figure 7.9:

.,

The Button Info dialog box. Your Card button number and ID wlll
probably be different from the lllustratlon.

I

I

Button Nome: Ouper1'olnl
Cord button number. 13
Cord button 10: 282
Styl e:
® Tronsporenl
0 Opoque
0 Reclongl e
0 Shodow
0 Round Reel
0 Check DoH
0 Rodlo Button

(81 Show Nome
(81 Ruto Hlllte

( Icon... )
( Effect ... )
( LlnkTo... )

~

( script ... )

~(

OK

Concel )

~ Type DuperPaint for the name, and leave Show Name selected. Also select
Auto Hilite. For Style, choose Transparent.

I1J Click on the Icon ... button at the left of the dialog box. You'll get Figure
7.10. Choose the one shown as selected, and click OK.
...,.~,. 1

Icons to choose for your button. Click on the one shown as selected.
I con 10: 26884 " Art ldeos· from " HyperCard "

ffi fi ~ ~ ~ ~ [I•
@JJ
~ ~ ~ ~ ~
.

~

¢

Q

~

~

-<>
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~
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Q

~
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Edit...
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)

I

OK
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Cancel
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You're back to your Home card , with a shimmering marquee around the
DuperPaint button. Double-click on it to get Figure 7.9 back.

@J Next, click on the Effect ... button, and choose Iris Open. Click on Slow,
and then click OK. This is going to look nice.
Now that it's going to look nice, we want to make it do something. Remember
that when we looked at the script for the HyperCard Tour button, we saw it contained instructions to go to another stack.

LINKING
In the trade, we say the button is linked to that stack. We want to link our new
DuperPaint button to the stack of that name. Go back to the Button Info dialog box, and:

OJ Click on the Link to ... button. You'll get the Link to: dialog box, which
HyperCard calls a windoid.

••

HyperCard's windoid
dialog. This will float
above everything else
until you open the stack
you want to link to.

Linlc to:
( This Carll J ( This Stacie J ( Cancel

J

It just asks you which card, or stack, you want to link your button to. It floats
above all other windows until you use it. So, without clicking on any of its
buttons, let's open your DuperPaint stack.

0

Choose Open Stack ... from the File menu, and navigate to DuperPaint.
With that stack open:

@J Click on the windoid's This Stack button.
Bingo. You've just linked your button to a stack.

0

Go Home, and click on the Browse (Hand) tool in the Tools menu. Back in
Browse mode:
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0

Click on your new button to verify that it takes you to DuperPaint. Pretty
slick, especially with the Iris Open effect. Go Home again, and hold down on
the Command and Option keys and click the button, to see the script
HyperCard wrote for you.

It doesn 't tear off the Tools and Patterns palettes for you, yet. We'll figure that
out in a bit.
Stop for a moment to think about what you've done. In the Tour stack, much of
the fancy effects you saw were done by linking buttons to cards. Now you know how.

PUTIING

IT TOGETHER

Let's make a complete stack, with graphics and buttons. We'll also include text, in
a mode HyperCard calls Fie lds. The example given is a simple book to teach
children the alphabet. Don't worry, it's easy.
To make it even easier, we'll put some of the objects in the background. This
HyperCard feature lets you add graphics or buttons o r things to a stack so that
they are the same on every card.
As you saw in the tour, every card in HyperCard can have two layers: the
Card layer and the Background layer. Both layers can have graphics, buttons
and text. You switch between the two by choosing Background from the Edit
menu, or pressing Command-B.

Background elements will show on euery card that uses that backThis could be euery card In the stack, or part of the stack.

ground.
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Take a moment to go through stacks available to you, to find a background
you like. Our example is called "My Book, " and we'll show an open book background, but any kind of decoration or border you want will work.
When you find something you like:
A typical background for a HyperCard stack.

OJ Choose New Stack from the File menu, locate it on your floppy disk, and
name it My Book.
Be sure that Copy Current Background is checked.
You'll get a display similar to this:
First, be sure that you're in the card layer, not the background layer. You do
that by looking at the menu bar. If the whole menu bar is bounded by slash
marks, you're in the background. Select the Background command from
the Edit menu, so as to uncheck it, and return to the card layer.

••

~~ ~

The Menu bar In
Background mode.
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#"
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#'

#'#.,##,#I

File

Edit
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We're now on the first card of our new stack. Let's start with a title.

mChoose the Text tool from the tool palette. (This is the large letter A.)
@J Pick a font and size you like from the Text Style ... command on the Edit
menu. Note that the dialog box is labeled Paint Text Style.

8J Put your cursor on the right page, if you have a book background, or in the
center of another decorative display.

I}] Type a title for your stack.

Perhaps "My Book, " but you can use something
else if you want to. Add your name and maybe the date.

What you've just typed was paint text. Just like the paint mode of
SuperPaint, this kind of text is real text when you type it, but once you
do something else, this text becomes 'fixed ' just as though it were
N o r E paint on canvas. You can select it and move it or erase it, but you
can't edit it as text.
We're going to enter the rest of the text in this stack in another way, so that
you can edit it as text-or search for a string, much like in a word processor.
We do this using HyperCard's Field mode .
Just like buttons or graphics, you can put text fields either on a card or the
background. Let's put some fields in the background, so they're immediately
available on every card we make.

mChoose Background from the menu bar. The slash marks around the Edit
menu bar confirm your choice.

llJ Select the Field tool from the tools palette.
[I]

Choose New Field from the Options menu.
A new field is displayed in the center of the window, just as your new button was.

~ Click on the lower right hand corner of the field, and reshape and resize it
until it's a square, about 0. 75-inch on a side.

[!Q]

Move the field to the center top of the left page, or the equivalent in another
background.

[!] Make two more fields, and size and position them so all three are as shown in
Figure 7.16. Leave a little room at the bottom of the left page.
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We've just created a new field. The dotted line shimmers, indicating
It's selected. Button creation worked this same way.

, .....................
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·......................

•
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• We've made, resized and positioned three fields. This was done In the
Background mode. The procedure for putting a field on a card
instead of the background would be just the same.
My Book
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Next, let's format the type style and size of each field.

@J Click on the top field to select it, and choose Field Info ... from the Options
menu.

~ Click on the Transparent radio button in the Field Info ... dialog box. Then
click on the Font button, and make this top field 24 point, with your choice
of font.

~ Make the middle field transparent and 18 point, and the bottom field transparent and 12 point.

8] Select the Background command on the Edit menu again , to come back to
the card layer. Your title should reappear. Then choose the Browse tool from
the tool palette.
Note that your fields have become transparent. Move the Hand icon over the
fields, and see how it changes to a text (I-beam) cursor, ready for text entry.

ADDING GRAPHICS
Now for some content to the stack. What we want on the right pages of our book
are graphics starting with successive letters of the alphabet.

ITJ Choose New Card from the Edit menu.
Now, let's take a tour through what graphics are available to you, or you can
paint your own with HyperCard's tools. Probably the easiest place to get
graphics is from the Art Bits stack that comes with HyperCard.
Access this stack by going Home-there's a button for Art Bits. To return to
your stack, you can use the Recent option. Or, make a button on your Home
card that links to your new stack.

If you're looking through Art Bits, HyperCard's Find command is a big help.
Rather than go card-by-card:

[I] Choose Find

from the Edit menu. Then just type what you're looking for;
the cursor is already between the quotes. Then press Return. Press Return
again to find further instances of what you specified.
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@J Find a graphic whose name starts with A. We've chosen Aardvark from the
Art Bits stack.

8J Using HyperCard 's Lasso tool, select your first graphic, and copy it. (Don't
cut it.)

[I]

Go back to your stack.

0

Paste the graphic. With it still selected, move your mouse over it, until the icon
changes to an arrow, and drag the graphic over to the right page or area.

ITJ Go back to Browse mode, and enter something in the text fields equivalent to
Figure 7. 17.
The first Inside page of My Book.

A
Aardvark
An aardvark Is a burrowing,
nocturnal African mammal that
reeds on ants and termites. It has a
long head ending in a round
pig·llke snout.
It's pretty gross. or course, It
thinks we are, too.

'' " ":1.

...
,jJ

. j•
,,
. ..,,

""

You need locate only the top field with your mouse. Then you can tab from
field to field.

[I]

Make a new card, and repeat this for the letter B.
Let's leave the alphabet for the moment, and get fancy. We'll want an index
for our book, one which, in HyperCard 's inimitable fashion , lets us go to
what we find in the index just by clicking on it.
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[II Make another card, and enter text in the second and third fields,

as you see

in Figure 7 .18.
We've put the Index button In the background. Alphabet letters are
on the card layer. We've made transparent buttons around the first
three letters.

Index
Click on a letter of the alphabet to
see something starting with that
letter.

~

J

s

K

T

L

u

v
w

F

M
N
0

X

G

p

y

H

Q

z

D

E

R

(

lndeH

)

!!QJ List the letters of the alphabet on the right-hand page, using the Paint Text
tool. The example was done in 18 point Helvetica.

I!:!J Switch to the Background layer, and we'll make the Index button.
~ Select the Button tool and choose New Button. Drag it to where you see
the Index button in the example.

~ Choose Button Info ... (or, as a shortcut, double-click on the button), name
the button, and press Link to ....

~ Press the This Card button on the link windoid.
HyperCard understands that it's the present (Index) card you want to link to,
even though you're presently in the Background layer.
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Let's add buttons to letters of the alphabet on the Index card. Go to the card
layer, and:

~ Make a transparent button over the letter A. Make it transparent, and tum off
the Show Name attribute. Don't link it just yet.
Now for one of HyperCard 's great shortcuts:

~ Hold down the Shift and Option keys, and drag this button so that it covers
the letter B. You've just copied a button. The copy has its own attributes,
though, so it has a separate link.

[!2]

Link the Index buttons for the letters A and B to their respective cards. Go
back to Browse mode and see that these work. Then check the scripts for
these buttons, to see how HyperCard has done them for you. Most often,
you don't need to keep track of card ID numbers-just show HyperCard the
card you want to link to.

SCRIPTING
Writing your own scripts is the gateway to the real power of HyperCard , called
Hype rtalk . A quick example of this: why have the Index button on the Index
card? When the user of your stack is on the Index card, she's not likely to want to
press that button.
Let's put a script in the Index card to make the Index button invisible when
the user is on that card. So go to the Index, and:

OJ Choose Card Info... from the Objects menu, and then click the Script button.
[I] Type this script in the script window. As with any respectable programming
language, HyperCard indents the appropriate lines automatically, if you don't
make a typing mistake (lack of proper indentation is a good check for typos):

on OpenCard
Hide bkgnd button "Index"
end OpenCard
on CloseCard
Show bkgnd button "Index"
end CloseCard
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@J

Close the script window by clicking on the close box, and OK changes. Test
your script by going to another card (the Index button should be showing) and
then returning to the Index card (the button should be hidden).

0

Add this same script to your title card.

To complete a competent and elegant stack, we need add only two things: a button to take the user Home, and buttons to go forward and backward. All in the
background.
Do the button for Home in the usual way. Choose a Home icon from the
several available in HyperCard's icon library. Then add buttons for forward and
back. The icons are in the library. We'll script what they do.
For the button to go to the next card, call up the script window, and you'll
see that "on mouseUp" and "end mouseUp" are already there, with a blank line
in between.

OJ Add the line go next card in that blank line. In like fashion:

!2J Add the line go preu card to the script for that button.
When finished, your stack should have background buttons something like Figure
7 .19. Place the buttons as you wish, but remember the user's convenience, and
A complete set of background buttons.

B
Bird
This big bird Is called a storK.
StorKs usually bring trouble.
among other things.

l ndeH
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put the forward and back buttons close to each other. The Home button, by convention, goes in a comer.
Your stack is now looking pretty elegant, and the only thing left to do is, so
to speak, pack it for shipping . As you've worked, the file has grown in size on
disk, and some of the file space is actually free. HyperCard lets you get rid of the
unused space by compacting a stack. Let's do this.
Check Stack Info under the Objects menu to see how much empty space there
is in your stack. Then choose the Compact Stack option under the File menu.

ADVANCED SCRIPTING
When you created the DuperPaint stack, you got a nice painting program, except
that each time you open it you have to tear off the tools and patterns palettes,
and place them in the painting window, to look like SuperPaint.
Why not have HyperCard do that for you, each time you open DuperPaint?
Here's how.
Open DuperPaint, and choose Stack Info ... from the Objects menu, and
click the Script button. Add this script:

on openStack
show window ''tools" at 0,10
show window "patterns" at 0,155
set visible of window ''tools" to true
set visible of window "patterns" to true
end openStack
on closeStack
set visible of window ''tools" to false
set visible of window "patterns" to false
end closeStack
While there are commands here that are new to you, note that everything's in
English. The coordinates, such as "0 ,10" for the Tools window, are horizontal
and vertical measures of pixels, and the rest is how Hypertalk does things. A look
at a few scripts makes this easy and intuitive.
And this script, all ten lines of it, has given you a relatively full-featured painting
program, one that you can distribute to all of your friends who have HyperCard.
They'll think you know what's going on with a computer. Of course, they're right.
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CHECKLIST
Since HyperCard 's such a creative tool, it's harder to provide a list of features
familiarity with which describes competence with the program. A good stack,
though, makes use of:
• a free-form paint environment,
• buttons, with icons and links,
• the card and background layers,
• fields and text formatting , and
• scripting, for elegance and much greater functionality.

HELPFUL HINTS
Apple's introduction of HyperCard brought a profound change to the Macintosh
environment. Previously, there were two kinds of people in the Mac world: programmers and users. Programmers had highly specialized skills, and the rest of us
could only use what they provided.
HyperCard and its easy-to-learn scripting made every Mac user a potential
programmer. There's lots of power in this program, as you'll see by exploring a
few stacks, and there are several thousand to choose from. Many are free, available from users' groups. What you can put in a stack is limited only by your imagination, and many users have created incredible, wonderful stacks dealing with
everything in sight, with not much more practice than you've had here.
We especially recommend the huge collections of stacks offered by the
Berkeley Macintosh User Group and the Boston Computer Society. See the
Technical Notes in Appendix F for their addresses or for Apple's toll free number
to get you in touch with a nearby users' group.
Every time you see a stack you like, you can call up the scripts that come with
it. Check out button, field , card, and stack scripts. Copy them (if they are not
copyrighted) into your own stacks. When you copy anything from one stack to
another, the associated script comes along with it. Just copy a button, for example, just like you've copied text and graphics. The script is copied with it.
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Here are some books you can get if you want to know more about
HyperCard and its programming:
• Understanding HyperCard by Greg Harvey
• The Complete HyperCard Handbook by Danny Goodman
• HyperCard Developer's Guide by Danny Goodman
• Hypertalk by Lon Poole

We could easily say that it's hard to overestimate the value .of HyperCard for
everything from education to fun and games. The truth is, though, it's hard even
to realize the value of this thing until you've seen a few stacks in areas of interest
to you.
The exhilarating freedom that this brings is the sense that you can do anything you want with this thing. And why Apple says its computers, more than
being tools for numbers or writing, really are tools for the mind.

Q&A
Q: I can't open scripts or find the graphic menu.

A: You need to set your user level in the Home stack before you can do anything in HyperCard except look at stacks . Go to the Preferences card, the
last card in the Home stack.
Q: I can't see much of anything on the Preferences card in the

Home stack, where I would change the user level.
A: You're working with a copy of HyperCard that ships with every new Mac.
While on the preferences card, type Command-M, and you'll see a message
box appear at the bottom of your screen. Type magic in this box, and press
Return. You should now be able to access the User Level dialog.
Q: I can't move graphic objects on a card.
A: HyperCard uses the paint mode. You can select any area and move it or

delete it, but not an object as such.

II
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Q : I want to search for some text in a stack, using HyperCard's

Find command. I know it's there, but I can't find it.
A: You are searching for text entered in the paint mode, rather than text in a
field. The Find command can't find paint text because, after it's entered, it
ceases to be real text. Enter text in fields if you want to work with it later.
Q: I can't select a button or a field.

A: Keep in mind which layer you're in- the card or background layer. What you
want to select is in the other layer.
Q: I copied a stack onto my hard disk and tried to run it. I keep

getting messages that the program can 't find or understand
things.
A: The scripts in that stack refer to the path to other stacks-which folder on
which disk they are on. Your copy is on a disk with a different name, and the
scripts can 't find what they're supposed to. You'll need to open the script
windows for the buttons that don't work, and change the references, or relink
buttons.

SAMPLE EXERCISE
This is such a creative and free-form tool that a suggestion of any structure for an
exercise strikes us as inappropriate. The best place to start for your first original
stack is with something especially interesting to you. How would you express the
magic and excitement of something you really enjoy, using the flexibility of this
program? Animation, sounds, special visual effects can help, but the most important part of a good stack is its structure-how many choices you give the user to
explore , whether it's in the context of a game or an interest. There's not much
limit to what you can do.

(HAPTE~
DESI"\TOP
PUI3LISH ING
In this chapter you'll learn how to:
• place text and graphics in a page design program
• resize blocks of text, and resize and crop graphics
• wrap text around graphics
• work with master pages
• use word processing features of page layout programs
• distinguish between categories of fonts and their best applications
• fine-tune type and styles for truly professional results
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Desktop publishing is one of the newest big industries around, and a major innovation of personal computers-what you'll do in an hour or two took professionals two days before PC's. As well, their product was not as good as yours can be,
since they did not have the immediate feedback and potential for change that you
have here.
They worked largely by hand, on light tables. The exacting nature of the
page design process was time-consuming and thus expensive. By contrast, the
ease and speed with which you can make up a page by computer is a real asset to
the creative process, in addition to saving bucks.
Computer page design also offers the invaluable asset of being able to make
fast changes to a publication and judging relative effectiveness of different layouts. This makes practice in this area much easier.
An inviting page is an important tool to persuade people to read what you've
written, or buy what you're advertising . Take some time with the next magazine
you read, to judge the use and effectiveness of its page composition, and ask why
advertising aimed at different markets makes use of different styles of layout.
This chapter may be one of the most useful for you, since whatever area of
business, education or government you're in, people need to communicate ideas.
Publications are often an effective way to do this, and a presentable brochure,
newsletter, or journal is more inviting to read. Your good ideas will go further
faster if they are well dressed.

GrniNG STARTED
Start up PageMaker by double-clicking on its icon, and then choosing New from
the File menu. First, you'll be asked to confirm or change the default page layout.
Choose Tall orientation, click OK, and you'll get a representation of a blank page.
The tool palette appears in a small window at the top right. You can drag
that window around like any other, or hide it to keep it out of your way as you
work with different-sized views of your page.
You 'll do a lot with the Arrow tool , and some with the Cropping tool.
Depending on how you work, you might use the Text tool quite a bit. The other
tools draw lines or shapes.
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PageMaker's Initial window. The margins show as dotted lines and will
guide teXt you place within them. You can, though, "bleed" pictures or
text to the edge of the page, if your printer will print to the edge. The
toolbox appears at the top right of the screen, but can be moved.

PageMaker's toolbox.

Arrow tool

; 0 ToolboH
~g,
1- A

D 0

0

.....--- Text tool

1z!

I

Cropping tool
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Page layout programs allow you different views of your page. PageMaker
opens to Fit in Window , but the Page menu has options for views in several different sizes, up to four times the actual size. All are useful views; the higher magnifications help with accuracy.
The rectangle representing a blank page, with dotted lines for margins, is
where we're going to place blocks containing either text or graphics, and lines or
other generic graphics to separate or emphasize blocks.
Anything can be put anywhere on a page.

A word processing program allows mixing text and graphics, and PageMaker
can also work moderately well for word processing. But you have the best of both
worlds by creating and editing text in a dedicated word processor, and doing page
makeup in a program designed for it.
Let's make up a rough, or dummy page, with some text and a picture. The
emphasis at this point won't be on accuracy but, rather, fluidity.
First , make sure the Guides and Snap to Guides commands on the
Options menu are on, and that the Autoflow command is off. A command has a
check mark beside it if it's on.
Note the location, on either your hard disk or available floppies, of both text
and graphics you'd like to place on your pages as practice. It's easy to make
some, using SuperPaint and Word or comparable programs. Here's how:
• PageMaker imports Word documents directly, so you can write as usual in
Word, and then place your writing in PageMaker for further work.
• PageMaker reads the file format (the program's own design for writing information to disk and reading it again) of several other word processing programs, but not all. It can, however, read a file made by any word processor if
the file is saved as plain text (also called text only, or ASCII text). As we go, see
if PageMaker will read your word processor's files as they are. If not, open one
and, using the Save As command, save the file with a new name in the plain
text format. PageMaker will then be able to use it.
• PageMaker can't read SuperPaint's own file format , but PageMaker can read
standard graphics formats on the Mac called PICT, MacPaint (or just Paint, or
MPNT), EPS, and TIFF. Open any SuperPaint file (or any other graphics program's file: most can write PICT or Paint files, and a few EPS or TIFF), and
use the Save As command to make a copy in one of these formats. You'll
have to give the copy a different name to avoid overwriting the original file.
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OJ Choose the Place command from the File menu. You'll get a standard open
dialog box. Navigate to your text and graphics, and you'll find a list of both
types that PageMaker can read.

I2J Double-click on a text file (leave the radio button lit for New Story). You go
back to your page, where you can see that the normal arrow cursor has been
replaced by a design suggesting the top left comer of a page of type.

•

,

. :-.:t PageMaker's cursor after
you double-click on a
text /lie. You're ready to
place that text.

----

PageMaker does a lot of this- the shape of your cursor shows you
what mode you are in. Had you selected a graphic to place, the icon
would indicate not only that it's a graphic, but what format it is.
N 0 T E

@] Align the Place Text cursor with the top left comer of the margins, and click
your mouse.
At this point, PageMaker flows the text into the margins, and your cursor
returns to a normal arrow.
Text f lowed into margins.
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Your text is shown as gray lines (or greeked} simply because at this view it's
too small to be drawn as text.
What you just did is get text from a word processing file. This isn't the
same as opening a PageMaker file , which you would do using Open
from the File menu.
N 0 T E

8J Choose Actual Size from the Page menu to see real text. Then go back to
Fit in Window.
The chief difference at this point between what you have and a page in a
word processor is the flexibility. You could move this text, all or part of it,
freely around on the page.

@J Click in the middle of your text block, and hold the mouse button down .
PageMaker takes a second , then your cursor changes to look like four
arrows, pointing in different directions. You're picking up this text. Keeping
the mouse button down:

liJ Move the text block around. This is more useful when you have several
smaller elements on the page, and want to rearrange them to see what looks
best. Drop the block back within its margins.
Since this text is still selected, it has windowshades at the top and bottom.
This is how you reshape, rather than just move , a block.

ITJ Click and hold in the handle of the bottom windowshade. Move it up the
page about a third of the way.
Note that the handle now has a down arrow in it, as in Figure 8 .6.
PageMaker is telling you that there is now more of the story than fits in the
area you've given it. This is useful for the editor who will continue the story
on page 99.
The top windowshade can be moved as well, to make the text start at a different point on the page. Why not move the whole block? Well, you might
have already fit the bottom of this story into ads below it, for example, but
want to make more room at the top for a larger title.
Look at each end of each windowshade. They end in small black boxes ,
called handles
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The block of text has been picked up and moved down and to the
left, to show flexibility In placement.

l
!
I
i

!

.............................. ....................,,, .;

Tools to resize or reshape this text block.
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Click and hold on the lower-right handle. Your cursor changes again, this
time to a diagonal arrow.

~ Move this around a little. The opposite corner of the block stays anchored ,
and you can otherwise resize and reposition to suit your needs.

[!Q]

Restore the original dimensions of your text. It's time for a graphic.

PLACING GRAPHICS
To place graphics in your layout:

DJ Choose the Place command again, and this time choose a graphics file. The
shape of the Place icon now indicates the format of your file. We'll explain
this business of graphics file formats in a little bit.

[I) Put your cursor somewhere off to the right of your page, in a part of the
screen we call the pasteboard . What we want to do is look at the graphic
first, modify it, and then place it.

@J Click the mouse, and watch your graphic take shape as in Figure 8. 7. Scroll
to bring it into full view, if necessary.

WORKING WITH ELEMENTS
At this point we can start to think about three treatments we 'll make to our
graphic: resizing , cropping and placing, and we don't want to think that these
should necessarily be done in any set order. We're creative artists here , and it
may take a little of this and a little of that to give us the effect we want.
But to learn, let's resize some first. Note the handles, three black dots at the top
and three at the bottom of the graphic, equivalent to the text windowshades. (Scroll
so that your graphic is in full view, if necessary.) Take your arrow cursor, and:

QJ Click and hold on the bottom-right handle. Your cursor will change to diagonal arrows again.
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Initial placement of a graphic on the pasteboard. Note the handles
and black dots on all sides, indicating the graphic is selected.
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[3] Drag the handle up and to the left, to make your graphic smaller. Let go of
the mouse button.
It's smaller, all right, but I'll bet also a little skinnier or chunkier than before.
Your drag was not proportional.

@J Choose Undo Stretch from the Edit menu and bingo, you 're back where
you started.
Let's resize it again , but this time:

GJ Hold down the Shift key, and then click on the bottom-right handle and drag.
Note that as you drag up or to the left, the boundaries of the graphic move in
the other dimension proportionally as well .
This use of the Shift key is a Mac convention: most graphics programs or
tools, SuperPaint included, do this.
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Enough resizing. Bring your graphic back to its original size with the Undo
command. If you've done something since the last resize, this won't work,
since Undo undoes only the last action-at least in this program.
In Freehand, a drawing application, you can undo the last hundred actions,
and Nisus, a word processor, lets you undo the most recent 32,767 actions.
Overkill? I'd settle for ten, but I'd like more than one.
Your ability to think critically about software design, especially its user interface , will be a lot of value to you as you evaluate programs and ways to get
things done.
What you can do if you can't Undo, and often the simplest move, is just erase
and replace the graphic. With it selected, press Delete to erase, and place it
again.
With it back at original size, come up to the toolbox and:

[II Select the Cropping tool. Then click once on your picture again to reselect
it, and:
We use the cropping tool
to change the visible
amount of a graphic.

Cropping tool

mClick and hold on the bottom right handle. Wait a moment for the cursor to
change to diagonal arrows, and drag up and to the left. (If the cursor changes
to a hand, you didn't quite click on a handle.)
When all you see is the top left few inches of the picture, release the mouse
button.
We 've cropped the graphic to the part that we want to use, and can now
resize again. Choose the Arrow tool, and:

CHAPTER

[I] Resize it so that it's about two inches square.

8

DESKTOP PUOLISHING

Now let's put it on the page.

IIJ Click to select it, and drag it onto the text, so it's somewhere around the right
top. Quick and easy.
Except that the text runs right over it. Sometimes an effect like this is desired,
perhaps if the graphic is large and has been done in a light shade of gray.
Not quite what we want here, though. We want the text to wrap around the
graphic. So:

~ Choose Text Wrap from the Element menu. You'll get a dialog box like Rgure
8.9. Click on the middle icon in the Wrap option line. This should select that
and the right icon in the Text flow line. So far so good. OK that dialog box.

•

:tLt... The Text wrap dialog
box.
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Your graphic now has space to call its own , and there are more lines and
points (PageMaker indicators) around it than before. It's time for a closer look
at all this, so:
Choose Actual Size from the Page menu. You should have something like
Figure 8.10.

G:QJ We could leave the text wrap as it is, but Page Maker allows us to customize
it, or wrap it around the graphic itself. The new dotted line around it is the
area that text can't enter, and that line goes from point to point. We can click
on a point and move it, or make more points by clicking on the dotted line
where we'd like to add a point.
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Text wrapped around the graphic's frame . Note additional indicators.
Those facing the text can be moved, and points added, to shape the
runaround.
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Click and drag the text wrap points at the top and bottom left of the picture.
Note how the text rewraps. Then:

[gj Click on the dotted line two o r three times to add additional points.

Then

reposition these.
See how you can make text follow the lines of a graphic. Used with some discretion, this is an elegant tool.
Hold it. The Art Director just walked in and looked at what you're doing. She
says no, you've chosen the wrong part of your graphic. But its magnification and
frame (area on the page) is perfect. What to do?
Here's the second use of the cropping tool. Select it, then click in the middle
of the graphic, hold until your cursor changes into a hand , and drag the picture
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within its frame. Isn't that elegant? Crop and resize some more, until you have
just what you want.

r21

Conceptual point: PageMaker keeps the entire graphic you originally
placed. Cropping changes only the size of the window through which
you see the graphic.

N 0 T E

Save a couple of versions of this on your disk. You've saved the original several times already, right?
Another conceptual point, about quality of graphics formats: basically, Paint
files can lose quality easily if you resize them in PageMaker, PICT files less so,
and EPS files not at all.

•, •

· :JUI

PogeMaker cursors after
you choose Place and
double-click on a:

~
T ext file

Paint file

Pict file

EPS file

As you remember from working with SuperPaint, the paint mode (making
paint-format files) offers lots of versatility and detail, while the draw mode (making PJCT files) is better suited to precision and high-resolution printing. EPS files,
made by more specialized graphics programs such as Adobe Illustrator, offer yet
greater precision.
The TIFF format is coming into more general use. Conceptually similar to
Paint format, it offers much higher detail, especially in gray-scale and color.
There are thus two points to consider when making graphics to use in
PageMaker: the kind of format determines how well you can paint or draw in differing styles; then, when placed in PageMaker, the format determines how well
you can resize. Good luck with your artist.
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THE STRUCTURED APPROACH
The other primary way to design pages is more common in a periodical publication, such as a newsletter. There the format is more standardized and logos,
charts, and other graphics are more often found in separate boxes or columns.
Let's do a newsletter something like the example at the end of this chapter: the
Computer Educator.
To help with the positioning of columns and other elements, we 'll use
PageMaker's column feature , and also use master pages, templates for our
newsletter that contain elements we'll want to repeat on every page. So, close
your current file and:

OJ Start a new document. In the initial dialog box, make this two pages and set
all margins to 0 .5 inch. Use Tall orientation. Click OK.
Note that at the bottom left of your screen, there are icons for the master
pages and actual pages, as in Figure 8.12. We want to go to the master
pages to add, logically enough, master el~ments.

Page icons. Page #1 is
currently displayed. L
and R represent the left
and right master pages.

(]] Click on the master pages icon. You should see a spread of two blank pages.
Now take a look at the Computer Educator, to see what we're going to do.
The first page has two wide columns at the right holding text, and a much
narrower one at the left which is largely white space, but with a small graphic
and caption.
We made the design decision that the left column on the first page would be
one fifth of the width of the page, and the two other columns would be twice
as wide. So we want five columns on the right master page, for odd-numbered pages.
For page two, we want evenly spaced columns, perhaps more typical for an
inside page. So we'll give the left master page three even columns.
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@J Choose Column Guides from the Options menu, click Set left and right
pages se parately and set the number of columns to three for left, five for
right. Leave the space between columns set at .167 inch. Your master pages
spread should look like Figure 8.13.
~~:1iJ:j

(''''

This spread of right and left master pages is where we design anything we want to appear on all pages of the publication. The first
page will follow the design on the right master, since It's an odd·num·
bered page.
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8J Choose the Vertical/Horizontal Line tool and, from the Element menu,
choose the line like the one at the top of the page in the example. Go to the
master pages, and draw two lines, one along the top margin of each page.
Then place the same type of line at the bottom. Once again, draw two separate lines.
[}] Now click on the page one icon, and we'll set up the masthead.
By clicking on the page one icon, you left the master page design and
are now on individual pages. A big mistake beginners make is to forget
to do this. They complete page one, then find they've done it all on a
WARN ING master page, so that pages three, five and seven will look just like page
one. Not what the Art Director had in mind.
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~ Choose the Text tool, click in the first column, and type whatever name
your newsletter is going to have. Then choose Select All from the Edit
menu, and make the text 28 point italic. (Use the Other.. . command on the
Type Size menu to get 28 point, a standard size.)
Hmm. It seems to want to stay all in one column. No problem, just choose
the Arrow tool and:

0

Grab a handle at the right end of the text block, either the top or bottom one,
and resize the text block so that it covers five columns. This also puts all of
the text on one line.

0

Put a box around the text. If you like, go to Fill from the Element menu and
set an 80 percent fill for the box, and specify Reverse for the type style. The
example was done this way.

~ Reposition the box and text so that the text is centered within the box.
This may be difficult at first, since you're now working with one element on
top of another. PageMaker has two commands on the Element menu to fix
this: Bring to Front and Send to Back. Select the box, and send it behind
the text, so you can work with the text.

[!QJ

Put a line below the masthead, as in the example.

rDJ Type "THE" and size and position the word as you think best.
It's time to place the lead story. With the Place option:

~ Choose the lead story for your newsletter. Your cursor looks like the corner
of a page again.

~ Put the cursor in the second column, under the bottom line of the masthead,
and click.
The text flows into column two, and the down arrow in the handle of the bottom windowshade tells us there's more text. But what we wanted was text in
a column that spans our page columns two and three. No problem. Using the
Arrow tool:

~ Select the text, grab a right handle, and pull it over. Your page should look
like Figure 8.14.
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:•12• Type placed In one column, then widened to fill two columns.

--·-

COMPUTER EDUCATOR
II

Now, to fill the second column:

~ Click on the arrow in the bottom windowshade. You get your text-placing
cursor back.

~ Click near the top of column four. You may want to choose the Actual Size
view to help you align your cursor with the top of the first column of text. Or,
after you place the text:

~ Click in the horizontal ruler at the top, and drag a guide down to the baseline
of the first line of text in the first column. Vertically align the second column
by this guide.
The text flows again , and fills up a narrow column again. But you know how
to fix that. And o nce that's done, there's still text left to place. Go to page
two, and put the rest into the left column.
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Oops. We forgot a headline for our lead story. So let's do one. But instead of
typing it in a column , like we did the masthead , and then fiddling with the
width, just:

~ Choose the Text tool, and click off to the side of your page. To get some
room, hold down the Option key, click on your page, and drag it to the left.
Like a graphic, we can put text on the pasteboard to play with it. Type your
headline, and make it Avant Garde and 28 point.

~ Make room for the head by selecting the first column of text. Grab the windowshade handle and move it down about an inch. We' ll do fine alignment
once the head is in place. Repeat this for the second column of text.

~ Align the tops of the text columns. Then go to page two, and note that the
remaining text has grown because you reduced the size of the text area on
page one. The whole story is still there.

f3:!J Select your headline and move it into place. You're in charge of exact placement, since the Art Director, who loves to breathe down everyone's neck,
just went to lunch. Leave room between elements, though.
Why? Take a look through a nearby magazine that seems to charge a lot for
its advertising. At steeply expensive rates per page, why do advertisers leave
so much white space between text and graphics?
Simply put, it increases the effectiveness of what text and graphics there are
on the page. Try to find an example of the opposite, where the page looks
crowded. Note how much less inviting it is.
This is less a matter of rules than of judgment born of practice. A keen eye
for what you find appealing in page design is a big help in developing your
own sense of how to make a page work. The experts recommend simplicity,
an odd number of major elements on a page, not too many fonts, and an
attention to composition, much as in painting, that leads the viewer's eye ·
from one element to another.

~ Get a graphic and a caption for the left column on page one, and put lines
above and below it.
Something like the example would be fine, or try whatever appeals to you.
Creativity and variety are important parts of publication design.
Let's take a moment to look at a couple of Pagemaker's nicer features, to help
with your work.
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STORY VIEW
Spell checking, Find and Replace, and other word processing specialties, are
available in PageMaker in Story View rather than Layout View.
Story View. The front window Is the same file as the text behind it.
Changes made In one window reflect immediately In the other.

11i:

COMPUTER EDUCATOR
Time for a big changel

"It's time to stop teaching people

about computers, end time to start teochtng
computers about people!"' wes the finding of e

Iorge end nigh-level conference. held In New Vork
lest week. of college feculty end edmtntstretors
from most of the United States end Cenede.
The conf erence wos convened In

response to numerous complaints from students
at hundreds of North Amen can colleges. who did

not feel they should have to learn how to operete

o computer. ..These things ore just too lexpleti\le
oeletecll conrustngl .. es en agitated student put
It ..The people who know how to use them con do
anything they went, end the rest or us ere 1n the
ocnc, .. he scld
The notion thl!lt the computer works
for the person. end should work as the person
woncs, t s c new one, the conference decided.
Tredltlonelly, th e person hcs nell t o teem how
the machine wot1cs, end conform to Its often
crcone s tructure or operations.

Story View is another window, in word processing style, of a text document
on the made-up page. In Story View, the text is often easier to read and can be
scrolled faster.
To see a file in this view, just click your text cursor in any text block, and choose
Edit Story from the Edit menu. Choose Edit Layout to go back to your page.
Story View is an effective feature for text editing, and the increased clarity of
its display makes its use preferable for accurate proofreading of text.
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What confuses many users at first is the apparent notion that since this is
another window, it's another document. It isn't, but just a way of looking more
closely at whatever text your cursor was in when you chose this view.

CONTROL PALmE
So far, all placement and sizing we've done has been by clicking, dragging , and
eyeballing it. This is a fine way to work for much of what we do, but often more
precision is desirable.
Pagemaker lets you size or move page elements by numerical measurement.
After selecting an element on your page (try a graphic), choose Control Palette
from the Windows menu, and you'll see:

.

. :.ell Pagemaker's Control Palette. Type of selected object (a PICT graphic
In this case, per the Icon on the Apply button at the left) and Its measurements are shown. You can change X and Y coordinates of the
object's reference point, or Its width or height, or size by percentage.
Clicking on the corresponding arrows moves the selected object one
pixel per click.

Close box

Size field
Apply button
Reference point

Scale and crop icons

Percent of original

Position field

1

••w:
lr::H~11 o l;~:y~:::~ :: 1
'if

3.833 in
~ H: 3.681 in

'

1 009iS

'

I~ 0

Proportiona11

1 009iS

X and Y are the coordinates on the page for the object you selected. W and
H are the size of the object, followed by the size as a percentage of the original, if
the object is a graphic.
You can change any of these numbers by clicking in the number: a text cursor is displayed. Make what changes you want, and click on the Apply button,
which also happens to show the format of the graphic you're working on.
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You're well on your way. Let's end the step-by-step page makeup, to look
at some fine points of design you'll want to keep in mind for professional-quality work.

FONTS AND FINE STUFF
One effective way to govern the look of a page is by choice of type styles.
Typography plays a surprisingly large role in how words are received by the
reader. You'll find many subtle instances in advertising. Want your text to appear
clean and open, or rich and classy? It matters to the ad agency dropping a million
or so on a campaign for a washing machine or a car.
What they' re doing to you is an example of Marshall McLuhan 's "The
medium is the message." It's such a sensitive touch that many people never recognize it consciously. But in most areas of endeavor, your ability to organize
effective presentation of the written word will become more important as you
earn increasing responsibility.
Let's take a quick look at some kinds of fonts. There are three major types,
shown in Figure 8.17. Serif is what we are used to in text: each letter has the
major strokes that define its shape and, in addition, smaller strokes or 'caps' at
the end of each major stroke. These serifs lead the eye from one letter to the next
in a word, and actually make text easier to read.
Sans-serif, as you might expect, is the letter without these caps at the ends.
Although not as readable in text, sans-serif presents a sense of directness of message through the simplicity of its style. Sans-serif fonts are often used for captions
and headings, in contrast to serif body text.

The third kind of font is cursive, similar to handwriting. This can be effective
in an advertising head or a sign, but is generally much harder to read in body
text than either serif or sans-serif.
What these examples don't show you is the effect a font has in body text,
where the co/or of the block of text is as important as the shapes of individual
strokes.
A way to develop an eye for fonts is to scrutinize different kinds of publications. Why did they choose the fonts they did? Why did we?
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This typeface is Palatino, a traditional
font.

News Gothic is a favorite in publishing.
Gill Sans is a favorite of the author.

Zapf Cfiancery is cursive, resem6fing fine caf{igrapfiy.
QL~

Symbol has Greek and math.

SIZES
The size of the type you use is an important part of making your publication inviting. Type height is measured in points, which are 1/ 72 of an inch. (Another unit
of printing measure is the pica, 1/6 of an inch.) For most fonts, from 10 to 14
point is the most suitable size for body text. What you're reading right now is 10
point.
Another aspect of type size is the x-height, or the height of a lowercase letter. Souvenir, what you're reading, has a relatively large x-height.
T en point Bodoni, with a small x-height, looks much smaller than 10 point
Souvenir.

Keep track of what fonts you're using if you'll need to switch machines, perhaps in order to print. Mac users commonly get into trouble when they do work
on one machine which has, say, the Avant Garde font installed. They then take
their disk to another Mac which doesn't have Avant Garde. Surprise.
Best ways to avoid this are: do all your work on one computer, check to see
that the other one has the fonts you're using, or carry a disk of them with you.
Most Macintosh screen fonts a re free , while the printer fonts used by a
Laserwriter or higher-resolution printer are not. Most Laserwriters have several of
the standard fonts built in, though.
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Line spacing is worth considering too. Both tight and open spacing have
their benefits. You're reading 10 point type on 13 point line spacing, offering a
slightly less packed look than a dictionary, for example.

STYLES
Back when your grandparents used typewriters, the only ways to emphasize
words were underlining and capitalizing whole words. Both are more difficult to
read, and less effective emphasizers than italic. As well, all caps suggests that the
writer is SHOUTING AT YOU. But too much body text in italic again becomes
hard to read. Ditto for the outline and shadow styles the Mac offers you.
But used sparingly, outline type looks nice .
Too m uch variety in styles, and in fonts, detracts from the quality of presentation that fine typography otherwise p romotes.

For example, look at what you just read: italic after outline. Too much variety
too fast interrupts the flow of thought.
One elegant touch the Mac gives us is a nicer set of apostrophe and quotation marks than typewriter types get. What they get is:

"She's inside," he said.
while we can use what are variously called typographer's quotes, or smart or
curly quotes, to get:

"She's inside," he said.
Most word processors and page layout programs offer this. If yours doesn't,
stop by your users' group for Smartkeys, a free little gem that gives you smart
quotes in any program.
Smartkeys a lso makes sure you put only one space after a period. What's
this? Didn't your typing teacher tell you to use two? Yes, and the idea was that in
the monospaced world of typewriters, where an i is equal to an m in width, two
spaces were necessary to separate sentences legibly. This isn't true with a proportional font such as all you see here, and using only one space after punctuation obviates excess white space within the line of type, and so makes text more
readable. Small stuff? Not really. Type can be beautiful, and worth making so.
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CHECKLIST
In this chapter you've learned to design (or make up, or lay out) a page of text
and graphics with complete flexibility of use of page elements. You can:
• place and size text,
• place, crop, and size graphics, and wrap text around them,
• place and use columns on a page,
• design the personality of a publication,
• work with PageMaker's word processing features, and
• judge typography for aesthetic impact and effective presentation.
As you've seen, page design programs like PageMaker tend to be big and full-featured. And, like other kinds of programs, each competitor in this area has a personality, and a set of strengths and weaknesses.
Programs similar to PageMaker include QuarkXPress, Ready,Set,Go!,
Framemaker, and Ventura Publisher. Smaller variations include Taste and Publish
It Easy. Each does most jobs, and there are reasons to prefer one to another for a
specific application.
When comparing these products, it's often best to try them out with a specific project in mind. Take a disk of text and graphics, and a sketch of what you
want to produce. Then see how well you and a program work together.

HELPFUL HINTS
Of what we've learned in this book, aesthetics counts the most in chapter two
(graphics), and in page layout. There's quite a difference, though: illustration is
just what you want it to be, while page design is full of conventions-which, like
all conventions, are susceptible to overrule once you understand why they exist.

If you're interested in this area, you can't spend enough time looking at magazines: general format, major and minor features, and advertising. With everything you see , ask yourself why they did it that way . When you' re looking at
quality work, the answers can be telling.
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Q&A
Q: I want to place a text or graphic, but its name doesn't appear

in PageMaker's Place dialog box.
A: What you want to place is in a format that PageMaker can 't read. Go back to
your graphics or word processing program, and use the Save As option to
save this file in a compatible format, as discussed in this chapter.
Q: I want to spell-check some text, but the spelling command isn't

active.
A: You need to be in Story View (choose Edit Story from the Edit menu} to
check spelling.
Q: I can't select a graphic I've placed on a page.

A: Another object is in front of it. Use the Send to Back command on the
Element menu to put the frontmost object in back of the stack. You should
now be able to access the graphic.
Q: My text only wraps around a graphic as a rectangle, it doesn 't

follow the shape of the graphic itself.
A: Choose Text Wrap from the Element menu, and change the wrap option.
Q: It's difficult to size and then crop a graphic for the effect I

want.
A: This is part of the art of page design. Some people like to work with the
graphic on the pasteboard; others like to put it on the page and then resize
and crop it. Try each , and try resizing first, then cropping, and then the other
way.
Q: Every odd-numbered page in my document has the same

objects on it.
A: You've made a mistake everyone makes when starting out, of placing elements on master pages. Just cut and paste them off the masters onto the
individual pages.
Q: I'm on a numbered (not master) page and I can't select an element.

A: The element is on a master page. There's no indication for this, except that
you can't select it while on a numbered page.

WELCOME TO .. .THE MACINTOSH: FROM MYSTERY TO MAsTERY

SAMPLE EXERCISE
Finish up the Computer Educator, or something very much like it. Then save a
new version of this file , and make some change to every element in it. Change all
of the fonts , try some different sizes, place graphics at different points on the
page. Print both versions, and judge which seems a more effective presentation
of its content. Ask a friend to judge too, and ask her why she likes either one better. Then make a revised version. Pretend this is an advertisement that will cost a
million dollars to run in a major magazine.

lAST THOUGHTS
This completes our tour of the Macintosh. If you're like many people, you've felt
surprised to achieve competence on this computer in eight chapters. We have
gone fast but, as you've seen, there's not much that's truly complicated and,
greatly to the Mac user's advantage, many options and functions of different programs are similar in design and use.
You'll find this with programs competing with the ones we've chosen for this
book, and you may prefer some aspects of the competition.
Since many preferences differ in this world of the personal computer, it's
good to know that we can work with each other , each using a different word
processor or database.
This is because competing products are largely file compatible-you can move
data from one to the other without much trouble, although you don't always have
the same flexibility with it once you've moved it. The page design programs, since
their documents are more complex, don't talk to each other as well.
All of these programs have some features their competition lacks. All have
some infuriating quirks-we get spoiled fast, don't we? All have some wonderful
qualities, and all seem sometimes to have been coded on the moon. Look well
before you buy.
As a final tip, may we suggest that you take an hour here and there over the
next month or two to play with the programs you've learned, to stay in practice
and to develop this splendid tool as an extension of, rather than an object of,
your thought.
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COMPUTER EDUCATOR
Time for a big change!
"Irs time to stop teaching people about

about the @#$%"'&• computer and start think·

ers about people!" was the finding of a large

ing about what we want to do, the better,"

and high-level oonfercnce, held in New York

they said.

last week, or college faculty and administrators from most of the United States and
Canada.

The conference was convened in response to

There was a fair amount o f opposition to
these new ideas. Observers were generally of

the o pinion that the new idea showed prom-

ise but was fraught with difficulties. "lfs of-

numerous complaints from students at hun-

ten easier to teach people about computers

dreds or North American colleges, who did

than the other way a round," one said. "Co m-

not fccJ they should have to learn how to oper·

puters have known all along that they have
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the upper hand with things, and getting them

pletive deleted I confusing!" as an agitated stu-

to do what people want them to might be

dent put it. "The people who know how to use

nearly impossible."

them can do anything they want, and the rest
or us are in the dark," he said.
The notion that the computer works fo r the

This computer
geek doesn't
like the news.

"The sooner the rest of us can stop thi.nk.ing

computers, and time to start teaching comput-

An attempt was made to contact john Rethorst, this manual's author, but to no avail. " I
haven't seen him in years," an observer said.

person, and should work as the person works,

"Ever since the high-speed Macintosh Quadra

is a new one, the conference decided. Tradi-

came out." No one would comment, tho ug h,

tionally. the person has had to learn how the

on persistent rumors that Rethorst had adual-

machine works, and conform to its often ar-

ly transformed himself into a Quadra on the

cane s tructure of operations.

football field at midnight some time ago.

Reversing this tradition portends far higher

Despite the variety of comments o n the new

creativity and productivity on the part or people who use computerS, the conference deter·

proposal, most participating oolleges have decided to go ahead and revise the curriculu m.

mined. However, this could only occur at the

'"This will give us vaJuable programming ex·

expense of computer experts, often termed

perience," a spokesperson said, "'and leave

"geeks" or .. nerds/' who have vast computer

our students with more time fo r the things

knowledge but seem reluctant to s hare it with

that are really important in college, like par-

others.
There would be a big advantage to making

ties. Computers may be better than we are in
many or even most ways, but they jus t can' t

nerds and geeks obsolete, everyone agreed.

party at all"

APPENDIX
VI~US P~OTECTION
& OTHE~ SAFETY TIPS
What's a computer virus? It's a small program, written most likely by a computer
programmer with a grudge , or by a well-intended person so young he doesn 't
realize the effects of his work.
The unique quality of this small program is that, analogous to a living virus, it
can move from one computer to another by itself fairly easily, as long as there's
something to move on-a floppy disk, for example, or telephone lines.
Once it's in your computer, again analogous to the living kind, it makes some
changes to its liking, and most of these changes are not to the benefit of the host
computer. Some more benign varieties just cause your Mac to beep more often,
or for the cursor movement on the screen to be erratic.
Other viruses are malignant, and can be designed to erase your hard disk or
cause other destruction. Whatever its effect on your machine, though, the virus is
also written to infect other computers that come into contact with yours, again by
means of a floppy or some other form of contact.
A new Macintosh virus appears about once a month. It is vital that you take
necessary and sufficient steps to protect your computer and, especially, your
data, from viruses. There are two means to do this:
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• prevent contact between your computer and others. If you're writing
the Great American Novel on an island in Puget Sound, you have an easier
time of this than someone whose work requires frequent trading of floppies or
access to computer networks over data or phone lines. Even if this method
seems feasible , it is not foolproof (even floppy disks containing programs you
buy, shrink-wrapped on the dealer's shelf, can contain a virus), so this second
method has the strongest recommendation I can give it:
• obtain and keep current, virus protection and eradication software.
The protection programs load into memory when you start up, and monitor all
floppy disks you insert, or a range of other activity, to keep a virus from infecting your Mac in the first place .
Should your Mac already be infected, the eradication type of software can find
and erase the virus-hopefully before it has done too much damage . Yo u
should get this software on a locked floppy-you can see through the hole at
the top right-and the floppy should stay locked , so that nothing, not even a
virus, can be written to it.
Several anti-virus programs of both the protection and eradication types are available. Some are commercial; others are free. The free programs are as good as the
commercial offerings, except that most of the commercial software comes with the
publisher's support in the form of an 8 00 number or such for updates, to keep the
anti-virus program current with the latest viruses. For the free programs, you have to
go get a newer version-usually going no farther than your users' group or dealer.
Two of the best free programs are:
• Disi nfectant. Written a nd frequent ly updated by John Norstad o f
Northwestern University (thanks, John!) This is both a protection and eradication program with extensive on-line help, to counter all known viruses. If you
do not have access to a users ' group , on-line services via a network or a
modem , or a responsible dealer , you can obtain the la test version of
Disinfectant by sending a stamped, self-addressed envelope and a blank BOOK
floppy to:

John Norstad
Academic Computing and Network Services
Northwestern University
2129 Sheridan Road
Evanston ll 60208
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• Gatekeeper. This is a protection program only; its advantage relative to
Disinfectant is that this will monitor your Mac's activity for the kind of activity
that viruses tend to do , even if no known virus is detected (remember, there
are new viruses all the time). Written by Chris Johnson of Austin TX (thanks,
Chris!), Gatekeeper is available from on-line services, users' groups, and good
dealers. If your dealer won't give you the most recent versions of these two
anti-virus programs for the price of a blank disk, find another dealer.

COMMERCIAL PROGRAMS:
In current versions, these aren't better at what they do than the free programs ,
but your purchase price allows the publisher to offer telephone or fax support,
often including a way that you can type in a string-a collection of numbers and
letters-that tells the program how to look for a new virus, and erase it. This is
simply faster than going and getting an updated version from your user's group.
Good commercial offerings include Central Point MacTools, SAM (Symantec
Anti-Virus for Macintosh), and Virex.

0TH ER SAFETY Tl PS
Assuming you save regularly and often, and make backups of anything important,
the largest source of danger to your data occurs in one of two ways: when something happens outside of your Mac, such as a power failure or your moving it
when you shouldn't; and something inside the computer, as when it can accidentally misplace a file. Here's how to deal with both:

EXTERNAL INFLUENCES:
• fluctuations in voltage. Get a surge suppressor. This $10 to $40 piece of
hardware can eliminate a common nuisance-surges in power supply voltage
that can fry your Mac's chips or your data. More expensive variations can actually offer a few moments' backup power-enough to save something to diskshould a total power outage occur.
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• moving a hard disk while it's running. Like a record turntable, a hard disk
has an arm which is often over the disk surface. J ostling the mechanism while
it's running can cause the arm to collide with the disk, ruining that part of its
surface. Other parts of the computer, monitors and such, can be moved while
powered on. But since many Macs have hard disks built in, either make sure
yours doesn't, or shut down before you move it even an inch.
• static electricity. If your work area has a carpet or whatever that tends to
generate this, you may want to touch a finger to anything else before picking
up a floppy, or going to work on your computer.

INTERNAL INFLUENCES:
In the course o(reading from and writing to a disk, one of two errors may occur.
The first is the corruption of, or an inaccuracy placed in, the disk directory. The
directory is a small area on the disk that functions much like a telephone book: it
tells the Mac where each file is located on the disk. If the directory becomes corrupted, or scrambled, your Mac won't be able to find a file and display its icon on
the desktop, although the file is still there. The computer has just, literally, lost its
address. Can you find it again? Yes, if you take the following precaution.
The second error is actually yours, not the machine's: you've simply made a
mistake and put a file in the trash, and then emptied the trash . Is that file gone
forever? Actually, the file itself isn't erased; the directory is just updated to show
that it's gone. The actual file is still there. Can you restore it to normal use? Yes,
if you take the following precaution.

PRECAUTION:
Get a file recovery/ disk doctor program. Two good ones are Central Point
MacTools, and Norton Utilities for Macintosh. Either of these includes a small
extension that loads when you start up, and tracks the location on disk of anything you erase and also, periodically, makes a copy of the disk's directory. The
program keeps this information in a separate place on the disk.

So, if the original directory becomes corrupted, the disk doctor program can
restore it. And, should you want to "unerase" a file you threw away, the doctor
can search your disk for recently deleted files, and restore their address in the
directory-136 Maple Street is once again occupied, so to speak.
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A catch here is that, should you want to unerase a file, you should do so soon
after you erase it. Otherwise, when you save more data to disk, the Mac goes
looking for free space on the disk on which to put it, notes that the directory says
that 136 Maple Street is empty, and puts this new data there. At that point, the
earlier data is physically ovetwritten, and the disk doctor can't help you.

SECOND PRECAUTION:
Be a backup fanatic. Make backups onto floppies of everything in sight, so
that when (not iO your hard disk's directory becomes corrupted, you wait too long
before unerasing a file , or there's a hardware failure , you'll have a second copy of
everything you need.
There are numerous backup programs to help you do this. The simplest way
is to use none of these: instead, just put a floppy in the drive when you're finished
working with a document, and Save As onto the floppy. Don't erase anything, fill
the floppy up, label it carefully and put it in a safe place.

If you can 't be this methodical, backup programs include Central Point
MacTools, Diskfit Pro, Redux and Fastback. Any of these, plus the cost of floppies, is a small price compared to losing work.
The advantage to backing up as compared to the disk doctor scheme is that
your dog can actually eat your hard disk any time it feels like it, leaving the doctor
with nothing to work with. A hardware failure is more than a software program
can cope with, making it very nice to have copies of important data on other
disks. The best recommendation is, use both the backup scheme and the disk
doctor. Your data will, someday, thank you.

APPENDIX
SHA~EWA~E

Now that we've looked at the major categories of commercially available programs for the Mac, and we know that data protection programs are here for us
now and forever, is there anywhere left to go? You betcha!
Probably the most creative and, in sundry ways the most versatile utilities for
the accomplished user-you-are not published and sold by behemoths like
Microsoft or Claris, but are written by enthusiasts here and there and released as
shareware or freeware , usually through users' groups. See the Technical Notes
in Appendix F for what users' groups are about.
Freeware is just that. Shareware is a great concept: you get the program free
and can try it out for a week or two. If you like it and want to use it, the author
asks that you send her a check. The amount is usually a trifle, since you and the
author both avoid the expense of advertising, packaging and commercial distribution. If you do send that check for these great utilities, you e ncourage their
authors to produce more.
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Here are some of my favorites:

• M0ire Idle is a screensaver, something every Mac owner should have. Out of
the box, the Mac's screen stays lit as long as it's on, and the continued bombardment of electrons can bum the screen phosphor in parts of the displaymenus come to mind-that don't change with the hours. Screensavers like
M0ire wait until you haven't used your Mac for a time you set, say five minutes, and then change the screen display to something constantly changing, so
no more bum-in. The nicer screensavers change the screen to an interesting
display such as M0ire's geometric patterns.
• Darkside of the Mac-a screensaver that's even better than M0ire, I think,
but for System 7 only.
• SuperClock puts the time on your menu bar, over at the right. Click on the
display to see today's date, all in the font and size you choose. It has timer and
alarm options too.
• ButtonPad is an improvement on the standard NotePad, by several orders of
magnitude. Define up to sixteen note pads, and go to any one with a click.
Text is saved automatically.
• Flashwrite is another fine tool for entering that quick thought we don't want
to lose. It is on your screen in a flash , as it were, and gone just as fast, with
your text saved as you write it.
• Easy Envelopes, an excellent utility for formatting and printing envelopes
and, of even more value, an electronic rolodex for addresses or anything else
you want. It has a very fast find function.
• Smartkeys makes sure you put only one space after a period or other punctuation, as the typesetting manuals say you should. It also offers smart quotes,
substitution of dashes for double hyphens, and myriad other typing (ahem,
typesetting) helpers.
• Escapade lets you stay on the keyboard while you work. Just press the first
letter o f any button in a dialog box, and it's chosen just as though you had
clicked it with the mouse. ButtonKey, YesNoCancel, and Commander
Dialog do this too. Most of these let you navigate around a dialog box using
the command, tab and space keys as well. Who needs a mouse?
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• Typelt4Me is an excellent glossary. Are you tired of typing "reification" ten
times a page? Why not tell this utility to enter that word automatically every
time you type "r/ ."? And, if you tend to type "adn " every time you want to
type "and," you can tell this program to correct it for you.
• DT (for Desktop) Calculator is "advertiseware" (free, but keep them in
mind) from a Swedish software company. It is a very fast and accurate RPN
(reverse Polish notation) calculator, with numerous scientific functions.
• Convert is also a fine calculator, with the added advantage that it converts
units-metric to English, or anything else-while it's calculating.
• Super Ruler puts a ruler on your screen for any kind of graphics work. Move
it around, change the units, vertical or horizontal orientation, the zero mark,
and its length.
• Artisto lets you look at any Paint or PICT file without opening a graphics program, and then paste the graphic into whatever you're doing. A must for any
kind of graphics/word processing o r page layout work.
• Calendar 1. 7 is many times better than the standard Mac calendar DA. It lets
you make notes for any day for hundreds of years into the future.
• Calendar Reminder INIT shows you whatever you've put into today's calendar file, when you start up your Mac. No more excuses.
• Finances is a very fast calculator for all kinds of money things. How long it
will take to pay off a loan, how well your investments will do at this or that
interest rate, and many more features. It is a substantial assistance to financial
planning .
• Magnify shows you the area of the Mac screen you select-at eight times the
magnification . Excellent for any kind of graphics work.
• Helium gives you options fo r those sometimes helpful , sometimes pesky
System 7 balloon menus. Leave them off until you hold down a hot key that
you choose, and there they are.
• The Dvorak keyboard, discussed in the word processing chapter, is available through Electric Dvorak or Keyboard Switcher, or (in System 7) from
an Apple keyboard module. Typing is faster, easier and less painful in long sessions. Well worth the time it takes to learn it.
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• Mouse2 and Pointing Device make your mouse faster on the screen, and
thus make your Mac easier to use. Indispensable for a large monitor, and nice
for everyone.
• Windows adds a menu of that name to every application (including the
Finder) that lacks one. Navigation through all of those windows becomes possible. How did we ever live without it?
• BeHierarchic (for System 7) adds submenus to your Apple menu, and all of
those utilities, control panels, and such, are suddenly easier to find, and operation can be much faster.
Using the alias feature of System 7, for example, you can add an alias for your
hard disk to the Apple Menu Items folder, and everything on that disk will now
appear in the Apple menu, in hierarchical menus up to five levels deep. Viva
organization!

APPENDIX
MACINTOSH
UTILITIES
Now that you can use a Mac and its major applications effectively, and have
understood the vital information about viruses and troubleshooting (Appendix A),
including the programs that offer this help, and have perused the information on
Shareware (Appendix B}-great bargains that offer you increased flexibility and
functionality-is there anything more to look at?
Yes, and if you'd like to consider this section, you can truly become a guru
among Mac fanatics-a fabled Power User.
The utilities discussed here are commercial programs that let you do things
faster and more easily than you might think possible. Apple doesn't include these
features in the system software simply to encourage third-party development and
competition. The results of that competition, which we'll look at now, are nothing less than breathtaking in their creativity and their improvements on the standard Mac interface.
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QUICKEYS
H ow many times have you performed a sequence of steps, and wondered why
you couldn't automate the series, for both speed and accuracy? When I wrote this
book, I created all of the illustrations in the PICT format {see Chapter 8 for a discussion of file formats). I then had to change every one to the TIFF format for
publication. All 175 of them. To do each required selecting the image, calling the
menu command Save As, choosing TIFF in the resulting dialog box, typing the
extension . TIF at the end of the name of each file , so both the Mac and I could
tell them apart, and then saving and closing the file .
Using QuicKeys, I went through this sequence manually just once, not 175
times. QuicKeys recorded my steps and saved them as a macro file, much like
Excel does, but a QuicKeys macro can be recorded for any program.
It then took me only one step per illustration , rather than the five that
QuicKeys did. Accuracy benefits too, since humans don't do their best when performing repetitive actions.
QuicKeys can a lso translate any menu command into a keystroke- just
choose the command and its keyboard equivalent, and you're set. This is most
useful for keyboard-intensive workers like myself. Although some users are happy
to leave the keyboard for the mouse each time they want to perform a command,
other users develop a feel for the keyboard gestalt, and don 't want to leave that
mode of thought for the different interface of the mouse and menus. It may seem
like a small point, but keyboard-equivalent utilities have been a good way for programmers to make money for a few years now.
Word and several other applications let you assign keyboard equivalents from
within the program itself. Nice, but Quickeys lets you do it for any applicationor for all of them at once.
Alternatives to this program include Tempo, AutoMac and MacroMaker.
Tempo offers especially inviting complexity, such as a macro making a decision
{called branching) depending on what's on the screen.

Now

UTILITIES

Now Utilities is for System 7 only. Rather than one focus, this is a collection of programs that make your Mac more powerful, fun, and easy to use in a number of ways.
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Boomerang, the most important component, takes you back to the part of
your disk where you were last, every time you open or save a document. You can
assign keyboard equivalents to any file or folder, to open it right away. It has a
fast Find function , for file names or-amazingly-the text within a file. And every
Open and Save dialog box has a menu bar on top, with the last fifteen or so files
and folders you've used. You can thus go to any of them immediately.
NowMenus lets you move your mouse over the menu bar, and the closest
menu drops without your needing to click. Just a little smoother and more elegant. Move down to the command you want, and then click. You can also add a
completely new menu or two or three, to display to the far left and right of the
menu bar, and to pop-up anywhere on your screen, with the help of a hot key
(command, control, o r such) that you choose. You then choose the content of
these new menus-the last twenty documents you've opened, or the most recent
applications, or files or folders you want to reside there permanently. You can
also define worksets--groups of applications or documents that you want to open
all at once.
This program also makes your Apple menu hierarchical, and any choice that
requires further choices-the Control Panel, for example-now shows those
choices as a submenu, making their access much faster.
This feature, which the shareware utility BeHierarchic gives you as well,
gets incredibly nice when used in conjunction with aliases , a System 7 nicety. Put
an alias of your hard disk in the Apple Menu Items folder in your System Folder,
and the contents of your disk is then available on the Apple menu, up to five levels deep in hierarchical menus. No more double-clicking. Make an alias of your
Clipboard file in the System Folder, and put that in the Apple Menu Items folder .
You can then access the Clipboard from within any program, whether it has an
option to show the Oipboard or not.

NowSave lets you save the active file automatically, at whatever number of
minutes, keystrokes, or idle time you set. Several other utilities, commercial and
shareware, also offer this. Here's why not to utilize it: I was using it, working on a
long document, and went to format it. I typed Command-A to select the whole
file, and then wanted to format it with Command-B. I mistyped, and pressed
only the letter B. My entire document was then replaced with the single letter B.
This is normally not a problem, because you have two ways to recover. The
first is Command-Z, Undo , to replace the letter B with your document. But
Undo has to be the first action you do. If I had typed a C after the B, the Undo
command would then undo the entry of the C, and that's it.

a

WELCOME TO ... THE MACINTOSH: FROM MYSTERY TO MAsTERY

The second recourse is to close the document without saving it. You might
lose a few minutes of earlier work (but only a few minutes, since you save so
often), but you won't lose the whole document.
But it was just at that moment that NowSave, saving the active file every ten
minutes, stepped in to save it. I watched this with some interest, and then carefully chose the Undo command. Very carefully.
So automatic saving of the active file may not always be the best route to
take. Well-designed applications such as WordPerfect or Finale (a fine music program) make backup files as you work-every ten minutes or so, and the automatic saving of these separate backup files doesn' t affect the status of the file
you're working on . Erase your active file accidentally? The backup is there, and
within ten minutes of current.
NowSave does have a saving grace, called Key Capture, a feature also
offered by the program Last Resort. This does a separate save of every keystroke you make to a text file in the System Folder. If you lose everything else,
you can recover all you've typed by opening this text file. This is a great idea, and
the chore of sorting through the raw data of your keystrokes is small compared to
re-creating your ideas.
Other components of Now Utilities: AlarmsClock is an advanced rendition
of the freeware SuperClock, with precise control over the reminders you give
your Mac to give you. WYSIWYG Menus show you all of your fonts as they'll
appear in your document , and lets you group fonts in whatever families you
choose. Startup Manager gives you control over which extensions (called JNITs
in System 6) and control panels (CDEVs in System 6) load, and in what order.
The advantage here is that not all extensions and control panels are compatible
with each other, or you might not need all you have for the upcoming work session. Unneeded ones just take up memory, so why not tum them off? The freeware programs INIT-Cdev and Extension Manager do this too.

ADOBE TYPE MANAGER
Adobe Type Manager is highly useful for any page layout work, or any graphics
work that includes text, and is nothing less than a miracle for anyone with
PostScript fonts and a non-PostScript printer. This utility uses the precise outlines of PostScript printer fonts to improve typefaces vastly as they show on the
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screen, and print text at the resolution of your printer, even if it doesn't have
PostScript.
Truetype fonts do the same thing, but there are fewer available. If you're able
to live with Truetype, it's a simpler option. Mac fanatics argue about PostScript
versus Truetype, but they both produce great results on the screen and on any
printer. And both coexist quite peaceably in your Mac, and even in the same document-as long as you don't use a PostScript font and a Truetype font that have
the same name. But you'd have to be a real Mac fanatic to do that.

ON LOCATION
On Location makes its own index of all of the files on your disk, and also indexes
the text in the types of files you specify. It can then find and open a file that has
the name or contains the text you're looking for, and it does it very fast. This is a
nice tool for users with large hard disks. Other utilities can find the same data but
take much longer, since they have to look through each file instead of through
their own index.

SUPERLASERSPOOL
SuperLaserSpool takes documents you're sending to any printer, and spoolssaves-them to disk, and then feeds the data to the printer, returning use of your
Mac to you faster than otherwise. Apple's print utilities, included with system
software, do this as well but more slowly, and don't support every printer, including the Imagewriter.

SUITCASE
Suitcase gives you control over use of fonts, desk accessories, Fkeys, and sounds.
For System 6 users, Suitcase is almost a requirement, since the Mac system won't
allow more than fifteen DAs to load. In System 7, you can load as many DA's (or
anything else) onto your Apple menu as you want, but management of fonts ,
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Fkeys, and sounds is still easier and more effective with Suitcase. Master
Juggler, a competing utility, offers this same versatility.

DIGIONARIES AND THESAURI
Many publishers offer these. The American Heritage Electronic Dictionary/
Roget's Thesaurus is one choice, although its interface isn't interactive with your
word processor-you have to copy and paste words to and from this utility ,
unless you get QuicKeys to do that for you. Word Finder Plus is a nice thesaurus, and there are several others. Each has the advantage of being more complete than what most word processing programs include. In any case, you'll find
that an on-line thesaurus is vastly easier to use than the paper variety and, since
vocabulary is fundamental to expression, this tool pays for itself in quality of your
writing very quickly.

APPENDIX
HA~DWA~E

So now that you know all about how Macintosh programs work, which Mac
should you buy?
It's a big question, and the main considerations are: stationary or portable;
speed of processing, and, if stationary, size of the screen. Speed is not just a luxury for some work-if you're doing complex design or illustration, a slower Mac
is simply unusable. Conversely, if you're writing the Great American Novel, keep
in mind that word processing doesn't take much in terms of computing power.
Screen size is a necessity for some graphic design and most page layout, and is
only a luxury for most anything else.
Another consideration is size of the beast overall. Why buy something that
takes up all of the real estate on your desk if a compact Mac does all you want
and leaves you part of your desk as well?
A note on portability: Having a battery inside , and a travel case outside, is
valuable for many. Think of all of the work you'll get done on the plane (unless
you really read novels on the plane). Portability costs something, but for many
users it's worth it.
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Here's what's available , with a discussion of each option. Which ones will
you need, and which are unnecessary expenses? Let's look at what each model
offers: how fast, how big, how much memory and storage space-and, how
expensive.
Speaking of expense, you can often find better deals on hardware and software through mail order. The tradeoff is that your local dealer should be better
able to help with your questions about setting up hardware and installing software. Dealerships vary with quality of after-sales service , so it's a good idea to
check with someone who has bought from a particular dealer.
The more responsible mail-order (or should we say phone-order: call a tollfree number, use your credit card, and shipping can be overnight or close to it)
companies also offer technical support. With either a local dealer or a phoneorder company, though , check to see how long they've been in business.
Recommendations from your friends at your users' group (see Appendix F for
how to find a users' group) can be most helpful.
Among IBM-compatible computers, there's a much wider range of hardware
available for the simple reason that anyone can make an IBM-compatible computer. Even the advanced user can, by buying a monitor here, a motherboard
there, and putting it all together in her garage. Macintosh users have it easier:
any Mac you buy is made by Apple Computer. The o nly exception is the
Outbound line of portables, a viable alternative to Apple's Powerbook machines.

MACINTOSH MODELS
Among the Macintosh models available, there are two broad types: stationary
and portable. Most Macs are of the stationary type, meant to live on your desk
and not be moved too often . The portable Macs, also called Powerbooks (or,
generically, notebooks) can serve about as well as the stationary Macs for many
purposes, and can of course be taken with you, to get all of that work done on
the plane.
Note that any Macintosh can run any Mac program, except that a few graphics programs require a computer with a color monitor.
Following is Table D. l , a comparison of the features of the different
Macintosh models.
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Model

Clock Speed
(Mhz)

Classic II
LC II
Ilsi
llcl

16
16
20
25

llvx
Quadra 700
Quadra 950
Powerbook 145
Powerbook 160
Powerbook 180
Duo 210
Duo 230

Table.
Memory
capacity (MB)

Hard disk
size (MB)

32
25
33

10
10
17
32
68
20
64

40-80
40-160
40-160
80-230
80-230
80-400
230-400

25
25
33
25
33

8
14
14
24
24

40-80
40-120
80-120
80
8G-120

Duo Dock
1

0 HARDWARE

Expansion
Slots

Color

0
1
1
4

No
Yes
Yes

4
2
5

Yes
Yes
Yes

0
0
0
0
0
2

No

Yes

No
Yes·
No
No
Yes

Price'

$1 079-$1209
$1239-$1489
$1749-$2139
$2539-$3089
$2949-$3319
$4219-$5849
$6539-$8169
$2149-$2499
$2429-$3149
$3869-$4229
$2249
$2609-$2969
$1079* ••

(depending on RAM and hard disk size)

* with an external monitor

• • depending on Duo model
* • * docking station only-requires a Duo to run

• Clock speed in megahertz. This is how fast the processor chip runs, and
implies not only how fast the chip can calculate, but how quickly the computer
can access data in RAM. While a useful benchmark, it is not the only influence
on overall speed. Other factors are how much RAM is available per program,
whether you 're operating a color system in color mode (slower), and how
large a disk cache you have set.
• Memory capacity in megabytes. This is RAM, not disk size. More RAM is
highly useful for working faster with complex applications (such as graphics or
page layout) or documents, or working with more than one application at a
time (multitasking). But for word processing or databases, 2MB to 4MB of
RAM is all you'll need.
• Hard disk size. Data storage needs vary widely according to use. If you're
planning to work with databases very much , you'll want plenty of storage
space for your files . Ditto if you're in graphics, or if you like a variety of pro-
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grams. Excel, for example , takes up 7MB on a disk if you load a ll of its
optional features, and Word takes 5MB. If you load only the essentials, Excel
uses 2MB and Word uses 1MB. If you plan to do largely word processing or
fairly straightforward spreadsheet use, and don't need to keep a library of data
on disk, you should find a 40MB disk plenty of room.
One caveat: many Mac models are available without a hard disk built in-only a
floppy drive. This configuration is useful if you already have a hard disk or want
to buy one separately (to carry with you from machine to machine, for example, or to lock up at night instead of having to lock up the whole computer), or
are able to depend on a network for its hard disk. The floppy-only configuration
is offered not because you can use a Mac anywhere close to its capacity without
a hard disk-you can't-but so you can add your own.
Another caveat: you can buy a larger hard disk at any time. The upgrade can
be internal, replacing what's already there, or external, adding to capacity and
offering a safety plus as well: if one disk crashes, the data on the other should
be untouched.

• Color. The greatest thing since sliced bagels, for the first two weeks. Then
reality sets in, and you wonder what you need the feature for. For some graphics or page layout work, of course. For spreadsheets, yes, both for charts and
to make a worksheet easier to read. But for word processing? Databases?
Think about this, since color costs money and slows your computer down. I
know a few people who bought color Macs and then turned the color off, just
for the increase in video speed.
As with hard disks, you can get a color computer with a black-and-white monitor, and always upgrade to a color monitor later. Or you can get a larger monitor. And you can keep the one you have and use both at once.

• Expansion slots are necessary to link your Mac to some (not all) networks, to
run IBM-compatible programs at a reasonable quickness, .t o increase speed for
number- or memory-intensive computing, more colors, a second monitor, or
for several esoteric configurations. Most users won't ever need a slot, but consider carefully how you might wish to customize or upgrade your computer in
the future.
In the end, the decision as to how much computer you need is not an easy one.
Many beginning users underestimate how valuable a Mac will turn out to be. An
equal number buy impressive color and speed and end up not utilizing it. The best
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advice I can give is, after studying these options, to observe someone in your field
with your work habits who's up on the Mac, calculate how little of an investment
you can get away with , and then add 25 percent to it.
Here, as in so many instances, seeking out and joining a users' group-either
a local one or one of the two biggies-is a great idea. They have special-interest
groups for beginning users, or for those who want to talk about hardware
options. See Appendix F to get in touch with a users' group. I have tried hard to
see that the hardware information here is accurate at present, but nothing in this
field stays in one place very long. Dealers also don't always seem to have current
or complete information. Shop around, compare the prices in ads in MacWorld
and MacUser magazines, become a nuisance to your friends with Macs, and join
that users' group.

STATIONARY MODELS
• Classic 11/Performa 200. The two model designations for the same hardware exist because of the two retail channels: the Classic II is sold through traditional computer dealerships, while the Performa line is offered through retail
outlets such as Sears. This is the only remaining "compact Mac," the small box
that sits on your desk and you still have part of your desk left. It's as fast as
many of the larger models, but doesn't offer color. Larger monitors are available as add-ons, should you later opt for serious graphics or page layout work.
Otherwise, this gives you access to Macintosh computing for the lowest price.
• LC 11/ Performa 400. This model offers color and the ability to expand
memory or other capabilities through slots at the back, where you can insert
cards made by Apple or other manufacturers (also called third-party vendors).
There are many more options with this model than with the Classic II, either
when you buy it or should you choose to upgrade performance later on.
• Ilsi. This comes with a little more memory and is a little faster than the LC II .
• Ilci. Again, it is a little faster than the model below it. This one also has more
space for expansion. It also comes with a math co-processor as standard (this
can be added to the less expensive machines) for greater speed in some applications, such as spreadsheets or high-end graphics.
• Ilvx/Performa 600. Here, the Ilvx is faster than the Performa, but you can
add a card to the latter to make up the difference. Again, it is a little faster than
the model below it. More importantly, this model offers the option of a built-in
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CD-ROM drive, allowing you to access enormous amounts of data on a wide
range of subjects by buying relatively inexpensive data CD's-entire encyclopedias, Shakespeare's works, and more.

• Quadra 700. The Quadra machines are Apple's workstations-meant as
dedicated design computers, in a thoroughly professional environment. This is
much faster than the less expensive models, and offers far greater capability.

• Quadra 950. The top of the line. The fastest Mac, with the most expansion
capability, and the most memory. Complex graphic rendering or CAD design
works best with this machine.

PORTADLES
• Powerbook 145. It is fairly fast, but doesn't include a connector for an external monitor-something many users would like, when they're back at home or
office.

• Powerbook 160. This model adds gray-scale to its built-in monitor, external
color capability, and a connector for an external monitor.

• Powerbook 180. This model has a better built-in display, although at a premium price. Check both this and the 160 to see if the 180's crisper monitor is
worth it.

• Powerbook Duo 210. This model is meant for primary use hooked up to
Duo Dock hardware in your office, and for occasional trips. It's smaller and
lighter than the regular Powerbooks, but less flexible when it's on its own. It
likes, but doesn't require, the Duo Dock, below.

• Powerbook Duo 230. As above, but a little faster.
• Duo Dock. Bring your Duo home to its docking station, where color capability and two expansion slots await it. This is a fine solution for those whose
work requires a portable Mac, yet who also need more comprehensive capabilities at home base.

APPENDIX
SYSTEM 7

When you use the Mac, you're making use of the hardware-chips, disks and
things- and the program you've chosen, such as FileMaker or Excel.
There's a third component in the scheme, largely transparent to you, called
the System Softwa re , that acts in two ways:
• It's a library of resources for every program you use. When FileMaker or Excel
needs to draw a dialog box or get a font, it goes to the System for it. This
allows every program to be smaller than it would have to be if it stored its own
font and other information, and it encourages every program to have a look
and feel similar to the others you'll use.
• It translates between the program you're using (also called the application) and
all of those chips. Again , if every application had to do this for itself, it would
have to be much larger and more complex in design.
The current System Software comes free with your Mac, and is already installed
on the hard disk if you bought one with your computer. All set up and ready to go.
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Apple keeps making improvements in the System, though, and periodically
releases a new version of it. The most recent is version 7. System 7 is noteworthy
because it includes many changes from System 6 but, because System 6 is simpler and requires less RAM , many users who started with System 6 have chosen
to stay with it.

If you have just bought or are about to buy a Mac, System 7 comes with it.
Don't worry, be happy. If you have System 6 or earlier, though, you may wish to
consider an upgrade to System 7. This Appendix describes the differences, and
what's involved in the switch.
The first consideration is cost. System 7 (and every earlier version) has been
free from dealers, if you bring the disks. Or, you could buy the disks plus a manual for $50. The most recent release, version 7.1, now costs $79 by mail order,
although users' groups may be able to offer a better price.
The other cost is upgrading your hardware to the 2MB of RAM that System
7 needs. Earlier versions would run themselves and at least one application with
1MB, and all Macintosh models came with 1MB as standard equipment. Any
Mac can be upgraded to 2MB or more of RAM. Depending on your model, this
could cost as little as $50 per Megabyte.

Is

AN UPGRADE TO SYSTEM

7 WORTH IT?

Let's look at the advantages of System 7. Most of these depend on having a
recent version of the applications you want to use: If you 're doing fine with
copies of Word and Excel dating from 1987, written well before System 7 was
announced, you'll find that System 7 offers only a few improvements. Current
versions of applications, though, make extensive use of 7's offerings.

NEW FEATURES
These features are new to System 7:

• Balloon help. These are interactive, real-time help messages for menus, windows, and dialog boxes. Choose Show Balloons from the Balloon Help menu to
turn the balloons on, and then drag your mouse over anything on the screen you'd
like a description of. See Chapters 1 and 5 for a detailed explanation of this.
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• Application menu. If you have more than one program running at once, you
can switch from one to any other more quickly this way than you could with
earlier systems. Just click on the small icon of the active program, visible at the
right of the menu bar, to see a menu of all open programs.
Working with multiple open programs was available with System 6 , if you used
a system addition called Multifinder. With System 7 , Multi finder is built-in, and
a little easier to use.

• Automatic organization of the System Folder. This folder contains all of
the information your Mac needs to run. In previous system versions, any number of things that you added to the folder stayed at the same level, allowing a list
of up to hundreds of dictionaries, or small programs that loaded at startupsuch as many of the shareware items discussed in appendix B-or basic control
panels and such that gives you greater control over your working environment.
System 7 organizes these things so they're easier to find and work with.
• More control and ease of working with fonts and desk accessories.
In system versions earlier than 7, you needed to use a special program to
install a font or DA. With System 7 , you can just drag these items into your
system folder, and they'll be put in the right place, automatically.
• More DA's, and a flexible Apple menu. With earlier systems, you were
limited to fifteen DAs, and DAs were all you could put in the Apple menu, at
the left of the menu bar. With System 7 , you can install as many DAs as you
like, and also anything else, in the Apple menu. The applications you use
most, for example.
• Aliases. An alias is an icon that duplicates the icon of any file or folder. You
can make an alias of anything and put it anywhere you like. In the Apple
menu, for example, so you can open it without digging through several folders.
Or, you can put an alias for "Quarterly Report" in the Update folder, while
leaving the original in the Reports folder. Opening the alias opens the original.
This is a nice feature for use on a separate Mac, but becomes really powerful
when your computer is networked to others, and you want to access easily
other files or folders over the network.

• Sharing. If you' re on a network, you and others can make files or folders
available to others on the network. You can limit the access-see only, for
example, or make changes-that others have to any folder on your disk.
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• Better control over the Finder. As it ships, the Finder displays all text in 9
point Geneva . You can change this to anything you want. You can also
choose icon sizes, and whether these line up straight or are staggered in
Finder windows. You can display folder sizes (although this slows operation
down a bit), and choose how much data (modification date, for example, or
version) is displayed in a list view of a window.
An especially nice feature of System Ts Finder is that it shows you contents of
folders within folders , in an outline view. Lists of the contents of subfolders are
shown indented from the lists of the main folders in any window.
You can also manage the Finder from the keyboard. Press any letter to select
the item in the active window whose name starts with that letter. Press Tab to
move to the next icon, alphabetically. Your Arrow keys move from any icon
to any other, in the direction you choose. The built-in Finder Shortcuts file,
available from the Balloon Help menu, illustrates all of these.

• The Trash doesn't empty automatically. In earlier versions it did at certain times, and users reported that they lost files accidentally. In System 7,
what you put in the Trash isn't actually erased until you choose to do so .
• Labels. With a color Mac, you can assign colors to icons, sort by color, and
give different colors labels with names you can change. This is helpful with
organization and ease of work.
• The Find Command. Although the ability to find any file on any disk was
available in earlier system versions, it was limited compared to this. In System
7 , you can search disks for all or part of a name, or by size, creation date, or
several other criteria. The Finder doesn't just tell you where it is, it takes you
right to it, and you can open, move, or copy it immediately.
• Virtual memory. This is powerful stuff. Say you have 2MB of RAM and
could use more, and you have 20MB free on your hard disk. You can turn
some disk space into RAM, and then work with more programs at once. This
is the cheapest way to acquire more RAM , and could well pay for your initial
investment in·System 7.
• Publish and subscribe. This is an even more powerful feature of System 7,
and is shown in detail in Chapter 5. What it does is let you place all or part of
any file in any other file-a graphic in a page layout document, for exampleand when you or anyone else updates the graphic, the page layout document
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updates too. This is a great tool for keeping all parts of your work current, and
is even better when there's a shared effort.

• Inter-application communication. Not only can you specify that one document updates another, as with publish and subscribe, but you can direct one
application to open another, obtain information , and bring it into the controlling application. You've noticed some conceptual similarity between Excel and
FileMaker, for example, although each is much better than the other in some
ways. How about if you tell Excel to open FileMaker and a datafile, get something out of it, and import it into Excel for manipulation in ways a spreadsheet
can do best? It's all here.
In general, current versions of applications offer these features under System 7,
and do everything e lse under earlier system versions. As time goes on, tho ugh ,
more and more applications will need System 7 to run at all, because their developers want to make use of System 7 for the functions it offers them, and that earlier systems don't. Although every program this book covers runs under System 6
as well as 7 , future releases of applications may not. You may need to upgrade
your system version to upgrade an application version.
The other side of the coin is, do you need to upgrade anything? We looked at
SuperPaint version 3 , which does more than version 2. Did you need it to do
more than version 2? If you're a professional graphic artist, you'll probably
appreciate the advances. But, since it does more, it takes up more room on your
disk, takes up more RAM, a nd runs more slowly, just beca use it's doing more.
Same with everything else, and System 7 too.
It's something like buying a car , and then next year's models come out.
Sleeker and spiffier to be sure , but not necessarily any better at all for the kind or
quality of work you do. Your humble author is going to finish this book and then
go back to getting a Ph .D . in moral philosophy a nd educatio n , and a 1984
Macintosh with Microsoft Word version 1 would be fine for the task. So don't be
swayed by the latest and greatest, but look critically at what any upgrade would
do for you. Joining a use rs' group a nd the ir ongoing conve rsations on myriad
topics is, here as elsewhere , most useful.

APPENDIX
TECHNICAL
NOTES
What would this book be without a tech note?
It was produced on a Macintosh Ilsi with 17 megabytes physical RAM. Hard
disks were an 80MB internal and a 44 megabyte Syquest Cartridge Drive, barely
adequate, and an Apple 21-inch monchrome monitor.
The body text is set in Souvenir, 10 point on 13 point leading. Subheads a re
Serif Gothic 16 point bold; captions are Souvenir 9 point.
The text was written in WordPerfect Mac , an e legant and capable word
processor. Conversion and editing was performed in Microsoft Word 5.1. Pages
were laid out and separated in QuarkXpress 3 .11. Our operating System is 7.1 ,
which with thirty-plus extensions and control panels loaded, didn't crash much
more than once a day. Graphic work was accomplished in Photoshop and Aldus
Freehand, and screens were captured using Rashit, a nice piece of shareware.
Virus protection, a most important issue, was accomplished with John
Norstad's wonderful program Disinfectant and Chris J ohnson's fine Gatekeeper.
Although the commercial alternatives may be as good , we are grateful that what
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we've used is provided free to the Macintosh community. These programs, and
many other fine resources, are available on electronic bulletin boards or from
most users' groups. Two good groups are:
Berkeley Macintosh User Group
1442-A Walnut St. #62
Berkeley, CA 94709
415·849·9114
Boston Computer Society
One Center Plaza
Boston, MA 02108
617·367·8080

or call 800-538-9696 for the name of the users' group nearest you.

Words in bold type are cross-referenced.
active

a menu command, or a button, or scroll bar, that
can do something. If the item is not active, its function is
not available right now.

active window

the window in front of any others on the screen, and
which has a title bar in it.

alignment

the relationship between text and its margins: leftaligned text is flush at the left margin but not at the
right; centered text puts an equal amount of space at
each end of each line; justified text is flush with both
left and right margins, an effect achieved by putting
extra space between words or letters within the line.

Apple Menu

the menu at the far left of the screen. Also called the
Desk Accessory menu.
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Apple Menu item

anything showing in the Apple Menu . These often
control operation of the Mac or of printing.

application

a program which you work with directly-to write or
draw with, for example.

arrow

a small icon on the screen showing the position of your
mouse. Also called the arrow cursor.

ASCII

a standard format for moving text between programs,
or between computers. It stands for American Standard
Code for Information Interchange.

background

in HyperCard , a layer con tain ing text or graphics
shared by more than one card.

back up

to make a second copy of a file.

balloon help

a Mac feature that gives you short explanations of what's
on the screen, contained in cartoon-like dialog balloons.

bitmap

a collection of dots that form letters, numerals, or graphics. Such a collection makes up all images on the screen ,
and the output of some printers. See dot-matrix.

block

in page layout, any amount of text as an element.

body text

in page design, text other than captions or headlines.

boot

to start a computer.

button

1. a representation of a small rectangle on the Mac
screen, with a word or a few words in it. Often the
way to give the Mac a command.
2. the physical button on top of the mouse.

card

in HyperCard, a screen containing text, sound or graphics, and buttons to link any of these to text, sound or
graphics on any other card or stack.

ceU

a box in a worksheet, where you enter a number or a
formula.

check box

in a dialog box, a choice represented by a name with a
small box to its left. Clicking your mouse in the box
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(or, in most programs, on the name as well) puts an X in
the box, indicating that the option is activated.

chooser

an Apple Menu item (also called a Desk Accessory)
that lets you choose which printer to use.

click

pressing the button on top of the mouse , especially
when the screen cursor is o n top of someth ing you
want to select or open.

clipboard

a special part of RAM that holds data you've cut or copied,
so that you can paste it. Uke all RAM, it disappears when
you tum the Mac off. See cut, copy, and paste.

close

a Mac command that re moves the active document
from the screen. If you have made changes to the active
document since you last saved it, the Mac asks you if
you want to save these changes.

close box

an icon at the top left of a window. When you click in
it, you close that window. Equivalent in use to the close
command on the file menu.

codes

what used to be involved in learning computers. Since
replaced by icons and plain English.

column

1. in a spreadsheet, a vertical block of cells, one cell
thick.

2 . in word processing or page design, a block of text .
separated vertically from other elements on a page.

Command

an instructio n you give the Mac. Commands are listed
on menus, or represented by icons in a palette.

Command key

a key on the Mac keyboard identified by an apple or a
cloverleaf icon . Pressing this key and holding it while
pressing another key is a common way to give the Mac
instructions.

composition

in desktop publishing , the aesthetic expression achieved
by the balance and coordination of elements on a page.

control panel

an Apple Menu item that offers options about the
Mac's operation.
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copy

1. to read data from one disk and write it to another, or
(less often) from one part of one disk to another part
of that same disk.
2 . a Mac command that takes any data you've selected,
and places it in a special part of RAM so that you
can then paste the data elsewhere.

cropping

changing the amount of a graphic that we can see on a
page, without changing the size of the graphic itself.

cursive

a font that resembles handwriting or calligraphy.

cursor, Arrow

the icon on the screen that moves as you move your
mouse. Also simply called arrow.

cursor, Text

an 1-beam shaped icon used to work with text. Wherever
you click it is where the text you next type is displayed.

cut

a Mac command that places data you've selected on the
clipboard, a special part of RAM, so that you can then
paste the data elsewhere. The cut command removes
the original selection from your document.

DA

see Desk Accessory.

database

1. an organized set of data of a ny type: a tele phone
book, a recipe file, a library card catalog.
2 . a program that creates and uses this data.

datafile

see database , definition 1.

decimal tab

a tab stop that lines numbers up so the decimal point in
each is aligned vertically with those above and below.

desk accessory

a small program listed in the Apple Menu.

desktop

the contents of a Mac's screen, seen as a metaphor for
a physical desktop. Folders, disks, and their windows
are visible and movable.

dialog box

a rectangle o n the screen containing items such as
names of files, and asking you for input such as what to
name a new file , or where to put it . Often contains
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check boxes and radio buttons, giving you choices
about formatting or other aspects of the program.
dimmed

said of a button, check box, or radio button when its
text is grayed-out and its function currently not available.

directory

see folder.

disk drive

the mechanism that reads data from , and writes data to,
a disk. Hard drive is sometimes used synonymously
with hard disk.

disk

a piece of plastic, much like a record, that holds dataeither programs or documents.

display type

type of a larger or contrasting size or style, used to complement or offset body text.

document

anything you've made using the Mac. Letters, drawings,
or worksheets are all documents.

dot-matrix

a type of computer printer that presses ends of wires
against an ink ribbon to print small dots on paper. The
dots form letters or numerals, or graphical lines or shapes.

double-click

to press the button on top of the mouse twice, quickly.

double-sided

referring to a floppy disk, one that can hold data on
both sides. The most common floppy disk today.

dpi

dots per inch , a measure of resolution on the Mac
screen or printed output.

drag

to click the mouse button on an icon and, holding
the button down, to move the mouse so that the icon
moves with it.

eject

a command to push a floppy disk out of the disk
drive.

e lement

in desktop publishing, any single piece- a block of text
or a graphic-on a page. Also called object.

EPS

encapsulated postscript, a graphics file format. Also
written as EPSF.
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erase

1 . to delete a file from a disk, by dragging its icon into
the trash.

2 . to fonnat an entire disk.
field

in a database, one kind of information. In HyperCard,
a place on a card designed to hold text.

file

anything that has an icon. Either a program or a document.

file fonnat

a program's design for reading and writing its information from and to a document.

fill

in graphics or desktop publishing, the degree of darkening of an area, expressed as a percentage.

find

a command that lets you search for a string of text.

Finder

the program that runs when you first tum on the Mac.
It lets you copy or organize files , run programs, or
open documents .

floppy disk

a piece of plastic, much like a record , that holds dataeither programs or files , and is small enough to carry
around.

folder

a graphical representation of what's on a part of a disk,
used to organize data on a disk. You can put nearly as
many folders on a disk as you'd like.

font

a particular design and style of letters. Also called typeface or typestyle.

footer

a line or few lines at the bottom of the page in a word
processing document that stay the same on every page.

fonnat

1. to erase a disk, and make it ready to put data on.
2. the way a program reads and writes data on a disk.

3 . the way text is presented, such as size and style of letters, and margins and spacing.
fonnula

in a worksheet, this contains references to other cells,
and instructions for instance to add or subtract the value
of one cell from another.
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fun

what Macintosh users have with their computers.

graphical interface

the idea that a computer should show you what's going on
by symbols, or icons, rather than codes. See interface.

grayed-out

when text in a menu or dialog box appears in a light
gray, or dimmed, instead of black. This means that the
command or function is not currently available.

greeked

in desktop publishing, a representation of text at a small
size by gray bars or by miscellaneous letters of the
Greek alphabet.

guide

in page design programs, a thin straight line that you
can 'pull out' of the vertical or horizontal ruler to
place next to text or graphic objects for alignment.

Hand tool

in Pagemaker, the tool used to move the page around
on the screen.

handle

in Pagemaker, an icon that controls alignment of a
block of text.

hard disk

a metal disk, much like a record, that holds data-either
programs or files , and that is built into the computer
or into a cabinet plugged into the computer.

header

a line or few lines at the top of the page in a word processing document that stay the same on every page.

highlight

see select.

hypertalk

the HyperCard program's implementation of hypertext.

hypertext

a concept that any word or text, or graphic, can be
related to any other by idea rather than by proximity on
a page or in a book.

icon

a picture that has a meaning. On the Mac, an icon may
represent a program, document, disk, or command.

lmagewriter

a Mac printer of the dot-matrix type.

initialize

to erase, or format, a disk.
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insertion point

the bUnking vertical bar that shows you where the text you
type is displayed. You can move the insertion point by
eliciting with your text cursor at any point on the screen.

interface

the structured relationship you have with a computer;
the language and the systems of recognition you use to
operate the computer.

jargon

difficult and technica l language that was once required
to talk about computers. Now replaced by plain English.

justified text

see alignment.

keyboard equivalent a keystroke, perhaps with the Command key , that
replaces choosing a command from the menu.
landscape

see orientation.

Laserwriter

a Mac printer that forms an optical image of a page,
and then uses technology similar to a photocopier to
print the image on paper.

layout

1. in a database, the positions on a page of each field,
and of other text and graphics.
2.1n page design, the placement of text and graphics

on a page.
left-aligned text

see alignment.

left tab

the most common kind of tab, which puts text to its right.

learning

growth of the whole person. Has little to do with gaining skills.

linking

1. a dynamic relationship between documents, so that
data in one document updates another document.
2.1n HyperCard, a re lationship between two or more

cards so that one card can reference another, or so
you can go from one card to another.
load

to start a program.

macro

a set of instructions you record, saved as a set, so that
you can give the computer a ll o f the instructions at
once, just by issuing one command.
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marquee

a shimmering dotted line around all or part of a bitmap
graphic, or HyperCard button or field. Used to indicate that the item is selected.

master page

in desktop publishing, a representation of a page on
which you place elements that you want to appear on
every page. Similar to the background in HyperCard.

masthead

the title of a publication, perhaps with issue number or
other indexing information, and date and place of publication.

memory

l.see RAM.

2. inaccurately used to refer to data on disk.
menu

a list of commands in a program, accessible from the
menu bar.

menu bar

words at the top of the Mac screen, showing lists of
what commands are available.

mode

in a database, a paradigm that lets you work with one of
these: fields, layouts, or records.

mouse

the thing you use to move an arrow-shaped pointer
around the screen. It has a button on top that you use
to click on icons.

multi finder

in System 6, a feature that allows you to run more than
one program at once. Automatic in System 7.

multitasking

using two or more programs at once, in conjunction
with each other.

New

a command on the File menu that starts a new document.

object

in page design, anything-text or graphics-that can be
put on a page. Also called an element.

on-line help

descriptions of program commands and functions,
available on-screen by choosing the help command.

Open

a command on the File menu that opens an existing
document from a disk.
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operating system

the basic software that drives the Mac. Transparent to
the user, unlike the operating systems for some other
computers, which require the user's involvement.

orientation

placing a page in vertical (or portrait, or tall), or horizontal (or landscape, or wide) view.

paint

1. one kind of graphics format.
2. a program that works in this format.

palette

a set of icons at the side of a window that represent
tools to format text or paint a picture.

paste

a command that takes data , such as text , that you've
already cut or copied from elsewhere, and inserts it at
the cursor position.

pica

a printer's measure, equal to one sixth of in inch.

PICT

a graphics file format .

pixel

one dot on the Mac screen.

placing

in page design, the act of putting a block of text or a
graphic at a certain place on a page.

point

a printer's measure. One point is 1/72 of an inch.

pop-up

a palette or menu that expands when you click on it.

PostScript

a page-description language developed by Adobe
Systems , allowing high precision and resolution in
printed output.

portrait

see orientation.

print

to direct the data in your active window to a printer.

program

a set of instructions to the Macintosh to do something.
Using a program, you can paint a picture or write a paper.

programming

a highly technical activity to make Macintosh applications that are then easy for the rest of us to use.

publish and
subscribe

a means of dynamic linking between two documents,
from the same or different programs.
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radio button

in a dialog box, a program command shown by its
name with a small circle to its left. Clicking your mouse
in that circle darkens it and activates that choice.

ragged

text that is not even along one or both margins. See
alignment.

RAM

stands for random access memory: data contained
on microchips in the Mac, which represents the working
area of the computer. The contents of your active win·
dow are in RAM. All data in RAM is lost when you turn
the computer off.

random access
memory

see RAM.

record

in a database, one specific entry. For example, in an
address book, information on one person is a record.

resize box

the icon at the bottom right of a window in the F"mder. You
click and drag in this to change the size of the window.

resolution

the fineness of the dots making up an image on the
screen or on paper. See dot-matrix and dpi.

right-aligned t ext

see alignment.

right tab

a tab that places text immediately to its left.

rule

in desktop publishing , a line between elements , or
leading from one element to another.

ruler

in a word processing or page design program , a
graphic, non-printing ruler along the top or left of the
screen, helping with alignment. A ruler can include
icons for tabs and margins.

runaround

p lacement of text so that· it follows the edges of a
graphic.

sans-serif

a type style in which each letter does not have small
strokes at the end of most major strokes. The illustration
and heading fonts of this book are sans-serif.

Save

the command that puts a copy of the data in RAM onto a
disk.

Iii
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Save As

the command to save a new copy of a document, with
a different name.

script

1. in a database; see macro.
2. In HyperCard, a set of instructions to the program
such as to show animation, go to another card, or
access any feature of the program for you.

scroll

moving your view of a Mac window up or down , or
right or left, using scroll bars.

scroll bar

the vertical bar at the right side of a window, or the
horizontal bar at the bottom, that lets you move around
within the window.

select

the choice of an icon, some text, or a graphic made by
clicking on it with the arrow. The choice then reverses
color from black on white to white on black, to show it's
selected. Also called highlight.

selection

anything-an icon, object or text-that has been chosen by the user, usually with the mouse.

serif

a type-style in which each letter has small strokes at
the end of most major strokes. The main text font of
this book is serif.

shift-click

to hold down the Shift key and click the mouse button. Used to select a range of data.

single-sided

referring to a floppy disk, one that can hold data on
only one side. Less common today than double-sided
disks.

spread

in desktop publishing, two facing pages viewed at once.
Important to look at as a whole, to judge composition.

spreadsheet

an application that lets you work with quantitative
data, and make charts from it.

stack

in HyperCard, a set of cards in one file , relating to a
common idea or association of ideas.

string

any amount of letters and numbers. Your name, includ-
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ing the space between first and last, is a string. So is
"12345xyz."
Stylewriter

a Mac printer of the dot-matrix type.

subscribe

see publish and subscribe.

system

a program on a disk that the Mac needs to run, but
that you don't use directly.

tab

a means of aligning lines of text with each other. See
decimal tab, left tab, and right tab.

text wrap

in desktop publishing, arranging text so that it flows
around the borders of a graphic.

title bar

the top part of a window, with horizontal lines running
across it, and the close box and zoom box at either end.

tool bar

a palette of icons, each of which represents a command.

trash

an icon on the Mac screen. Drag an icon of a file over
the trash icon , and choose Empty Trash from the
Special menu to erase the file. Drag an icon of a disk
over the trash icon to eject the disk from the Mac.

typeface

see font .

typestyle

see font .

typography

the art of choosing different fonts and styles for effective communication.

undo

a Mac command that undoes the last step you made. If
your last action was typing , this command erases what
you typed.

virus

in computer terminology, a program written to be invisible to the user, which moves by itself from one computer to a n o ther, and which disrupts th e no rmal
functioning of the computer or causes more serious
damage, such as erasing data. See the Technical Notes
in Appendix F for important information on virus prevention and eradication.
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white space

in a publication, areas on a page without text or graphics.
Critical to composition.

window

a rectangular area on the Mac's screen, shown as a box
with four sides. In an application, a window shows you
the text or graphics currently in RAM. In the Finder, a
window shows you what's in a folder or a disk.

windowshade

in Pagemaker, icons that control vertical alignment of a
block of text.

word processor

1. a computer application that lets you write, and
include graphics.

2. a small computer with a word processing program
built in: Usually much less capable than definition 1.
word-wrap

a feature of a word processing program that obviates
use of the Return key at the end of a line: a new line
starts automatically.

worksheet

a document produced by a spreadsheet application.

zoom box

an icon at the top right of a window. When you click
in it, you change the size of the window.
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copyright, 66
creativity, 169, 210, 231
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database, 131-134, 142-143, 146,
149, 151, 163-165, 170,
218, 254
datafile, 151 , 156, 158, 166, 247 ,
254
decimal tab, 54, 254, 26
default, 54, 91 , 93, 121-122, 194
page layout, 194
de-select, 136, 159
desk accessory, 251, 253-254
desktop, 9-10, 17, 19, 23, 30, 39,
120, 125, 134, 194,224,
229, 261, 263 253-257 ,
259, 262
Dewey, John, 4
dialog box, 15, 29, 33-34, 39, 47,
59-60,65, 83, 85, 93-95,
97-98,254
dictionary, 57-58, 215, 236
Digital Darkroom, 45
diminishing returns, 116
directory, 224--225, 255
disk, 1, 6-7 , 10, 14--22, 24--25,
29-30, 34,36, 39-40, 45,
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drive, 17, 29, 135, 255
display type, 255
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dpi, 255, 261
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edit line, 80-81, 83, 86-87,
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edition, 125- 126
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eject, 39, 255 , 263
electronic mail, 3
element, 203 , 207-208, 210, 212 ,
217-218, 252 , 255,259,
261
entry options, 151
environment, 4, 6, 8, 49 , 65 , 71 ,
104, 132,190,242, 245
EPS, 196, 205, 255
EPSF see EPS
erase, 16, 82, 182, 202, 221- 225 ,
234, 256
Euclid, 169
F

fatbits, 32
fax, 26, 223
field, 60, 132-133, 135-136,
139-144, 146, 148- 160,163,
166, 174, 182, 184-185,
190, 192, 241 , 256
definition, 133, 136, 151

We, 1, 5, 9, 12-13, 17- 21,23- 26,
29-30 , 33-35, 39-40,
45-46 , 229, 260 50-51 ,
56-57, 64,67-68,70,80,
93,95-96,256
format, 196, 255-256, 260
fill, 47, 208-209, 225, 256
find , 21 , 23 , 59-60, 74, 105-106,
146-148, 165,256
all, 146- 148, 165
criterion, 146, 148
Finder, 24, 104-106, 123, 170,
230 ,236,246,256,261,
264
flat-file, 164
floppy disk, 1, 14, 18, 20, 181 ,
221 , 255- 256, 262
folder, 8, 10-13, 17-18, 20-21 ,
23-24, 30, 106, 192, 230,
233-234, 245-246,
255-256, 264
font, 5 1- 52, 55- 56, 73, 83, 95 ,
98, 101, 160, 182, 184,
213-215,228 , 235 , 243,
245, 254, 256, 262-263
footer, 63 , 95 , 144, 256
footnote, 61-62, 64, 74
forecast, 79
format, 15-17, 22, 24, 49-51 , 58,
60, 63, 71-72 , 82-85,
97-98, 100, 129, 139,
156-157, 160, 184, 190,
196- 197, 200,205-206,
212 , 216- 217 , 228,
232- 233, 252 , 255-257,
260
formula, 78- 79, 86-94, 100,
107-111, 113- 115, 117,
128,154-155,158,252,256

INDEX

Fourth Dimension, 164
Foxbase, 164
function, 37, 77, 79, 87, 90 , 104,
106, 113, 154,228, 233,
251, 255, 257

hinge point, 44
Hypertalk, 187, 189, 191, 257
Hypertext, 169, 257
icon, 5-6, 10- 12, 17-21, 23-24,
26, 28, 30,34, 39, 41,50 ,
54, 69, 79, 84,86, 257

G

game theory, 2
glossary, 229, 251
grammar, 49, 67, 71, 74
graphic, 6, 22, 25-26 , 45, 47, 56,
65, 74, 120, 125, 163, 185,
191,197,200-206, 210,
212,217 , 229, 237, 242,
246-247, 254, 257,
259-263
GUI, 56
guides, 104, 196, 207
H

hand tool, 174, 257
handles, 44, 98, 118-119, 121 ,
139, 156,177, 198,200
hard disk, 17, 21, 29, 192, 196,
221, 224-225, 230, 233,
239-240, 243, 246, 257
header, 63-64, 95 , 144, 160,
257
headings, 84, 95, 107, 213
help, 1-2, 4, 10, 22, 25, 37-38,
40, 45, 57,59, 66-68, 77,
79-80, 89-90, 101 ,
103-104, 108, 129, 165,
169, 184, 192, 196, 206,
209-210, 225,231 , 233,
238,244,246, 252, 259
highlight, 257, 262

lmageStudio, 45
lmagewriter, 39, 47 , 235, 257
imaging, 46
incremental saves, 34
indent, 53, 187
information , 2-5
information theory, 2
initialize, 257
input, 3, 6, 46, 165
inserting, 15, 65
insertion point, 74, 258
interface, 4-6, 22, 46, 202,
231- 232, 236 , 257-258
intuitive, 7, 22, 46, 72, 189
italic, 49, 52-53, 73, 208, 215
J

jargon, 258
justification, 54-55
justified text, 251, 258
K

keyboard , 5, 23, 50, 72-75, 87,
121 , 137, 140, 165, 172,
228-229,232-233,246,
253, 258
knowledge, 22
Kolb, David, 4
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L

label, 12, 14-15, 140, 144, 159,
225
landscape, 249, 258 , 260
LaseiWriter, 39, 42, 47 , 214, 258
layout, 49 , 63- 64, 71 , 73, 108,
131-133, 137-139, 141 ,
143-146, 148-151 , 156,
158-163, 165-166,
193-194, 196, 211 ,
215-216, 229, 234, 237 ,
239-241 , 246, 252,258
learning, 2, 4 , 10, 45 , 50, 139,
169, 253, 258
left tab, 54, 258 , 263
legend, 98, 118, 121-122
line spacing, 215
link, 103, 108, 110, 125-126,
127-129, 167, 169,
179-180,186-187,240,
252, 258 , 260
literacy, 3
load, 50, 222, 234-235, 240, 258

memory, 26, 28, 30, 36, 110, 222,
234, 238-242, 246, 259,261
menu, 9-10, 12-13, 17, 20-21,
23-24, 26 , 28-30, 33-39,
44, 50-53, 259
bar, 9-10, 12, 36-37, 51 , 259
mode , 40-47, 65, 68, 72, 74,
133-134, 136, 138-139,
141-146, 151, 156-159,
165-166, 170, 175,
177-180, 182, 185, 187,
191-192, 197, 205, 232,
239,259
mouse, 5, 9-12 , 16, 20, 23-24,
28,35,40, 46, 52, 57, 59,
62, 72,82,93,96-97, 259
button, 9, 12, 20, 28, 35, 52,
82,96-97,252
moving files, 22
multifinder, 245, 259
multiple windows, 103, 112, 127,
129
multitasking, 103, 123, 239, 259
N

M

MacDraw, 45, 244
MacPaint, 45, 196
macro, 71, 120-123, 129, 131,
232,258, 262
MacWrite, 71 , 244
magnification, 108, 204, 229
mail merge, 165
margin, 74, 207 , 251
marquee, 34, 41 , 177-179 , 259
master page, 206-207, 217 , 259
masthead, 207-208, 210, 259
match case, 60

network, 126-127, 222, 240, 245
Nisus, 71-72, 202
0

Omnis, 164
open, 7, 9, 12-14, 17,20-22,256
paragraph, 55
operating system, 249, 260
option key, 23, 210
order of parameters, 90
organization, 68, 72, 165, 230,
245-246

INDEX

outline type, 215
outlining, 49, 68, 71
output, 45, 47 , 67 , 252, 255, 260
p

page
design, 71 , 120, 193-194 , 207 ,
210, 216-218 , 252-253,
257-261
layout, 63-64, 71 , 193-194,
196, 215- 216 ,229,234,
237 , 239-241,246, 252
setup, 95
paint, 25-28, 30, 33-42, 45-47,
65, 132, 168, 174-175,
178, 182, 184, 186,
190-192, 196,205 , 229,
260
brush, 28, 30, 33, 41, 168
format, 205
mode, 40-41 , 47 , 175, 178,
182, 191- 192,205
multiple, 33
pattern, 33
text, 182, 186, 192
tools, 25, 27
palette, 27- 28, 30, 33-34, 41 ,
174, 180, 182, 184, 194,
212, 253, 260
Panorama, 164
paragraph, 3, 51, 53, 55-56, 63 ,
70, 74
paste, 25, 34, 36- 37 , 40, 56, 62,
65,74-75,86-87 , 96,
107- 108, 111, 113- 114,
120- 121,124, 185, 217 ,
229,236, 253-254, 260
pasteboard, 200, 210, 217

patterns, 27-28, 47, 175, 180,
189, 228
pica, 214, 260
PICT, 196, 205, 229, 232, 260
pixel, 31, 140, 165, 260
PixelPaint, 45
placing, 74, 168, 200 , 217, 260
plain text, 196
point, 51, 208, 214
Popper, Karl, 168
pop-up, 30, 156-157, 233, 260
portrait, 260
power failure, 28, 223
precision, 43, 84, 140, 205, 212,
260
predictions, 79
primary key, 149-150, 161
print, 38-39
area, 93-94, 101
merge, 165
preview, 63-64, 74, 93, 95
printer, 6, 38-39, 42, 163, 214,
234-235, 253, 255,
257-258, 260, 263
program, 2-3, 6-7, 9-10, 19,
26- 27, 36-37, 39-40,
45-46, 50-51, 65-66,
71-72,74, 78-79, 96, 100,
104, 106, 120, 123,
125-128, 148, 151, 154,
161, 163-167, 169-170,
172-174, 176, 189-190,
192-193, 196, 202,
215-217 , 221-225, 227,
229, 232-234, 238-239,
243,245,247,249, 252 ,
254-264
programming, 2, 120, 122, 187,
191,260

&a
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language, 187
proportional font, 215
publish and subscribe, 103, 125,
127, 246-247 , 260, 263
Publish It Easy, 216
Q

QuarkXPress, 216
quit, 39, 41 , 50
R

radio button, 184, 197, 255, 261
ragged text, 261
RAM, 28-29, 36, 58, 128, 164,
239, 244, 246-247 , 249,
261
random access memory, see RAM
range, 82, 85, 101, 107- 108, 111,
113-114,152, 222 , 238,
242, 262
Ray Dream Designer, 46
Ready,Set,Go!, 216
record, 120, 123, 133-134,
136-137, 141-142, 146,
148, 151 , 153, 158, 164,
224, 261
references to unopened documents,
110
regions, 96, 103, 113, 118, 127 ,
129
relative addressing, 91 , 107-108
rendering, 14, 46, 242
repeat new window, 113
replace, 49, 59-60, 155, 202 , 211 ,
233
report, 4, 93, 120, 143
re- select, 136

reshape, 44, 119, 177, 182, 198
resize box, 7, 12, 120, 261
resolution, 42 , 235, 255, 261
retrieve, 3, 39, 134
return key, 51, 136, 264
ribbon, 52-53, 55, 63
rolodex, 172, 228
row, 73, 81-82, 84, 95,100,118
rule, 14, 113, 261
ruler, 53-55, 63, 69, 74, 209 ,
229, 257, 261
runaround, 261
Ryle, Gilbert, 169

s
save, 25, 28-30, 33-34, 38-40,
45-46, 50, 52,56, 58, 72,
8 1- 82, 87-88,96, 261
save as, 34, 40, 45-46, 262
scrapbook, 36-37, 45-46 , 120,
125
screen, 5- 13, 17, 23, 26-28,
31-32,34, 36, 39-40,42,
50- 51 , 55- 56, 62, 64, 66,
73,79-80, 94, 263
script, 75, 131 , 161-163,
166-167 , 176, 179-1 80,
187- 190, 192 , 262
scroll, 1, 7- 8, 13, 17, 22, 26, 37,
46, 5 1, 62, 64, 79-80,
87-88,90- 91, 262
bar, 13, 37, 80, 251 , 262
search mask, 148
select, 5, 11-13, 17, 26, 28-29,
34-35, 37, 40, 42, 44,50,
52-53, 55, 61, 65, 67 ,
73-74,82,84-85, 87, 90,
93- 94,96, 98,262

serif, 213, 262
shutter, 14-15
smartquo~s , 215, 228
smooth point, 44
sort, 131, 134, 136, 148-150,
161-163, 166, 246
order, 149-150, 163
spacing, 55, 64, 215, 256
spelling, 49-50, 57-58, 72, 217
split windows, 80, 112
spread, 206-207 , 262
spreadsheet, 36, 77, 79, 82, 93,
99-101 , 103, 110, 113,
123, 127, 240, 247, 253 ,
262, 264
stack, 167, 170-174, 176,
179-182, 184-185,
187-192,217, 252, 262
string, 59, 81, 115, 182, 256,
262-263
Stylewriter, 39, 263
subscribe, 103, 125-127, 129,
246-247,260, 263
T

tab, 53-54, 63 , 80-81, 100, 136,
142, 146,185, 228, 246,
254, 258, 261 , 263
tablet, 46
tall orientation, 194, 206
text wrap, 193, 203- 204, 263
textures, 40 , 42
thesaurus, 49, 58- 59, 71 , 236
TIFF, 196, 205, 232
title bar, 12, 26, 51 , 251 , 263
tool, 3-5, 10, 28, 30, 32-34, 38,
41-44, 47 , 53,55, 59,
67-71 , 77, 79,83-84, 86,

96 , 99-100, 104, 106, 108,
117-118, 132, 140, 160,
164, 166, 168-169,
174-176, 179, 182,
184-186, 190, 192, 194,
202 , 204, 207-208 , 210,
218, 228, 235-236 , 247,
257 , 263
bar, 77, 79, 83-84, 86, 96,
99-100, 104, 108, 118,263
palette, 28, 34, 41 , 174, 182,
184, 194
transparent button, 187
trash, 39, 224, 246, 256, 263
typographer's quotes, 215
typography, 213, 215-216, 263

u
UltraPaint, 45
underline, 53
undo, 26, 28,50 , 113,201-202,
233-234, 263
unique field, 150
user dictionary, 58
user level, 172, 191
users' group, 73, 190, 215, 222 ,
238, 241 , 247 , 249

v
value list, 151 , 153
Ventura Publisher, 216
version, 30, 34, 106, 125, 176,
218, 222- 223, 244,
246-247
virus, 221-223, 231 , 249 , 263
Visicalc, 78
vocabulary, 58, 236

J
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w
white space, 101, 206, 210, 215,
264
~ndow, 6-10, 12-13, 17-20,
23-24, 26, 28,37, 39,
51-52, 59, 62-63, 65-66,
74-75, 80-82, 90, 97,264
word count, 70
WordPerfect, 65, 71-72, 234, 249
worksheet, 78-82, 84-85, 87-88,
90, 93, 95-96, 100- 101,
103, 107-108, 110, 113,
115, 117-121, 128-129,
240, 264

workspace, 84, 100
WriteNow, 71
VVYSNVYG, 56, 96, 234
X

x-height, 214

z
zoom box, 7-8, 12, 79, 264

• This book will make you a
competent and productive
Macintosh user quickly and
painlessly
• It offers complete and
comprehensive information on
a wide range of programs for
users at all levels
• Step-by-step guides have been
thoroughly tested and are
clear and reliable
• Developed in Cornell
University's largest computer
course, more than 600 students
learned the Macintosh using
this book
• 175 illustrations and hundreds
of tips and shortcuts are also
included
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